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 INTRODUCTION
Introduction
Welcome to the OptiSPICE Schematics, the schematic entry tool for OptiSPICE. 
OptiSPICE Schematics is built with features designed to allow it to form the core of 
your opto-electronic design system.

This chapter will point you to the resources you need to get started using the package 
as quickly as possible.

Where to Start

We suggest you ease yourself into the world of schematic editing with OptiSPICE 
Schematics by taking the following steps:

Step Action 

1 Install the package using the procedures outlined in the on-line installation 
notes provided on the release CD-ROM or downloadable files.

2 Work first through “Tutorial” on page 9. It provides step-by-step instructions 
for basic schematic editing.

3 Refer to “Basic Procedures” on page 25 and “Basic Schematic Editing” on 
page 37 for general schematic editing procedures.

As you work with OptiSPICE Schematics you will have occasions to look for 
information in this manual. It is organized into a number of parts, sorted more or less 
in order of the depth and complexity of the material.

If a question comes up that the manual doesn’t answer, we are available for technical 
support by phone or on-line (see Optiwave makes no representation or warranty with 
respect to the adequacy of this documentation or the programs which it describes for 
any particular purpose or with respect to its adequacy to produce any particular result. 
In no event shall Optiwave, its employees, its contractors, or the authors of this 
documentation be liable for special, direct, indirect, or consequential damages, 
losses, costs, charges, claims, demands, or claim for lost profits, fees, or expenses 
of any nature or kind).

1
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 USER INTERFACE
User Interface
This chapter provides general information on the use of windows, drawing tools and 
other user-interface features of OptiSPICE Schematics.

Mouse Button Usage

Several different mouse button actions are used for various functions in OptiSPICE 
Schematics. For clarity we will use the following terminology when referring to these 
actions in the remainder of the manual:

• Click—means press and release the left mouse button without moving the mouse. 
Example: To select a device, click on it.

• Click and drag—means press the left mouse button and hold it pressed while 
moving the mouse to the appropriate position for the next action. Example: To 
move a device click and drag it to the desired new position.

• Double-click—means press and release the left mouse button twice in quick 
succession without moving the mouse. Example: To open a device's internal 
circuit, double-click on the device.

• Right-click—means press and release the right mouse button without moving the 
mouse. In OptiSPICE Schematics, the right mouse button is only used to display 
a pop-up menu of shortcut commands which depends on the item clicked on.  
Example: To display the popup menu for a device, right-click on it.

Note: It is possible for users of a Windows system to change the meaning of the mouse 
buttons on that specific system.  We will use the terms "left" and "right" buttons consistent 
with the standard usage, but you made need to translate these items if your system 
settings have been changed.

Dialog Boxes

Many OptiSPICE Schematics functions require information to be displayed or 
prompted from the user. To do this a special window called a “Dialog Box” is 
displayed, such as the following one which is used when a Properties command is 
executed for a signal.

In general, the controls in dialog boxes will behave according to Windows standards.
3
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Ine dialog boxes requiring text entry, the keyboard equivalents for the clipboard 
commands Cut (CTRL-X), Copy (CTRL-C) and Paste (CTRL-V) are active and can 
be used to transfer text to or from a text box.

Window Usage

Document (Circuit, Part and Text) Windows

Each circuit window displays one page of a circuit schematic. The title on a circuit 
window will be the name of the circuit file, followed by the page number and title, if 
any.  No page number is displayed if the circuit only has one page. Any number of 
pages in a given circuit and any number of circuits can be displayed simultaneously.

At any given time only one page of one circuit is “current”, that being the one in the 
topmost window. Any other window can be made current simply by clicking the mouse 
anywhere in the window.  Many of the menu commands, such as Save As, Export, 
etc., apply to the "current" circuit.

Document windows can be displayed in three different forms:

• Normal—In this state, windows are stacked on top of one another and can be 
moved and resized independently.

• Maximized—In this state, a single document window takes up all available area 
within the application frame.

• Minimized—In this state, the window is displayed as an icon at the bottom of the 
application frame.  I.e. The associated document is still open, but the contents are 
not displayed.

The positions of the window controls in the Maximized and Normal state are shown 
here:
4
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Tool Panels

Program modules, or Tools, can create their own windows, toolbars and panels which 
may be displayed concurrently with other OptiSPICE Schematics windows. A typical 
tool panel looks like this one, created by the Find command:

This type of panel have a number of controls that can be used to move the panel and 
change how it is displayed.

• Click the Close Box—to close the window.  To redisplay the window, use the 
associated command in the menu bar.

• Click and Drag in the Drag Bar—to move the panel to a different location.  This 
type of panel can be located on any side of the main application frame.

• Right Click in the Drag Bar—to display a small menu with other display options:

• Allow Docking—When this item is checked (the default), the panel will try 
and "stick" to the edges of the main application window.  When this item is 
unchecked, the panel will float as a separate window that can be moved out 
of the way of the main application window, if desired.

• Hide—This is the same as clicking the Close Box.

• Float in Main Window—This command causes the panel to be displayed like 
a document window.
5
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Closing a Document Window

To close a document window, simply click in the Close Box of that window.  The effect 
of this on the document file depends on the type of information that was displayed in 
the window.

• Circuit Windows—Clicking in the Close Box on a Circuit window has the effect 
of closing the circuit page. If the page being closed was the only one open on the 
design then the design file is closed.

• Symbol Editor Windows—Clicking the Close Box of a Device Symbol Editor 
window closes that symbol editor session.  If the symbol had been modified, you 
will be prompted to save the changes back to a library.

• Text Windows—Clicking the Close Box of a text window closes the text 
document.  If the document was unsaved, you will be prompted to save any 
changes.

Redisplaying a Circuit Window

When a circuit page window is closed it is removed from the Window menu to avoid 
clutter. To reopen a page in the current circuit level, use the Pages command in the 
Drawing menu. To reopen an sub-circuit window, double-click on the device in 
question.

The Window Menu

The Window menu provides a means of bringing to the front any window currently 
open.

Keyboard Usage

The keyboard is only absolutely required when entering names for devices or signals, 
or for placing random text notations on the drawing. However, the c, M,  and g keys 
on the keyboard can be used with many editing operations to invoke special features 
such as auto-alignment, auto-naming and different signal line drawing methods. In 
addition the arrow “cursor” keys (if available) can be used as a convenient way of 
"nudging" selected items, or setting symbol rotation while placing devices or pasting 
circuit groups. These options are described in detail in the relevant chapters.

Pop-up Menus

At any time while editing a diagram you can right-click on a schematic object. A pop-
up menu will appear under the cursor allowing you to select from commands 
appropriate to that object. E.g. the menu for a device contains commands to get 
device information, edit attributes, open the internal circuit, flip or rotate the symbol, 
Cut and Copy operations, etc.

Separate pop-up menus are available for devices, signals, pins, attributes, and (if 
clicking in open space on the drawing) the circuit itself.
6
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Toolbars

OptiSPICE Schematics uses a variety of toolbars to give quick access to program 
functions.

To Discover the Meaning of a Tool

To find out what a tool does without risking trying it, just move the mouse pointer over 
the tool and stop.  A one-word description of the tool will pop up after a pause and a 
longer description will appear in the program status bar at the bottom of the 
application frame.

Moving a Toolbar

A toolbar can be moved to another location in the application window by clicking and 
dragging in an unused area of the bar (i.e. not on a button).

Showing and Hiding a Toolbar

Toolbars can be displayed or hidden using the commands in the View menu.

Status Display

The lower area of the application window is used to optionally display several items 
of status information.  This display can be showed or hidden The selected orientation 
will be displayed in the tool palette icon.

Use of the Pointer or Cursor

In subsequent descriptions, we will refer to the small shape which tracks the mouse 
position on the screen as the “pointer” or “cursor”. In OptiSPICE Schematics there are 
a number of different cursor modes used which determine what action will be 
performed when the mouse button is clicked. Following is a summary of the cursor 
modes. More detailed descriptions of operations performed in each mode are 
provided in later reference chapters.

Note that the cursor shape sometimes differs from the tool palette icon for ease of 
pointing.
7
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Tool 

Palette 

Icon

Initial 

Cursor 
Shape

Equivalent 
Menu 

Command

Description

Point Used to select or drag objects, extend 
signals.

Draw Bus Used to create a new bus line or extend 
an existing bus. Clicking once fixes a 
corner, double-clicking terminates the 
line.

Draw Sig Used while creating a new signal line or 
extending an existing signal. Clicking 
once fixes a corner, double-clicking 
terminates the line. Note that most 
signal drawing operations can also be 
done in Point mode.

Text Used to select a signal or device to 
name, or to place random text on the 
diagram. Point at the item you want to 
name and press and hold the mouse 
button. Move to where you want the 
name to appear, then release the 
button.

Zap Used to remove single objects. Press 
the button to remove whatever the tip of 
the cursor is pointing at. Objects can 
also be removed in groups by selecting 
them and using the Clear command or 
delete key.

Magnify Used to zoom in and out. Clicking on a 
point or dragging down and right zooms 
in, dragging up and left zooms out.

Attribute 
Probe

When the arrow portion of the cursor is 
clicked on a device, pin or signal, the 
contents of the primary attribute fields 
for that object are displayed.
8
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Tutorial
The purpose of this tutorial chapter is to give you a quick overview of the steps 
involved in schematic creation. You can then refer to the later reference chapters to 
find more information on specific topics of interest.

To allow you to get a quick overview and then delve into specific topics of interest, this 
tutorial chapter is divided into these sections:

• The 5-Minute Schematic Diagram -- NOTE: All other sections below assume you 
have worked through this one!

• Advanced Schematic Editing

• Creating Device Symbols and Hierarchical Design

Note: If you have not yet installed OptiSPICE Schematics on your computer, follow the 
instructions in the ReadMe file provided on the installation CD before proceeding.

Manual Format

In all of the following sections, action instructions are shown in bold face like this, 
whereas explanatory text is shown in normal typeface.

The 5-minute Schematic Diagram

In this first tutorial section we will show you how quick and easy it is to put together a 
complete schematic diagram, generate a netlist, and run the simulation.

Tip: If you are new to Windows or have any questions about the operation of the tools and 
controls you see on the screen, you may want to refer to “User Interface” on page 3 before 
proceeding.

Starting the Program

• If it is not already running, double-click on the 
OptiSPICE Schematics   icon, or select the OptiSPICE 
Schematics item in the Start menu to start the 
program.

After a moment of loading the program and opening libraries, 
you will see the New Design dialog box.
9
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Creating a New Design
The Welcome box allows you to select a design mode for your 
application.  Each selection enables the group of options most 
commonly used for the application type.  All options can be 
changed later, if desired.

• Click on the Create/Open Design tab.

• Select  “OptiSPICE” in the list.

• Click the OK button.
You will now see an empty schematic drawing window ready for 
editing.

Saving the Design

• Select Save Design As command from the File menu 
to save the design.

File must be saved before creating netlist or running simulation.

Choosing a Library
• Move the cursor to the library selection pop-up 

menu and choose the library “Electrical”.

The contents of this library will now be displayed in the part 
selection list.

Note: The exact parts listing may vary from what is shown 
heres.

Selecting a Part

• Move the cursor to the part selection list and click 
once on the item “Resistor” to select it.  You will see 
a preview image appear in the box above the list.

• Double-click on the same item to place it in the 
drawing.  Move the cursor into the schematic 
drawing area.

An image of the selected part will follow the cursor movement.  
This part does not become a permanent part of the schematic 
until you click the mouse button.

Tip: To place a single device, you can also just drag and drop it 
from the parts list.
10
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Placing a Device

• Move the cursor to an area just left of the parts 
palette and click the mouse once to place a device in 
the schematic.

• Move and click again to place a second device as 
shown.  Order of placement is not important.

You can continue to place devices of the same type just by 
clicking in the desired locations. This automatic assignment can 
be disabled if desired.
Return to the normal pointer by pressing the spacebar on 
your keyboard.

Wiring Pins

• Move the arrow cursor exactly to the end of the 
output pin on the left-hand device, as shown, then 
click and hold the mouse button.

Wiring Pins (cont'd)

• With the mouse button still held down, move to the 
right away from the output pin.

• Move so the arrow cursor is exactly positioned 
over the end of the upper input pin of the right-hand 
device, then release the mouse button.

You will see the signal line flash briefly indicating that a connec-
tion has been made.

Moving Devices

• Click and drag on the right-hand device and move 
it to a new position, as shown.

Notice that the connected signal line stays attached and 
stretches to follow the device movements.

Using Undo/Redo

• Select the Undo command in the Edit menu. 

• Select the Undo command again, and repeat until 
all items you have placed have disappeared.

• Now select the Redo command and repeat it until 
all edits are redone.

Most schematic editing operations can be undone and redone 
up to 10 levels.  Major structural changes (like adding a page or 
hierarchy level) or any operation involving a dialog box cannot 
be undone.
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Part Selection by Name

• Click the mouse once in the Filter text box in the 
Parts Palette. 

You will notice a text cursor starts to flash in this box. 

• Type the characters “Ind” on the keyboard. 

• Double-click on the part “Inductor” in the list.

Automatic Pin Connection

• Move the cursor so that you can place the Inductor 
device exactly as shown so that the inductor pin just 
touches the pin of the Resistor. 

• Click the mouse button to place the device at this 
point.  (Depending on the size of your screen, you 
may need to use the scroll bar at the bottom of the 
schematic window to make room on the left.)  You 
will notice the two pins flash to indicate a 
connection. 

• Press the spacebar to return to the normal pointer.

Automatic Pin Connection (cont'd)

• Click and drag the Inductor device to the left and 
notice that right-angle lines maintain the 
connections between the two devices.

Placing more devices

• Place devices Vpulse, Capacitor, and Ground from 
the Electrical library as shown (follow the same 
directions as in the “Placing a Device” section)
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Wire Editing

• Using the pointer tool,  click and hold on the left 
Inductor pin.

• Move to the location shown and release the mouse 
button.  (You may have to modify this procedure 
slightly depending on the exact positions of your 
symbols.)

Notice that a small perpendicular mark is placed at the end of 
the signal line.  All unconnected line ends are marked this way 
automatically to simplify checking for missed connections.

• Click and hold on the end of the line just completed 
and connect it to the top pin of the Vpulse device.

Wire Editing (cont'd)

Note: If you're using a small screen, you can hide the Parts 
palette at any time by clicking in the “go away” box at its top left 
corner.  To re-display it, use the “Parts Palette” command in the 
Window menu.

• Using the pointer tool,  click and hold at a point 
midway along the vertical line (or any line) just 
created.  Notice that you can drag this line segment 
sideways.

With the pointer tool, clicking at the end of a pin or line segment 
or at an intersection allows you to extend the signal.  Clicking in 
the middle of a segment allows you to move that segment.  The 

signal drawing tool ( ) can be used to draw from any point.

Complete signal connections

• Using above guidelines complete the signal 
connections as shown.
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Entering Device Parameters

• Double click on the Vpulse device to launch Device 
Parameter Editor.

• Enter the following parameter values in the dialog 
box: pulsed voltage = 1, rise time = 1n, fall time = 1n, 
pulse width = 3n, and period = 8n.

You can enter parameter values for any device in the parame-
ter editor dialog box. For details of device parameters see the 
Device Library manual.

Placing Probes

• Select the library “Probe” in the Parts Palette.

• Select the device Probe.
A probe can be either placed on a signal or a pin. When placed 
on a pin it will be a voltage probe (if the signal type is electrical). 
When placed on a pin, it will be a current or an optical probe 
depending on type of the pin.

Placing Probes (cont'd)

• Place the first Probe on the signal connecting 
Vpulse and Inductor as shown (voltage probe).

• Place the second Probe on the second pin of R1 
(current probe).

Simulation Setup

• Select Setup from the Analysis menu.
This will launch the Setup dialog box where you can specify the 
type of simulation and other details. For more details see 
OptiSPICE simulation manual.
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This completes the tutorial section “The 5-Minute Schematic Diagram”.

Simulation Setup (cont'd)

• In the Setup dialog box check the “Value” box for 
“Transient”

• Switch to the “Transient” tab.

• Enter 0.01n for “Print step size” and 20n for “Stop 
Time”.

• Click OK.

 

.tran 0.01n 20n 

R1 SIG7 SIG8 1k 
R2 SIG8 0 1k 
L1 SIG9 SIG7 10u 
C1 SIG7 SIG8 1n 
Vpulse1 SIG9 0 PULSE 0.0 1.0 0.0 1n 1n 3n 8n 

.END

Viewing Netlist

• Select View Netlist the File menu.
You can view the OptiSPICE netlist of your design on a new 
window. You can edit and run the netlist. For details on netlist, 
see OptiSPICE netlist reference.

Running simulation

• Select Run from the Analysis menu.
This command will generate the netlist and run the simulation. 
For post-processing details see, OptiSPICE post-processing 
manual.
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Advanced Schematic Editing

In this tutorial section, we will cover advanced schematic editing techniques, 
including:

• More editing techniques and shortcuts

• Using pop-up menus

• Multipage schematics

• Sheet size settings

• Text notations and graphics

This tutorial will continue using the file created in the last section.  Open the file you 
created, or use the file “5-Minute Schematic” provided in the “Examples” folder. 

Navigating Around the Schematic

• Right-click in an empty area of the 
schematic (i.e. not on a device or signal 
line).

• In the pop-up menu that appears, select 
the command Reduce to Fit.

The screen display will be zoomed out to fit the entire 
schematic in the window. The commands “Zoom In” 
and “Zoom Out” can also be used to expand or reduce 
the screen display.

Navigating Around the Schematic (cont'd)

• Click on the magnify ( ) tool in the 
toolbar and then click at the point where the 
probe connected to the pin of R1.

Clicking the magnifying glass tool  zooms in on that 
part of the schematic.  Some less obvious uses of this 
tool are:

• Clicking and dragging down and right 
causes the display to zoom so that the area 
swept over just fits in the window.

• Clicking and dragging up and to the left a 
small amount causes the display to zoom 
out one step.

• Clicking and dragging up and to the left a 
large amount (more than 1/2 the screen) 
causes the display to do a Reduce to Fit.
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Deleting a Group of Objects

• Using the pointer ( ) tool, click and 
drag from the left of R1 to the right of C1 as 
shown. 

• This will highlight and select R1, C1, 
Probe, and signals connected to them.

• Hit the Delete key on the keyboard to 
remove these items.

• Connect L1 and R2 directly.

Placing Page Connector

• In the Parts palette, select a “Page Conn” 
device in the Pseudo Devs library

• Place and connect the symbol as follows.
The Page Connector symbol indicates that this signal 
will be connected to other signals with the same name 
on other pages of the schematic.  Without this symbol, 
connections by name occur only within a single page.

Placing Page Connector (cont'd)

• Using the naming ( ) tool in the toolbar.

• Click on the Page Connector symbol.

• Type the name “A” on the keyboard, then 
hit the Enter key.
17
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Using the Clipboard

• Return to the pointer tool and click in an 
unused area of the schematic to ensure that 
no items are selected.

• Click on the page connector

• Holding the Shift key on the keyboard 
pressed, click on the signal connected to 
the page connector and then on the 
inductor and resistor.  All of these items 
should now be highlighted.

Using the Shift key, you can select any collection of 
items on one page.  These items can then be operated 
on in subsequent menu commands.

• Select the Copy command in the Edit 
menu.

Adding a Page

• Select the Pages command in the Drawing 
menu.

• Click on the New Page button.

• Click on the Done button.
We have now added a second page to the circuit, 
which can be edited in its own window.  The second 
page is still logically part of the same circuit and will be 
stored in the same file.  A single circuit can have up to 
1000 pages.

Adding a Page (cont'd)

• Select the Paste command in the Edit 
menu.  A flickering image of the bus lines 
copied from the first page will now appear.

• Using the arrow keys, orient this entire 
group so that the Page Connector is on the 
left and the breakout is on the right.

• Click the mouse button to place the circuit 
segment in the middle of the page.

You will notice that a new notation appears next to the 
Page Connector symbol.  This is an automatic page 
reference which indicates the page and grid position of 
other page connectors attached by name to this one.
18



 TUTORIAL
Setting Sheet Size

• Select the Sheet Size Wizard command 
from the Drawing menu.

• Click on the “Adjust all pages in the 
current circuit” box, if it isn’t checked 
already.

• Click on the Next button.

• Click on the Fixed border size button, if it 
isn’t selected already.

• Click on the Next button.
There are two general methods for setting sheet sizes 
in OptiSPICE Schematics.  The “use printer setup” 
mode automatically adjusts the size of the sheet you 
see on the screen to match your current printer set-
tings.  This is generally the most convenient in that it 
guarantees that the border you see on the screen will 
fit exactly on the paper.
The “fixed sheet size” mode is preferable if you will be 
switching to a variety of printers and want the border 
size to stay fixed at a specified size.

Setting Sheet Size  (cont'd)

• Select the standard sheet size ANSI C – 
22W x 17H from the popup list of standard 
sizes.

Note that the list of standard sheet sizes can be cus-
tomized using settings in the initialization file, so the 
list of settings you see may not match the ones shown 
here.  If the one mentioned above is not in the list, pick 
any one that suits you at this point.
Click on the Next button.

Setting Sheet Size  (cont'd)

• Select the “scale to fit printed page” 
option, if it is not already.

• Set the width and height settings to 1 and 
1.

These settings will produce a large printed area on 
the screen and cause the program to scale the 
page automatically when printed to provide the 
best fit on the paper available. 

• Click on the Finish button to apply the new 
settings.

Select the Reduce to Fit command in the Drawing 
menu to observe the new sheet size settings.
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This concludes the tutorial section “Advanced Schematic Editing”.  The remaining 
tutorials deal with specific areas of the program and do not make further reference to 
this file.

Adding Text Notations

• Move to an unused corner of the 
schematic page.

• Select the text (A) tool in the toolbar.

• Click in an open area of the schematic (i.e. 
not on an existing device, signal or text 
item).  You will see a blinking text insertion 
point appear.

• Type “All resistors 10% tol. unless 
otherwise noted”, or any other notation that 
suits you.  Carriage returns can be used in 
text notations, if desired.

• Click outside the text entry rectangle to 
terminate editing.

Text notations created in this fashion are stored with 
the circuit, but are not associated with any device or 
signal and will never appear in a netlist.

Adding Text Notations (cont'd)

• Right-click on the text item that was just 
created.

• Select the Properties option.

• Click on the Text Style button.

• Use the controls in this box to set any 
desired text style.

• Click OK on both boxes to return to the 
schematic.

Text style can be set individually for random text nota-
tions such as this one.  Other forms of text such as 
attribute and pin numbers have global text style set-
tings, but cannot be set individually. 
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Device Symbol Editing and Hierarchical Design

In this tutorial section we will cover some of the OptiSPICE Schematics features for 
creating and editing device symbols and associating internal circuits with them.

Creating a New Library

• Right-click on the Parts palette and select the 
New Lib command in the pop-up menu.

• Create a new library called My Lib in the Libs 
folder inside the OptiSPICE Schematics folder.

Device library files hold collections of part symbols along 
with associated pin function information, default attribute 
values and internal circuit definitions.  A single library can 
contain from one to thousands of part definitions, to suit 
your needs.

Creating a Device Symbol

• Select New command in the File menu.

• Select Device Symbol option in the document 
type list and click OK.

The device symbol editor window contains a drawing area 
for your symbol, a toolbar and a pin list.  The toolbar 
includes standard drawing tools plus special items for nor-
mal, inverted and bus pin placement.

Setting Pin Name Visibility

By default, the symbol editor displays the name of each pin 
next to the pin stub.  For this example, we want to turn this 
off.  To do this:

• Make sure no graphic items are selected in the 
drawing area, then select the Properties 
command in the Options menu.

• Click on the Pin tab and turn OFF the Visible 
switch in the Pin Name area.

• Click OK
Setting items in the Properties command with no objects 
selected sets the default properties when future objects are 
created.
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Creating a Device Symbol (cont'd)

• Click on the polygon ( ) tool in the toolbar.

• Draw a symbol similar to the one shown by 
clicking once at each corner point and then 
double-clicking to terminate the polygon.

The position of the symbol in this window is not important.

Creating a Device Symbol (cont'd)

• Select the ( ) pin tool.

• Place input pins on the symbol by clicking at 
the positions shown.

• Select the ( ) pin tool.

• Place an output pin as shown.

Note: The crossbar portion of the T pin tool only appears 
during placement and dragging for alignment purposes.

Setting Default Part Attributes

• Select the Part Attributes command in the 
Options menu.

• Select the Part field in the list.

• Enter the value “OPAMP” or any other value.
These attribute values will appear as the defaults when this 
part is used on a schematic.  If desired, these values can 
be overridden for each individual device.
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Entering Pin Names and Numbers

• Double-click on the PIN1 item in the pin list.

• Enter the pin name “IN+” then press the Enter 
key.

• Double-click on PIN2 and enter the pin name 
“IN-” and similarly change PIN3 to “OUT”.

Note: Pin Number is for visibility purpose only. Pin function 
type is not important for OptiSPICE simulation.

Saving and Using the Part

• Select the Save As command from the File 
menu.

• Enter the part name “OPAMP” or any other 
desired name.

• Click on the “MyLib.clf” library in the list to 
select a destination and press “Save”.

• Close the symbol editor window.

Creating a Hierarchical Block

• Select the New command from the File menu.

• Select the Design option and click OK.

Creating a Hierarchical Block (cont'd)

• In the Parts palette, double-click on the 
OPAMP device that was just created.

• Place two of these devices on the schematic, 
as shown.

When new symbols are made in the symbol editor, they are 
set by default to be “Sub-Circuit” devices, meaning that an 
internal circuit can be created in them, even if none is pro-
vided initially.
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This concludes the tutorial section on Device Symbol Editing and Hierarchical Design.

Creating a Hierarchical Block (cont'd)

• Double-click on either of the OPAMP devices 
that were just placed.

• Click OK in the warning box to create a 
subcircuit.

A new window will now appear showing the internal circuit 
for this block.  When a new  subcircuit is created, “port con-
nector” symbols are automatically laid out to match the 
pins on the parent symbol.  Any signal connection made to 
a port connector becomes logically connected to the pin 
with the same name on the parent symbol.

Creating a Hierarchical Block (cont'd)

• Place VCVS device from Electrical library.

• Double click on the device and enter the gain 
value as 1e6 on the parameter editor dialog box.

• Click OK in the dialog box

• Place Ground device.

• Complete the signal connections as follows.

• Close the subcircuit window.
This will cause the definition of all devices of the same type 
to be updated throughout the design.  Double-clicking on 
any other device of the same type will now reveal the same 
subcircuit.
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Basic Procedures
This chapter provides a quick overview of a OptiSPICE Schematics and how it is 
stored. It will then provide simple procedures for creating, saving, opening, navigating 
around and printing documents, and look at the important issue of backup 
procedures.

OptiSPICE Schematics File Types

OptiSPICE Schematics deals with a number of different types of files. Far and away 
the most important type is the design file, which contains all the stored data of your 
schematics. Operations on design files are discussed in this chapter. More 
information on the other types of data files that you may encounter can be found in 
these parts of the manual:

This table summarizes the types of files used in OptiSPICE Schematics:

Design Structure

In OptiSPICE Schematics the term “design” refers to a complete, independent logical 
entity which is saved in a single file. The following rules outline how a design is stored:

• A single design is stored in a single file and no logical connections are made 
between designs. All information required to display and edit a design is stored in 
the design file.

• A design never makes reference to external library files. When a library device is 
used, all information needed is read from the library and stored with the design. 
Changing the original library definition will not automatically update the design. 
More information on the relationship between symbol libraries and designs can 
be found in “Device Symbols and Libraries” on page 143.

• When a design file is opened, the entire contents of the design are read into 
memory. This means that design sizes are limited by the available memory in your 

Description File Extension More Information
Design Files OSCH This chapter

Symbol Library Files CLF “Device Symbols and Libraries” on 
page 143

JavaScript Files DWJ OptiSPICE Schematics JavaScript 
User’s Guide (separate manual on 
disk)

Design and Sheet Tem-
plate Files

OSCH “Design Templates and Customization” 
on page 183

Initialization Files INI “Appendix A - Ini File Format” on page 
199
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computer and increasing the memory allocated to the program will increase the 
size of the designs you can work with.

• A number of user-settable parameters are stored with the design and affect the 
entire design when changed. These include:

• attribute and pin number text style settings

• the attribute definition table

• signal and device auto-naming settings

• display options, such as crosshairs and printed page breaks

• page reference format

• hierarchy mode

• In a hierarchical design (that is, one in which a symbol can represent a nested 
circuit block), all hierarchy levels are stored in a single file. More information on 
hierarchical design is in “Hierarchical Design” on page 115.

What is a Circuit?

A circuit in OptiSPICE Schematics has these characteristics:

• A circuit can be drawn on one or more pages (up to 1000). You can elect to draw 
the entire circuit on a single page or divide it up functionally onto a number of 
pages.

• Each page is viewed in a separate circuit window and any or all pages in a circuit 
can be displayed on the screen simultaneously.

• A page is drawn on the screen as if it was a single piece of paper, although it may 
have to be broken up into a number of individual sheets of paper for printing or 
plotting.

• Logical connections can be made between pages using the Page Connector 
device allowing for full simulation and netlisting across pages.

Types of Objects in a Circuit

A OptiSPICE Schematics circuit is made up of four types of entities: devices, signals, 
text objects and picture objects.

• A device is an object having a symbol, signal connection points called “pins”, and 
optional text attributes, internal circuit and simulation information. A device in 
OptiSPICE Schematics can correspond to a physical device in a circuit, or it can 
represent a sub-circuit block or a pseudo-device, such as a page connector or bus 
breakout.

• A pin is a connection point on a device. A pin is not an independent entity since it 
only exists as part of a device and cannot be created or deleted separately. 
However, pins can have attributes, pin numbers and other parameters that may 
be different from pin to pin on the same device. A bus pin is a special type of pin 
that represents an arbitrary number of internal pins. The internal pins are not 
visible on the schematic but can still have the same logical properties as other 
pins.
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• A signal is a conductive path between devices. Signal connections can be made 
visually by drawing lines between device pins, or logically by name or bus 
connection.

• A text object is used to place a title block or other notation on the diagram. Text 
can be typed and edited directly within OptiSPICE Schematics, or can be created 
externally and pasted onto the diagram from the clipboard. Text objects are not 
associated with any other object and are not accessible through net or component 
lists. The attribute facilities should be used to associate text with specific devices 
or signals.

• A picture object is used to place any graphics item imported from another 
program or the symbol editor tool via the clipboard. The Schematic tool cannot 
edit picture objects directly, other than moving, deleting and copying them whole. 
They can, however, be pasted into a symbol editor window, edited using the 
device symbol tools, then copied and pasted back into the schematic.

Creating a New Design

A new design is created by selecting the New command in the File menu, then 
selecting Design, and then choosing from one of the available templates. The new 
design will consist of an empty circuit with a single page. The New command does not 
create a disk file. The design exists only in memory until you do a Save As.

Your circuit diagram is created by first placing one or more devices in the circuit 
window (as described below), and then interconnecting the device pins with signal 
connections.

Choosing a Template

OptiSPICE Schematics does not have a fixed set of templates, but rather displays the 
ones that are available in the designated Templates folder. See the accompanying 
sidebar for more information on how this is done. A template may contain a variety of 
initial settings for options and items such as a sheet border and title block, that make 
it easier for you to get started on a design. We encourage you to create your own 
templates that suit your application, once you are comfortable with the basic operation 
of OptiSPICE Schematics.

See See “Design Templates and Customization” on page 183 for more information. 
for more information on creating design templates.

Note: A template is only a convenient way of starting out with the appropriate settings for 
a certain type of design.  There is nothing in a template that is carved in stone and all 
settings in the design can be changed later if your requirements change.

To get started: If you have just installed OptiSPICE Schematics and want to start a 
basic design, pick the template that is closest to your application.  The OptiSPICE 
template is the default choice for board-level designs. 

Opening a Design

A design file can be opened in one of two ways:
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• Select the Open command in the File menu. This command allows a design to be 
opened from a disk file using the standard Windows file open box.

• Locate the file using the Windows Explorer and double-click on the file’s icon. If 
OptiSPICE Schematics is not already running, it will be started up. If it is already 
running, it will come to the front and the selected file will be opened.

When you open a file, the circuit data is read into memory in its entirety and no more 
access to the disk file is required.

There is no fixed limit on the number of designs that can be open at once, although 
the complete contents of all open designs must fit into memory.

Navigating Around a Schematic Page

In addition to the standard scroll bars, OptiSPICE Schematics has these convenient 
features for moving around a diagram:

Zooming In and Out

Controlling Zoom by Menu Commands

The Drawing menu contains four menu items for controlling the zoom factor of a 
window: These commands control screen display only and have no effect on the 
stored circuit information, printed output, or graphics files. Due to the integer 
calculations that are done by OptiSPICE Schematics and by the Macintosh system, 
device symbols and text may be displayed rather crudely at scale factors other than 
100%. It is best to do most editing at normal size to ensure that everything lines up as 
you would expect.

Normal Size Sets the screen scale to 100%.

How Design Templates Work

A design template is simply a normal design file that has its sheet size, 
attribute fields, hierarchy mode and other settings pre-defined for the 
application at hand. The simplest way to create a template may be to 
take an existing design that is set up the way you like it, delete all the 
circuit elements and extra pages out of it and save it in the appropriate 
template directory.

When you create a new design and select one of the template files 
listed, OptiSPICE Schematics just reads the file in the normal way, then 
renames it “Circuit1” (or the next available number), and disassociates 
it from the original file so that it cannot accidentally be Saved on top of 
the template. In all other respects, creating a new design using the New 
command is the same as doing an Open on the template design. All the 
28



 BASIC PROCEDURES
Controlling Zoom with the Magnifying Glass Tool

The  item in the toolbar is a powerful tool for moving around in a schematic 
diagram. It can be used to zoom both in and out and can control the exact area 
displayed on the screen.

• Clicking and releasing the mouse button on a point on the diagram will zoom in to 
that point by one step.

• Clicking and dragging the mouse down and to the right zooms in on the selected 
area. The point at which you press the mouse button will become the top left 
corner of the new viewing area. The point at which you release the button will 
become approximately the lower right corner of the displayed area. The circuit 
position and scaling will be adjusted to display the indicated area.

• Clicking and dragging the mouse upward and to the left zooms out to view more 
of the schematic in the window. The degree of change in the scale factor is 
determined by how far the mouse is moved. Moving a small distance zooms out 
by one step (equivalent to using the Reduce command). Moving most of the way 
across the window is equivalent to doing a Reduce to Fit.

Opening Circuit Page Windows

In OptiSPICE Schematics, each circuit page is displayed in a separate window that 
can be opened, closed, scrolled and zoomed independently. The Pages command 
can be used to display any existing page, as well as adding new pages and setting 
page order and title.  The Pages command can be found in the Drawing menu in the 
main menu bar, or in the circuit popup menu which is displayed by right-clicking in an 
empty location in the diagram.

See more information on the Pages command in “Creating a New Page” on page 46.

Locating Circuit Objects with the Find Tool

The find tool allows you to locate any device, signal or pin by name or other 
parameter. It will automatically open closed pages and adjust zoom and scrolling to 
highlight the located objects. To use it:

• Select Find in the Drawing menu.

• Select the type of object you wish to search for, device, signal or pin.

• Enter the name of the object to search for, or other search criteria.

Reduce to Fit Sets the scale factor and centers the display so that the entire 
diagram fits on the screen. If the size of the diagram and the size 
of the window is such that this would require a scale factor of less 
than 20%, then the scale is set to 20% and the diagram is 
centered. If the diagram fits completely in the window at 100%, 
then the scale is set to 100% and the diagram is centered.

Enlarge Increases the scale factor by about 20%, causing the diagram to 
appear larger on the screen. If this causes the setting to exceed 
the maximum of 200%, it is set to the maximum.

Reduce Decreases the scale factor by about 20%, causing the diagram to 
appear smaller on the screen. If this causes the setting to go 
below the minimum of 20%, it is set to 20%
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• Click the Search button.

The Find tool automatically displays the first item found. The list of found items can 
be used to look at any other objects matching the search criteria.

Tip: The Find tool is scriptable and can be customized to find objects or scan the design 
for many different purposes.

More detailed information on the Find tool is provided in “Using the Find Tool” on 
page 136.

Locating Objects Using the Browser Tool

The Browser tool is a convenient way of viewing all objects in the design in tabular 
format. Clicking on any item in the Browser’s spreadsheet area automatically displays 
the corresponding item in the schematic.  To display the Browser, select the Browser 
command in the View menu.

Saving a Design

An open design can be saved to disk using the standard Save and Save As 
commands in the File menu. Save saves the circuit back into the file that was most-
recently opened. It will be disabled if no file has been opened or if you’ve created a 
new design that has never been saved. If you select Save As, a standard file save 
box will be displayed requesting the name the new file. The default name will be the 
current title of the circuit window, i.e. the name of the most recently opened or saved 
file.

Reverting to a Saved File

The Revert command in the File menu rereads the current design from the disk file it 
was last saved to or read from. If any changes have been made since the last Save, 
you will be prompted to confirm the choice before they are discarded.

Saving a Circuit Page in WMF, DXF or PDF Graphics Formats

OptiSPICE Schematics can save diagrams in the standard WMF (Windows Metafile), 
DXF (AutoCAD) and PDF (Portable Document Format, also known as Acrobat 
format) graphics formats. This capability allows you to pass graphics to other 
programs for plotting, enhancement, or incorporation into other documentation. Here 
is some more information on these formats:

• WMF is a standard format under Windows for representing graphics objects such 
as lines, circles, text, etc. This format can be read by many Windows-based 
graphics and word processing packages. Note that OptiSPICE Schematics 
cannot read these files, it can only create them. A WMF file is strictly a graphics 
format and does not contain information about signal connectivity, pin functions, 
attributes, etc.

• DXF is a format developed by AutoDesk for use with their AutoCAD series of 
general CAD packages. In addition to AutoCAD, most general drafting packages 
can read and write DXF. Like WMF, a DXF file is strictly a graphical representation 
of a diagram and does not contain all the information necessary to construct a 
30



 BASIC PROCEDURES
logical schematic.  OptiSPICE Schematics has no ability to read DXF files.  Note 
that Enhanced Metafile and bitmap pictures that have been pasted onto a 
diagram (e.g. for a logo in a title block) are not exported to DXF.

• PDF is a standard file format used for displaying print-quality documents in 
portable format that can be sent over the internet and displayed on any platform. 
A PDF format is strictly a graphics format and does not contain any information 
about signal connectivity, etc.  For this reason, it cannot be re-imported back into 
OptiSPICE Schematics.

Generating a WMF File

To export a WMF (Windows Metafile Format) file:

1 Open the design file you wish to export.  If your design has multiple pages 
and you only want to export one of them, make that the current page (i.e. the 
topmost window).

2 Select the Export command in the File menu.

3 Select the WMF option and click Next

4 Select either “Export all Pages” or “Export Current Page Only”, as 
appropriate.

5 If desired, click the Browse button to enter a different filename.  The default 
will be the same name as the design with the extension changed to “WMF”.

6 Click the Finish button to complete the operation.
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Generating a DXF File

To export a file in DXF format:

1 Open the design file you wish to export.  If your design has multiple pages 
and you only want to export one of them, make that the current page (i.e. the 
topmost window).

2 Select the Export command in the File menu.

3 Select the DXF option and click Next

4 Select the appropriate color option. If you choose the “Export Color 
Information” option, OptiSPICE Schematics will choose the closest standard 
DXF color for each object on the schematic.

5 Choose whether you want to use Release 12 or Release 13 format.  Release 
13 provides better representation of curves and ellipses, but is not compatible 
with all readers.  You should try a test run with the desired target application 
(making sure your test includes a variety of symbols) before doing any major 
conversions.

6 Click the Next button.

7 Select either “Export all Pages” or “Export Current Page Only”, as 
appropriate.

8 If desired, click the Browse button to enter a different filename.  The default 
will be the same name as the design with the extension changed to “WMF”.

9 Click the Finish button to complete the operation.

Generating a PDF File

Note: This feature can no longer be accessed via the File/Export wizard. To save a 
schematic in PDF format a PDF distiller (such as Adobe Distiller) must first be 
installed on the same computer. To export the file select File/Print and then choose 
the name of associated PDF printer name (such as “Adode PDF”).
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Printing

The Print command allows you to print all or part of your circuit diagram to any printer 
or other output device that is selectable as a printing device.

Specifying the Page Number Range

For purposes of specifying a range to print, printed sheets are numbered from top to 
bottom, then left to right, starting on circuit page 1. The page range settings in the 
standard Print dialog box correspond to printed sheet numbers, not to circuit pages.

In multi-page circuits the print pages are numbered sequentially from the top left 
corner of circuit page 1 to the bottom right corner of the last circuit page. Page 
numbers do not appear in the printed output unless they are explicitly placed there 
using a text variable. See “Using Text Variables” on page 72.

In hierarchical designs, pages are numbered separately for each circuit level. The 
Design Preferences command is used to determine printing extent. See more 
information on printing in hierarchical designs in “Printing Hierarchical Designs” on 
page 122.

Setting the Printer Page Setup

The Print Setup command in the File menu allows you to choose the size and 
orientation of printer paper you wish to use. Once chosen, this information will be 
stored with your design file and affect the page outlines shown in the command and 
the Show Printed Page Breaks option in the Design Preferences command.  
Depending on the settings in the Sheet Size Wizard, the page setup may affect the 
displayed page border in your schematic
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Fitting the Diagram to the Available Paper

OptiSPICE Schematics has a very flexible ability to set the size of a circuit page, either 
independently of the current printer, or derived from the printer settings. The Sheet 
Size Wizard command in the Drawing menu is used to select from a number of size 
options.  If, as a result of these settings, the diagram will not fit on a single page, it will 
be broken into as many parts as are needed, based upon paper size specified in Print 
Setup. You can preview the page breaks by using the Show Printed Page Breaks 
option in the Design Preferences command.

Fitting a Printout to a Single Sheet

If the current sheet size settings are such that your printout does not fit to a single 
sheet on the current printer, you can force it to be scaled by taking these steps:

1 Select the Sheet Size Wizard command in the Drawing menu.

2 If your design has multiple pages or hierarchy levels, you will be asked which 
of these you want to modify, so make the appropriate selection, and click 
Next.

3 Select the “Fixed Border Size” option and click Next

4 The Wizard will have filled in the sheet size setting with the current sheet size, 
which you should not change, so just click Next.

5 Select the “Scale to Fit Printed Page” option and adjust the controls to print 
on 1 wide by 1 high.

6 Click Finish.

When the design is printed, each page will be scaled as needed to fit on a single sheet 
of paper according to the current printer settings.

More information on sheet size settings is given in “Setting Sheet Sizes and Borders” 
on page 184.

Backup Procedures

OptiSPICE Schematics has several backup features to allow you to fine-tune your 
backup strategy to suit your requirements. These features are controlled by inserting 
keywords in the INI file, as described in the following sections.

Enabling Auto-Backup on Save

When auto-backup is enabled, the following sequence of actions is performed every 
time you select the Save command in the File menu when a circuit file is current:

• The existing design file is renamed to the same name with “.bak” appended. If a 
file with the “.bak” extension already exists, it is discarded.

• The design is saved to a new file with the original design name in the same 
directory.

Note that the “created date” of the new file is set to be the same as the old file so it 
will retain its historical created date.
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The auto-backup feature is enabled by placing the following line in the INI file:
Backup = On

Important: If a disk failure occurs (such as disk full) while the file is being saved, the 
existing file will already have been renamed to “design.bak” and will not be automatically 
switched back to its original name by the program.

Enabling Timed Auto-Save

Timed auto-save allows you to request a prompt to save the design every time a 
specified number of minutes has elapsed. At the appointed time, a box will give you 
a choice of:

• Saving the file. This will also create an auto-backup file, as described above, if 
enabled.

• Postponing until another interval elapses.

• Disabling timed auto-save completely.

Note that if you choose the last option, timed auto-save will be disabled until you quit 
and restart the program.

Timed auto-save is an extension of the auto-backup feature and is enabled by placing 
the following line in the setup file:
AutoBackup = 30

where “30” can be replaced by any desired number of minutes.

See “Enabling Auto-Backup on Save” on page 34 for more information.

Closing a Design

The Close command in the File menu closes all the circuit windows associated with 
the current design and removes all data from memory. If the design is hierarchical, all 
hierarchy levels will be closed. If any changes have been made to your design since 
the last Open or Save, then you will be asked if you wish to save those changes. The 
same effect is achieved by clicking the “Go Away” box in the upper left corner of the 
last circuit window.

Disposing of a Design

OptiSPICE Schematics has no built-in command to dispose of a design file. All 
information about a design is stored in a single file. Deleting the file using the 
Windows Explorer (or any similar system command) has the effect of erasing all data 
concerning that design.

Exiting OptiSPICE Schematics

The Exit command in the file menu closes the OptiSPICE Schematics application. If 
any designs are open and have been modified, OptiSPICE Schematics will ask if you 
wish to save them.
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Basic Schematic Editing
The purpose of this chapter is to give you enough basic schematic editing procedures 
to allow you to create and edit a complete schematic diagram in OptiSPICE 
Schematics. This chapter will also point you to later chapters for more in-depth 
information on specific topics.

General Editing Operations

Undo and Redo

The Undo command undoes the last editing operation that was performed. The text 
of this menu item will change based on the type of operation. Generally, only 
schematic editing operations can be undone. Major structural changes, such as 
Define Attribute Fields, adding pages, or any menu commands involving a dialog box 
are usually not undoable. OptiSPICE Schematics stores up to 10 levels of Undo 
information.

Undo never changes the contents of the Clipboard. E.g. after a Cut operation, Undo 
will restore the schematic, but leave the Cut objects on the Clipboard.

The Redo command redoes the last Undo command. It will only be enabled 
immediately after an Undo operation. Any other editing operation will disable this item.

The Clipboard Commands

The standard clipboard commands Cut, Copy, Paste and Paste Special can be used 
to move or copy circuit fragments, graphical and text information within a single circuit 
window, between multiple windows, and between different programs (e.g. word 
processing or drafting).

Using Clipboard Data From Other Programs

When you enter OptiSPICE Schematics, the clipboard may contain graphical or text 
information Cut or Copied from a document in another program.

Picture (Graphical) Clipboard Objects:  

A picture can be Pasted directly onto your diagram in any desired position. Once 
placed, it can be dragged, Zapped, Cut, Copied, Duplicated, etc. using the various 
editing commands available for other circuit elements. Here are some notes on 
pasting pictures onto a schematic.

• When a picture item is selected, the Properties command can be used to select 
an optional border and to indicate that the picture should be considered to be part 
of the sheet background or border.

• A picture object is considered to be a monolithic item on a schematic and can only 
be moved or deleted in its entirety.

• OptiSPICE Schematics accepts pictures from the clipboard in either Bitmap or 
Enhanced Metafile format. The Bitmap format is typically produced by “paint” 
programs, such as Windows Paint, Corel Photo-Paint, Paint Shop Pro, and many 
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others.  Bitmap format is not generally recommend as it does not scale evenly and 
gives relatively poor printing results.  Enhanced Metafile Format (EMF) is 
produced by object-oriented drawing programs, such as the drawing tools in 
Microsoft Word, Corel Draw, etc.  EMF is much better suited for creating 
mechanical drawings or logos since it will reproduce much better on a variety of 
output devices.  In some cases, programs may place both types of images on the 
clipboard.  You can use the Paste Special command (described on page 39) to 
select which type of data is used.

Text Information on the Clipboard  

Text information from a word processor or text editor can be pasted into a text block.  
See “Creating a Text Block” on page 69 for more information..

Using Clipboard Data From OptiSPICE Schematics

When a Cut or Copy is done, two types of data are placed on the clipboard:

• A picture of the selected items, which can be pasted into a graphics document 
using most drawing programs.  Both bitmap and Enhanced Metafile Format 
versions of the picture are placed on the clipboard.

• The OptiSPICE Schematics circuit info for the selected items. This data is in a 
format that only OptiSPICE Schematics can understand and is discarded when 
you exit the program.

Warning: Circuit structural information on the clipboard is discarded when you quit the 
program. Only picture and text data is retained. You cannot Copy and Paste circuit data 
between OptiSPICE Schematics sessions.

Cut and Copy work on the currently selected group of circuit objects and will be 
disabled if no objects are selected. When items are copied onto the clipboard, their 
names are copied with them, which may result in duplicate names. If duplicate signal 
names are pasted back into the circuit page they were copied from, then logical 
connections will be made between the like-named segments.

Cut

Cut removes the currently selected objects from the circuit and transfers them to the 
clipboard. It is equivalent to doing a Copy and then a Clear. Cut will be disabled if no 
objects are selected

Tip: As well as the standard location in the Edit menu, there are also Cut, Copy, Paste, 
Clear and Duplicate commands in the Device and Signal pop-up menus. These operate on 
the single object that was clicked on to display the menu.

Copy

Copies the currently selected objects onto the clipboard without removing them. This 
can be used to duplicate a circuit group, copy it from one file to another, or to copy a 
picture of the circuit group to a drawing program. See the notes on clipboard data 
above. Copy will be disabled if no objects are currently selected.
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Paste

Paste replaces the cursor with an image of the contents of the Clipboard in the circuit 
window. The data being pasted may be a circuit group copied from within OptiSPICE 
Schematics, or it may be text or picture information created by another program. The 
image of the clipboard data can be dragged around and positioned as desired. The 
item will be made a permanent part of your diagram when the mouse button is 
pressed. Paste will be disabled if there is no information on the clipboard of a 
recognized type.

Paste Special

The Paste Special command performs the same operation as the Paste command 
described above, but it allows you to select a number of options for how the data is 
used.  Here is a typical box that will be displayed in response to this command:
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Clipboard Format  

The clipboard format selection provides a list of the data formats that are currently on 
the clipboard and are acceptable to OptiSPICE Schematics.  The following table 
summarizes the common formats that you will see in this list.

Obviously, the exact contents of this list will depend on what Cut or Copy operations 
have preceded the selection of the Paste Special command.

Device Naming Options  

This selection allows you to choose how names are applied to any devices contained 
in the circuit data on the clipboard.  You can choose to apply a new name based on 
the current settings for naming, or to keep all names as they are.

Important: Pasting with the “keep existing names” option may create duplicate device 
names that will render the name table invalid.  It will then be your responsibility to make 
any corrections needed and use the Rescan Design command to bring the name table up 
to date.

Bitmap Picture This is the most common graphics format created and 
used among Windows applications.  In general, this 
format is not recommended as it does not print and 
scale well.

Enhanced Metafile 
Picture

This is the Windows “object graphics” format, i.e. it 
describes images as collections of lines, circles, etc.  
For this reason, it is better suited as a format for printed 
logos, mechanical drawings, etc.

OptiSPICE 
Schematics Picture

This is the internal graphics format for picture data (i.e. 
without circuit information) used in OptiSPICE 
Schematics.  This is the best format for copying images 
within the program as it preserves the image 
information exactly as it appears on a drawing.  
WARNING: This is strictly a graphics image format and 
contains no circuit connection data.  If you copy a 
collection of circuit elements, then paste it as a picture 
you are losing all the device and signal connection 
information.

OptiSPICE 
Schematics Circuit

This is the format used internally for normal clipboard 
operations involving schematic data.  Unless you have 
a good reason for choosing another format, this should 
be the default choice for all Paste operations on a 
schematic.

Unformatted Text This is a plain text format, accepted by most text 
processing and drawing programs.  Pasting text will 
place a “miscellaneous text block” on the schematic.
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Signal Naming Options  

The Signal Naming Options give you more control over the process of assigning new 
names to signals when circuit scraps are pasted back into a design.  The available 
options are:

• Assign new names to signals that currently have default names—This is the 
normal operation performed by Paste.  This option also renames signals that 
have a non-default name, but whose name is no longer visible because of the 
particular combination of elements that was copied.

• Assign new names to all signals—All signals will have a new name assigned 
except those that have a hard connection to a pseudo-device such as a bus 
breakout or ground connector that forces a name.  This guarantees that no 
connections by name are made with the new elements.

• Keep all existing signal names—This option guarantees that all names are 
pasted exactly as they appear in the original.

Connection Checking  

This checkbox allows you to turn off the normal connection checking that occurs when 
circuit elements are pasted.  This is described in more detail below.

Important: This option can result in diagrams that look connected, but are not.  It is the 
user’s responsibility to make sure the diagram is cleaned up to produce appropriate 
connection information for netlist purposes.

Signal Connection Checking on Paste

OptiSPICE Schematics checks for signal connections only at “loose ends” in the 
signal lines being pasted, i.e. ends of line segments which do not touch devices or 
other line segments. E.g. if the following circuit scrap was pasted, the points marked 
X would be checked for connection to the existing circuit.

Note: Connection “hit testing” can be disabled by holding the c key on the keyboard 
depressed while clicking the mouse button (this also applies to single device placing), or 
by using the Paste Special command, described above.  In this case, the circuit scrap is 
placed, but no connections will be made to adjacent items. This allows the group to be 
selected again (by  c-double-clicking on any device in the group) and moved without 
interactions with other objects in the circuit.

Duplicating One or More Objects

The Duplicate command makes a copy of the selected circuit group which can be 
dragged and positioned as desired. This is equivalent to selecting Copy and then 
Paste, except that the selected circuit scrap is not placed on the clipboard for future 
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use. See the notes under Paste, above, on how connections are made when a group 
is placed in the circuit. Note that the duplicated objects can be rotated using the arrow 
keys on the keyboard.

Rotation on Paste and Duplicate

Any group of objects being Pasted or Duplicated can be rotated using the same 
controls as when placing a device:

• The Orientation command in the Options menu.

• The arrow keys on the keyboard.

Note that these controls are only effective while actually moving the flickering image 
of the object being pasted. Each Paste or Duplicate always starts in the same 
orientation as the source.

Note: The Orientation command cannot be used for Paste or Duplicate since selecting this 
menu command will abort the paste operation.

Selection

Many OptiSPICE Schematics commands, such as Properties, Cut, Copy, etc., 
operate on the currently selected objects. In general, any object can be selected by 
clicking on it, but a few exceptions exist and numerous other convenience features 
are available. For a detailed list of the techniques available for selecting objects, see 
the following procedure sections in this chapter.

Selecting Groups of Objects

Several methods are available for selecting multiple objects:

1) Any group of adjacent items can be selected by clicking and dragging across the 
group. A flickering rectangle will follow the mouse movement. Any object that 
intersects this rectangle when the button is released will be selected (except 
background objects).

2) A group of interconnected devices and signals is selected by double-clicking on 
any device in the group while holding the  c key pressed. If a circuit is completely 
interconnected, this will select the entire circuit.

3) The Select All command in the Edit menu selects all items on the current page 
except background items.

See “Selecting a Background Object” on page 74 for more information on background 
objects and how to select them.

4) The Shift key can be used in combination with any of the above methods to select 
multiple items. When the Shift key is held, the previously selected items are not 
deselected when a new item is clicked on. Thus you can add to the selected group 
until the desired collection of items is selected.
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Deselecting a Selected Object

All currently selected objects are deselected by clicking in an empty area of the 
schematic window. A single item can be deselected by holding the Shift key while 
clicking on it.

Multi-page Selection

The OptiSPICE Schematics commands that operate on selected objects normally 
only affect objects on the current page. However, some external tools, such as the 
Browser and Find, operate across pages and can select objects on non-current 
pages. This is done to allow global operations to be done without having to go to each 
page and perform separate editing operations. For example, Find can be used to 
locate all devices of a particular type and select them, then Browser can be used to 
display and edit their attributes.

Note the following rules for multi-page selection:

• Clicking in an empty part of a schematic window deselects all objects everywhere 
in the design.

• Switching from one schematic window to another does not change the status of 
any objects that were selected on either page.

• You can select objects on one page, switch to another page, and (using the 
normal Shift key technique) add items on the new page to the selected group.

• Editing commands like Cut, Copy and Clear will only affect selected items on the 
current page, even if objects are selected on other pages.

Zooming in on Selected Objects

The Go To Selection command causes the circuit position and scaling to be adjusted 
so that the currently selected items are centered and just fit in the circuit window. The 
scaling will be set to 100% maximum. This command works even if the selected 
objects are on a page other than the current one.

Adjusting the Position of All Objects on a Page

If you wish to adjust all the objects on a page to make room for editing or to re-center 
an edited drawing, you can:

• Use the Select All command in the Edit menu to select all the objects on the page, 
then click and drag inside any device symbol to move the entire group.

• Use the Center in Page command in the Drawing menu. This command moves 
all items on the current page (except text and picture objects marked as “border” 
items) so that the circuit objects (taken as a group) are centered in the page. If 
the “Auto-Expand” option is turned on in the “Custom Sheet Info” box, then this 
command may result in the number of pages required being reduced.

More information on the Custom Sheet Info command can be found in “Setting Sheet 
Sizes and Borders” on page 184.
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Showing Overall Circuit and Design Statistics

 If no objects are selected in the circuit (i.e. if you have clicked in an empty portion of 
the diagram) then Properties will display this general design information box:

The buttons on the right hand side of this box allow you to chose the scope of the 
displayed counts:

The following items of information are shown for the selected scope:

Current Page This selection shows information only on objects 
displayed in the circuit page displayed in the 
frontmost window.

Current Circuit This selection shows information on objects on all 
pages of the current circuit level.

Unrestricted Circuits This selection shows information on objects in the 
master circuit of the design and all subcircuits not 
marked as “Locked” in their respective Properties 
boxes.

Entire Design This selection shows information on all circuits in the 
design.

nnn devices This is a count of devices in the selected scope. 
Pseudo-devices, such as page connectors and 
breakouts are not included. In “Current Page” or 
“Current Circuit” mode, this count includes devices 
that have subcircuits. In “Unlocked Circuits” and 
“Entire Design” mode, this count includes only 
“bottom-level” devices, i.e. those without a subcircuit 
or whose subcircuit is not being listed.
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Setting Design Attributes

To edit text attributes associated with the design, you need to display the general 
design attribute editing box. This can be done in either of these ways:

• Click in an empty area of the schematic to ensure that no objects are selected, 
then choose the Properties command in the Options menu. This will display the 
circuit info box already described. In this box, click on the Design Attributes 
button.

• Select the Set Design Attributes command in the Options menu.

For more information on the usage of attributes, see “Entering and Editing Attribute 
Data - Basic Procedure” on page 80.

Making a Circuit Read Only

You can make a circuit read-only to prevent accidental modification to it. This is done 
by following these steps:

• Click in an empty area of the schematic to ensure that no objects are selected.

• Choose the Properties command in the Options menu. This will display the circuit 
info box already described. 

• In this box, turn on the Read Only switch. Note that this switch is enabled only 
when the “Current Circuit” button is selected since it only applies to one circuit 
level.

In a hierarchical design, the “Read Only” status applies only to the current circuit level 
in a hierarchical design and to all levels below it. Note that “Read Only” is not the 
same as “Locked” in that it allows you to view the circuit but not change it.

nnn signals This is a count of signal nets in the design, including 
unconnected pins. Signals that pass through more 
than one hierarchy level are included once for each 
level that they exist in.

nnn pins This is a count of device pins, not including pseudo-
devices.

nnn changes made This is a count of editing changes made since the 
design was created. This is intended to allow 
comparisons of different versions of the same file. 

nnnK memory used This is a count of the amount of main memory 
occupied by the selected part of the design, in Kbytes.
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Adding, Deleting and Titling Circuit Pages

The Pages command is used to create a new page, display an existing page, change 
page order, or set a page title. Executing this command will produce the following box:

Operations on pages are performed by selecting the pages in the scrolling list and 
clicking on one of the operation buttons. More than one page can be selected at a time 
(for all operations except setting the page title) by holding the Shift key pressed while 
clicking in the list.

Tip: You can right-click in an empty area of the circuit (i.e. not on a device or signal) and 
select the Pages command as a shortcut to display this box.

Warning: Operations in this box cannot be undone!!!

Opening a Page

The Open Page button causes the pages selected in the list to be displayed in a 
window. If a window is already open with the selected page, then it is brought to the 
front.

Creating a New Page

The New Page button causes a new, empty page to be added to the circuit and opens 
it in a new window.

Deleting a Page

The Delete Page button causes the page selected in the list to be deleted from the 
circuit. Note that the page must already be empty, i.e. all objects must have been 
removed from the page (for example using the Select All and Clear) commands 
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before this will be allowed. Higher numbered pages will be renumbered when this 
page is removed.

Changing Page Order

The Promote and Demote buttons allow you to change the number order of the pages. 
Promote causes all pages selected in the page list to be moved one step toward the 
front of the list, i.e. their page number will be reduced by one. All non-selected pages 
will be renumbered as needed. Demote similarly moves all selected pages toward the 
end of the list. Promote will be disabled if the first page is selected and Demote will 
be disabled if the last page is selected.

Setting a Page Title

The page title text box allows a title of up to 63 characters to be entered for the 
selected page.

Tip: This title can be displayed in text notations and title blocks using the $PAGETITLE 
variable. See “Using Text Variables” on page 72.

Working with Device Symbols

Placing a Device From a Library

To select a device from a library for placement in the schematic:

Select the desired library using the pop-up menu at the top of the Parts palette. The 
palette displays only the contents of only one library at a time. If the library file you 

About Device Libraries

The symbols and related parameters for OptiSPICE Schematics devices 
are stored in data files called symbol libraries. Libraries can be opened 
and closed using the Open Lib and Close Lib commands, or using 
entries in the initialization file.

For each device type in a library the following data is stored:

• general information on the type, such as number of pins, number 
inputs, number of outputs, type name, default attributes, position, 
orientation and type of each pin, etc.

• a picture representing the symbol for this type.

• a polygon outlining the symbol, used for highlighting and erasing the 
symbol.

• an optional internal circuit definition.

How Device Symbols are Created and Stored

Libraries are created and modified using the device symbol editor tool, 
which is described elsewhere in this manual.

See “Device Symbols and Libraries” on page 143 for more information.
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need is not open, you can open it using the Open Lib command in either the Libraries 
sub-menu of the File menu, or in the Parts palette pop-up menu.

• If necessary, use the scroll bar to scroll the list until the desired part name is in 
view.

• Double-click on the part name in the list.

• Move the cursor to the current schematic window.

The cursor will be replaced by an image of the selected device. While moving this 
image around, you can use the arrow keys on the keyboard or the Orientation menu 
command to rotate the symbol.

Clicking anywhere in the circuit diagram will make a permanent copy of the device at 
that point.

Tip: Holding the  c key while clicking will inhibit checking for pin connections. This allows 
you to select the device again and drag it to a new position without affecting any existing 
connections.

Setting Device Orientation

Device symbols can be placed in any of 8 different orientations, that is, the 4 major 
compass points, plus a 180 degree flip around each of those axes. The orientation 
that a symbol will be placed in is determined by the current orientation setting. This 
can be controlled in any of the following ways:

• The Orientation command sets the orientation (up, down, left, right, mirrored) that 
will be used next time a device is created. When this command is selected, the 
following box is displayed:

• The orientation can be set by clicking directly on the Orientation command in the 
Options menu. This displays a pop-up list of orientation icons that you can choose 
from.

• The orientation ca be set using the arrow keys on the keyboard. Press any arrow 
key once to select that direction. Press the same key again to flip the symbol 
around that axis.
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You can also flip and rotate a device symbol after it has been placed in the schematic. 
See “Flipping and Rotating a Device” on page 51.

Using the Parts Palette

Parts library contents are displayed in a floating palette window which looks like this:

The Parts palette displays the contents of the selected library file and allows any item 
to be selected for placement in the schematic.

Using the Part Name Filter

The Filter text box allows you to type characters which will reduce the size of the list 
and make it easier to locate the desired part. Simply click in the text box and type the 
desired characters. After a brief pause, the displayed part list will be reduced to only 
those parts that contain the typed string of characters.  To return to the full selection, 
delete all characters from this box.
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The name filter also accepts several simple “wild card” characters which help in 
locating items:

Creating or Editing a Part Symbol

To create or edit a part symbol, right-click in the parts list area and select the New Part 
or Edit Part commands.

See “Working With Symbol Libraries” on page 143.

Moving the Parts Palette

The Parts palette can be moved to any desired location on the screen by clicking and 
dragging in its drag bar.  Right-clicking in the drag bar also displays several display 
option for this window.

See “Tool Panels” on page 5 for more information. 

Hiding the Parts Palette

The Parts palette can be removed from the screen by clicking in its close box. To re-
display the palette, select the Parts Palette command in the Window menu.

Duplicating an Existing Device

To duplicate an existing device, either:

• Select a similar device anywhere on the current circuit page and use the 
Duplicate command (either in the Edit menu or in the device pop-up menu).

• Select a similar device in any other page of any open design and use the Copy 
command. Return to the destination circuit and select the Paste command.

After either of these operations, the cursor will be replaced by an image of the 
selected device which can be placed by clicking in the schematic, as discussed 
above.

Deleting a Device

Devices can be removed by either of these two methods:

• Select the device by clicking on it (holding the Shift key if it is a switch or other 
input device) and then hit the “delete” or “delete” key on the keyboard, or select 
the Clear command from the Edit menu.

• Enter Zap mode by selecting the Zap command or clicking on the  in the 
toolbar, then click on the device in question.

Character Meaning Example

* Matches any string of zero or more 
characters

1*7 matches 17, 1775, DD123-7A

# Matches any string of 1 or more 
numeric characters

#P matches XX123P5, 1P, 
#5PART

? Matches any single character #?# matches 1234, 12X12, 
XX1X1, but not 1XX1
50



 BASIC SCHEMATIC EDITING
Moving a Device

Devices can be moved by either:

• Clicking and dragging to the desired new position, or,

• Using the arrow cursor keys on the keyboard to “nudge” the selected items one 
grid step at a time.

If more than one device is selected, all the devices, and all signals connecting 
between them (whether or not selected) will be moved. Signal lines will be adjusted 
to maintain right angles at points where moving signal lines intersect with non-moving 
ones.

Flipping and Rotating a Device

A set of four commands for flipping and rotating an existing device symbol can be 
found in the device pop-up menu, i.e. by right-clicking on the device. The Rotate 
Left/Right and Flip Vertical/Horizontal commands are equivalent to deleting the 
selected device and replacing it in the selected new orientation.

When placing a device symbol, you can determine its orientation in advance using the 
Orientation command or the arrow keys on the keyboard. See “Setting Device 
Orientation” on page 48.

Displaying and Setting Device Information

The device information box allows you to view and set a lot of vital information about 
the selected device. To display the device information box, either:

• Right-click on the device, then select the Properties command in the pop-up 
menu, OR,

• Select the device by clicking on it, then choose the Properties command in the 
Options menu.

Quite a few options are available from this box, as summarized in this table:

When a normal device symbol is selected on the schematic (i.e. not a pseudo-device), 
then the following information box is displayed:
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The following table lists the information and options available in this box.

Part Type This is the library type name of the device symbol, i.e. the 
name as it appears in the Parts palette. This is not the same 
as the Part attribute field.

Primitive Type This is the primitive type of the symbol. For standard types, 
the name is shown, otherwise the name “Reserved” is 
shown. The ordinal number of the primitive type value is 
shown in parentheses. This is normally only of interest in 
specialized applications.

Token Number This is a permanent number that is assigned to this device 
instance for use in internal OptiSPICE Schematics 
operations and some back annotation and other interface 
operations. More information on tokens can be found in 
“Device Token Values” on page 122.

Subcircuit Size If the selected device has a subcircuit, its memory size is 
shown in Kilobytes.

Show Pin Numbers This switch allows you to disable the display of pin numbers 
for the entire device. This is intended for discrete 
components or others where pin numbers are not normally 
shown on the diagram.

Lock Opening 
Subcircuit

This switch allows you to prevent the subcircuit (if any) of 
this device block from being opened for editing. See 
“Locking and Unlocking Subcircuits” on page 118 for more 
information.

Report Options This button allows you to select whether this device or its 
internal circuit will be listed for reporting by searching tools.
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Warning: Clicking Cancel on the Properties box does not cancel changes that were made 
in other boxes displayed using option buttons.

Entering Device Attributes

To enter device attribute, either:

• Right-click on the device, then select the Attributes command in the pop-up menu, 
OR,

• Select the device by clicking on it, then choose the Properties command in the 
Options menu, then click the Attributes button.

See more information on attributes in “Attributes” on page 79.

Device Names

Note: In this manual, we use the term “device name” to refer to the character string that 
identifies a unique device in the circuit. Typical device names might be “R23”, “C4”, “M6”, 
etc. This is distinct from the “type name” or “part name” that is used to distinguish the type 
definition that is read from a device library. Typical part names are “Resistor”, “Capacitor”, 
etc.

Device names may contain any letters, numbers or special characters that you can 
type on the keyboard, but are restricted in length to at most 32 characters. The name 
associated with an object can be placed anywhere on the diagram and will be 
removed if the object is removed.

Adding a Device Name by Typing on the Schematic

Enter “Text” mode by clicking on the Naming tool in the toolbar:

Note that once “Naming” is selected, the cursor changes to a pencil icon.    Two 
techniques are available to determine the position of the name:

• If you click the pencil cursor on a device and release it immediately, the flashing 
text cursor will jump to the default name location for that symbol. You can then 
type the name as desired on the keyboard, ending with the Enter key.

Pin Properties This button displays the Pin Properties box for the first pin on 
the device. Buttons on this box allow you to sequence 
through the other pins on the same device. See “Getting and 
Setting Pin Information” on page 65 for more on the Pin 
Properties box.

Attributes This button displays the standard attribute edit box for the 
device. See “Entering and Editing Attribute Data - Basic 
Procedure” on page 80 for more information.
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Note: A default position can be specified for any attribute use the methods described in 
“Using Default Position Fields” on page 88. If no position is specified, the program will 
calculate one.

• If you wish to determine the starting position of the text before you type it, press 
and hold the mouse button with the tip of the pencil positioned inside a device 
symbol. As long as you hold the mouse button down an I-beam cursor will track 
the mouse movements. The device name text will start at the position where you 
release the button. Type the desired name and press Enter, or click the mouse 
button anywhere. This sequence of steps is illustrated below.

Adding a Device Name Using a Menu Command

The name can be set by holding the š key while clicking on the device, and selecting 
the Name command out of the device pop-up menu. This command displays a simple 
edit box allowing you to enter or edit the device name. The “Visible” option in this box 
allows you to select whether the name is made visible on the schematic or simply kept 
as an invisible text attribute of the device.
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Repositioning or Removing a Name

Once a name is placed, it can be repositioned by dragging it using the Point cursor or 
removed using the Zap cursor. The device name will be removed automatically if the 
device is removed. Holding the c key depressed while moving a name (or any 
attribute value) disables the grid snap, allowing you to micro-position the name for 
alignment with other graphic items on the schematic.

Note: The “Name” is actually an attribute field, so all attribute editing techniques can be 
used on it. In particular, you can hold the š key while clicking on the name and the attribute 
pop-up menu will appear, giving you a variety of editing commands, described “Other Ways 
of Viewing and Editing Attributes” on page 87.

Selecting a Device

To select a device, the cursor must be in the normal pointer ( ) mode. A single 
device is selected by clicking the mouse button with the pointer positioned anywhere 
inside the device symbol or in any displayed attribute value associated with the 
symbol.

If the OptiSPICE Schematics Simulator option is installed, simulated input devices 
such as switches and keyboards can only be selected by holding the Shift key while 
clicking. This is necessary because a normal click is used to change the state of these 
devices when a simulator tool is active.

Creating and Editing Signals

In OptiSPICE Schematics, a signal represents the electrical connection between any 
number of device pins. A signal can simply be represented on a schematic by a single 
line or a number of connected line segments, or more complex structures such as 
connection by name, busses, cross-page connectors and hierarchy blocks can be 
used to simply the representation of large designs. In this chapter, we will look at 
simple signals and connection by name within a single circuit page. Busses and 
multipage signal interconnection schemes are covered in “Making Signal 
Connections” on page 97.
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Interconnecting Signals

If you draw a signal line such that the end of the line contacts a second signal line, 
then those two signals will be interconnected. Also, if you place a new device such 
that one of its pins contacts an existing signal line, that pin will be connected to the 
signal. If both of the two signals being connected were named, then you will be 
prompted to choose the name of the resulting signal. Whenever three or more line 
segments belonging to the same signal meet at a given point, an intersection dot will 
be placed at that point automatically.

Note: For efficiency, signals are only checked for connections at their endpoints and only 
signals actively being edited are checked. It is possible to create overlapping lines that do 
not connect by unusual combinations of editing operations. This situation is usually visually 
apparent at the time the editing is done since the intersection dot will be missing and the 
entire signal will not highlight when clicked on. You may wish to also use the Find tool to 
locate these situations.

See more information on connection checking in “Signal Connection Checking on 
Paste” on page 41.

Drawing From an Existing Line or a Device Pin

A line can be extended from the end of an existing line or device pin using the normal 
( ) cursor. Click and hold on the end of the pin and drag away from the pin. A pair 
of right-angle lines will follow the cursor away from the pin and long as the mouse 
button is pressed. Releasing the mouse button makes these lines permanent. If the 
end of the line (i.e. the point where the mouse button was released) touches another 
signal line, a connection will be made at that point.

Alternate line routing methods can be activated by pressing the c and a keys, as 
follows:
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The Shift key constrains the movement to a single vertical or horizontal line. The c 
key inverts the order of line drawing, and the š key switches to three line segments 
with a center break. 

Note: Holding the c key while clicking will inhibit checking for pin connections. This allows 
you to select the signal again and drag it to a new position without affecting any existing 
connections.

Creating an Unconnected Signal Line

The Draw Sig ( ) cursor can be used to create an unattached signal line, or can be 
used to extend an existing signal. Simply click anywhere in the schematic and drag 
away in the desired direction. Unlike the Point mode drawing method, above, the 
mouse button does not have to be held while creating signals in this mode. Double-
clicking terminates the signal line.

Editing a Signal Line

The following features are available to edit signal lines:

• Zap mode (entered by selecting the Zap command in the Edit menu or the Zap 
item in the toolbar) allows you to remove any single line segment from a signal 
connection. Zapping on a signal line removes only the line segment being pointed 
at, up to the nearest intersection, device pin or segment join point.
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• Selecting a signal line (by clicking anywhere along its length) and hitting delete or 
selecting the Clear command removes an entire signal trace.

• Drawing backwards along the length of an existing line causes the line to be 
shortened to end at the point where you let the button go.

• Clicking and dragging the middle of a signal line segment with the pointer cursor 
allows you to reposition the line. Vertical lines can be moved horizontally and vice 
versa.

• The pointer cursor can be used to start drawing from the ends or corners of an 
existing signal.

• The Draw Sig ( ) cursor can be used to start drawing from anywhere along an 
existing signal line. Double-clicking terminates drawing.

Checking Signal Interconnection

Double-clicking anywhere along a signal line will cause that signal segment and all 
logically connected segments on the current page to be selected.

You can also use the Pin List command in the signal pop-up menu (by right-clicking 
on the signal) to view the list of pins attached to the signal and go to any of them. This 
command displays a list of all device pin connections comprising the selected signal. 
Only pins in the current circuit are listed; pin connections in other hierarchy levels are 
not shown. 
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Selecting any item in the pin list and clicking on the Go To button will cause the 
appropriate page to be opened (if necessary) and that pin to be displayed in the center 
of the circuit window. If the selected pin is invisible (e.g. a bus internal pin) the window 
will be centered on the parent bus pin.

For convenience in navigating a schematic, connections to pseudo-devices such as 
bus breakouts are also shown in this list. In this sense, the list is not a logical “netlist”, 
but rather a method for checking connectivity and navigating the diagram.

Each item in the pin list is formatted as follows:

• For normal devices:device-pin (page ref)

• For pseudo-devices:device type (page ref)

The elements of this format are as follows:

For more information on page references, see “Automatic Display of Page 
References” on page 107.

device If the device is named, this will be its name, otherwise it will be a 
“#” mark plus the type name.

pin If the pin has a pin number, this will be the pin number, otherwise 
a “#” and the pin name.

page ref This will be a reference to the page number and grid position, 
formatted as specified using the Design Preferences command.
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Setting Signal Color

To select an individual color for a single signal line, right-click on the line and select 
the Color command in the popup menu.  This setting will override the default signal 
color, which is determined by settings in the initialization file, described in “Color 
Settings” on page 200.  To return a signal to the default color, select the Color 
command again and click the Default button.

Selecting a Signal

A single signal is selected by clicking anywhere along the signal line. This selects only 
the part of the signal directly attached to the clicked line. Double-clicking the signal 
selects all parts of the signal on the given page including logical connections by name 
or bus.

Selecting a Pin

A pin is selected by clicking on the pin line close to the device. 

Note: Since an unconnected device pin is both a pin and a signal, you determine whether 
you get the pin or signal pop-up menu as follows:

• clicking on the pin in the last 1/4 of the pin length away from the device will display 
the signal menu.

• clicking on the pin close to the device symbol will display the pin menu.

Getting and Setting Signal Information

Selecting the Properties command with a signal selected causes the following box to 
be displayed:
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This box can also be displayed by holding the c key pressed while clicking and holding 
on a signal line. In the pop-up menu, select the Properties command.

Here are the options presented in this box:

Naming Signals

Names may contain any letters, numbers or special characters that you can type on 
the keyboard, but are restricted in length to at most 15 characters. The name 
associated with an object can be placed anywhere on the diagram and will be 
removed if the object is removed.

What Signal Names are Used For

The signal name is referenced by the following OptiSPICE Schematics functions:

• The signal name is used in netlists.

• The signal can be located by name using the Find tool.

Omit From ReportThis switch controls whether the selected signal is included in 
reporting output. 

Line Width The number typed into this box determines the displayed width of the 
signal. Any number > 1 displays the signal that number of times wider 
than the normal value. The maximum value is 255.

Pin List This button displays a list of the real device and pseudo-device pins 
attached to this signal. Double-clicking on any item in this list will 
display the selected pin. More information on this box is given in 
“Checking Signal Interconnection” on page 58.

Attributes This button displays the general attribute data entry box for the 
selected signal. More information on the functions available in this 
box are given in “Entering and Editing Attribute Data - Basic 
Procedure” on page 80.
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• Signals can be logically interconnected by name.

Invisible Signal Names

OptiSPICE Schematics allows you to assign and edit signal names in a circuit without 
making them visible on the diagram. This can be used to assign names that cannot 
be conveniently placed on the diagram, or that are needed for netlist generation 
purposes only. Signals with invisible names are not connected by name, except for 
invisible names created by a Signal Connector device, as described above.

Connecting Signals by Name

Signal names can be used to make logical connections between wires that are not 
visually connected on the schematic.   Like-named signal traces on a single page are 
logically connected for simulation and netlisting purposes. Whenever a signal name 
is added or changed, the circuit is checked for a change in connectivity. If the name 
is now the same as another signal on this page, the two signals are merged into one. 
If this signal segment was previously connected by name to others and the name is 
changed, then the logical connection is broken. Whenever a name change causes 
two signals to be connected, both parts will flash on the screen to confirm the 
connection.

Adding a Signal Name

Enter “Text” mode either by clicking on the Naming tool in the toolbar:

Note that once this command is selected, the cursor changes to a pencil icon.

Press and hold the mouse button with the tip of the pencil positioned anywhere along 
a signal line except within 5 screen dots of a device. As long as you hold the mouse 
button down an I-beam cursor will track the mouse movements. The signal name text 
will start at the position where you release the button. Type the desired name and 
press Enter or click the mouse button anywhere. 

Adding an Invisible Name

An invisible name for a signal can be created by either:

1) Clicking the right mouse button on the signal, then selecting the Name command 
from the pop-up menu.

OR

2) Selecting the desired signal, then selecting the Properties command in the 
Options menu, then clicking on the Attributes button in this box, then selecting the 
Name field in the attributes box.
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In either case, if the name is already visible on the diagram, changing it here will 
change all displayed occurrences of it.

Making an Invisible Name Visible

An invisible name can be made visible by simply clicking the Text cursor anywhere on 
the signal or device. When the mouse button is released, the name will be positioned 
at that point, as shown in the general naming instructions above. Alternatively, you 
can use the Name command in the signal pop-up menu to change the Visible status 
of the name.

Removing a Name

A signal name can be removed by using the Zap cursor. If the signal has been named 
in multiple locations then Zap removes the name only at the location zapped, but the 
signal still retains the logical name. Alternatively, you can hold the c key while clicking 
on the name text on the schematic and use one of these commands in the attribute 
pop-up menu:

• The Hide command can be used to hide the name without changing it.

• The Clear command can be used to remove the name completely.

Important: See “Adding an Invisible Name” on page 62 for an important note about 
invisible signal names and auto-naming.

Editing a Name

The name can be changed by simply clicking the Name cursor on the signal name 
and editing using the keyboard as desired. Alternatively, a name can be edited by 
using the Name command in the signal pop-up menu.

This command displays a name edit box for the selected signal. The following box is 
displayed offering you several options on how the name changed is to be applied:

Apply to All Connected Signals—This option allows you to choose whether the 
name change applies only to the selected signal segment (i.e. thereby breaking its 
connection with other like-named signals), or to all interconnected signal segments.

Visible—This option allows you to choose whether the name entered should be 
displayed on the schematic. If the name was already visible and you uncheck this box, 
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it will be removed from the schematic. In this case, the name will still be associated 
with the signal as an invisible attribute. If the name was not previously visible and you 
check this box, it will be displayed somewhere adjacent to one of the signal line 
segments.

Moving a Signal Name

A signal name can be moved by selecting the Point (normal) cursor, clicking and 
holding the mouse button on the name, and dragging it to the desired new position. 
Holding the c key depressed while moving a name (or any attribute value) disables 
the grid snap, allowing you to micro-position the name for alignment with other 
graphic items on the schematic.

Note: The “Name” is actually an attribute field, so all attribute editing techniques can be 
used on it. In particular, you can hold the c key while clicking on the name and the attribute 
pop-up menu will appear, giving you a variety of editing commands, described in “Other 
Ways of Viewing and Editing Attributes” on page 87.

Multiple Naming of Signals

A signal name can appear in up to 100 positions along the length of a signal line. To 
add a new position, simply use the normal naming procedure given in the section on 
signal naming i.e.:

• Select Name mode

• Click and drag anywhere along the signal line

• With the mouse button pressed, move to the desired position for the name

• Release the mouse button

A new copy of the signal’s name will appear at this point followed by a flashing cursor. 
To accept the name, simply click the mouse button once or press the Enter key. If you 
edit any occurrence of a name along a signal segment, all other occurrences will be 
updated to reflect the new name.

Any occurrence of a signal name can be removed using the Zap cursor. If you remove 
the last visible name from a signal segment then the logical connectivity to other like-
named signals is removed.

Using the Auto-Naming Features

Two features are available to simplify the naming of groups of related signals, devices 
and pins. These features are activated by holding down the c, a or Shift keys while 
selecting the signal to be named with the Text cursor.

• Auto-alignment - If the a key is held down while the signal is selected, the text 
insertion point will be positioned horizontally aligned with the last signal name that 
was entered. The vertical position is determined by the vertical position of the line 
that was clicked on. This feature works only with signal names, not with devices 
or pin numbers.

• Auto name generation - If the c key is held down while a signal, device or pin is 
selected, a new name is generated automatically for this item. The new name will 
be the same as the last one entered, except that the numeric part of the name will 
have been incremented. If the previously-entered name did not have a numeric 
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part, then a “1” digit will be appended to it. If the Shift key is pressed at the same 
time, the number will be decremented instead of incremented.

Sequential Naming 

The above two features can be used in combination to perform easy naming of 
sequential signals. The normal symbol standard in OptiSPICE Schematics is to 
position the highest numbers at the top, so you can either:

• number the bottom-most line in the group (e.g. D0) using the normal naming 
technique, described above, then hold c and a while clicking on successive 
higher-numbered lines.

• number the topmost line in the group (e.g. D7) using the normal naming 
technique, described above, then hold c, a and M while clicking on successive 
lower-numbered lines.

Note that when you select each successive line, the new name appears, then it is 
necessary to click again or press Enter to make the name permanent.

Pin Numbering and Information Entry

Pins are circuit objects that provide a link between devices and signals. A pin cannot 
exist independently of a device, but it can have a variety of information associated 
with it that can be set separately for each pin. This information includes the visible pin 
number on the schematic and any number of attribute fields.

Getting and Setting Pin Information

You can display a general pin information box by either selecting the pin and choosing 
the Properties command in the Options menu, or, right-clicking on the pin, then 
selecting the Properties command in the pin pop-up menu.

See “Selecting a Pin” on page 60 for the technique used to select a pin.

In either case, this box will be displayed:
65



 BASIC SCHEMATIC EDITING
The following information and options are available:

Pin Numbering

Pin numbers may contain 0 to 8 characters (not necessarily just numeric) and are 
always positioned adjacent to the associated pin. 

Pin Number This is the physical pin number corresponding to this device pin. 
This can be empty if desired. See “Uses of Pin Numbers” on 
page 67 for more information.

Visible This check box determines whether the pin number is displayed 
on the schematic. 

Pin Type This information item gives the function and visible status of the 
pin.

Pin Ordinal 
Number

This number is the pins ordinal position in the device's pin list, i.e. 
as viewed in the device symbol editor. This order number is used 
to determine the order of connected signals when creating 
OptiSPICE netlist.

Associated 
Internal Signal

For subcircuit devices, this item shows the name of the signal 
attached to the associated port connector in the internal circuit. 
For other devices, this will be “None”. 

Attributes This button displays the general attribute data entry box for the 
selected pin. See “Entering and Editing Attribute Data - Basic 
Procedure” on page 80.

Bus Pin Options This option will be enabled if the selected pin is a bus pin. This 
will display the Bus Pin Options box which provides a number of 
information and editing operations for working with bus pins. See 
“Using Bus Pins” on page 103 for more information.

Prev Pin/ Next 
Pin

These buttons allow you to move to the next or previous pin (by 
ordinal number) on the same device, without having to return to 
the schematic and select the pin.
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Uses of Pin Numbers

Pin numbers are used only for labeling purposes and have no particular connectivity 
significance to OptiSPICE Schematics. Pin numbers are not automatically checked 
for duplicates or other invalid usage. 

Default Pin Numbers

A device type may have default pin numbers associated with it which will appear when 
the device is first created. These pin numbers are not permanent and can be edited 
or removed by the techniques discussed in this section. Devices in a library can have 
default pin numbers assigned to them using the device symbol editor tool.

See “Setting the Pin Number” on page 172 for information on setting default pin 
numbers while editing a symbol.

Editing Pin Numbers On the Schematic

If the mouse button is pressed with the tip of the pencil positioned on a signal line 
within 5 screen dots of a device, a blinking insertion bar will appear immediately where 
the signal joins the device. You cannot set the text position for pin numbers. Type the 
desired 1 to 8 character number and press Enter, or click the mouse button anywhere, 
to make the number permanent. See the sequential numbering option discussed 
below under “Auto-naming Features”. Pin numbers cannot be repositioned.

Quickly Applying Sequential Pin Numbers

If the c key is held down while a pin is clicked on with the pencil cursor, a new pin 
number is generated automatically for that pin. The new number will be the same as 
the last one entered, except that the numeric part of the string will have been 
incremented. If the previously-entered item did not have a numeric part, then a “1” 
digit will be appended to it. If the Shift key is pressed at the same time, the number 
will be decremented instead of incremented.

Editing Pin Numbers Using the Properties Command

To edit pin numbers using the Properties dialog box:

• Click on the device in question to select it.

• Select the Properties command in the Options menu.

• Click on the Pin Properties button. This will display the pin information for the first 
pin.

• Edit the pin number as desired.

• Click the Next Pin button to see the next pin in the list.

Editing Pin Numbers Using the Browser

To edit pin numbers using the Browser tool:

• Select the Browser command in the View menu.

• Select the Pins object type.

• Select the Number item in the Pseudo pop-up menu.

Pin numbers can now be edited in the “Number” column of the spreadsheet.
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Setting Pin Number Text Characteristics

The text font used for displaying pin numbers is setting by selecting the Design 
Preferences command in the Drawing menu, then selecting the Text tab, then clicking 
the Pin Text Style... button. This displays the text specification box, allowing you to 
select a font family, face and point size. Any changes made to this text style will be 
applied to all pin numbers displayed throughout the design. There is no ability to 
select different fonts for individual devices or pins. The text changes are applied when 
the OK button in the Design Preferences box is clicked.
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Allowing Rotated Pin Numbers

You can optionally show pin numbers on all north- and south-facing pins rotated 90° 
to run along the length of the pin. This is set by selecting the Design Preferences 
command in the Drawing menu, selecting the Text tab, then checking the Rotate Pin 
Numbers item. If this item is unchecked, all pin numbers will be displayed horizontally 
adjacent to the pin.

Using Text and Graphic Objects

Text and graphic objects are used only to enhance the graphical appearance of a 
schematic diagram. They have no logical significance in the design.

Text objects are not associated with any particular device or signal on the screen and 
should not be used to set a name or attributes for devices or signals. The text in these 
boxes is not accessible in net or component lists. Use the naming and attribute 
features to attach text to devices and signals.

Creating a Text Block

If you click the  cursor on the diagram a blinking cursor will appear at that point and 
you will be able to type any desired text on the diagram. The Return key can be used 
to enter multiple lines in a single text block. Text entry is terminated by the Enter key.
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Editing a Text Block

If you double-click on or click the text cursor inside an existing text item the insertion 
point will be positioned at the click point. You can then use normal Windows text 
editing techniques to modify the text. Note that text on the clipboard can be pasted 
into an existing text box using the c-V key equivalent for the Paste function. The Paste 
menu command will cause the current text entry to be terminated and a new text box 
to be created. Similarly, the c key equivalents for Cut (X) and Copy (C) can also be 
used while editing a text box.

Text boxes can be Zapped, Duplicated, Cut, Copied, Pasted and dragged just like any 
other item on the screen. See the descriptions of these commands for more 
information.

Background and Border Objects

Either text or picture blocks can be set to be “border” or “background” 
objects. These two options will normally be used together, but can be 
enabled separately if desired. These two options are enabled by 
selecting the object in question and using the Properties command.

Border Objects

If a text or picture is marked as a “border” item, then it is considered to 
be part of the sheet border information for the page it is on. This has the 
following effects:

• if a new page is added to the circuit using the Pages command, this 
item will automatically be copied to the same position on the new 
page.

• if the page containing this item is used as the source for an Import 
Sheet Info operation, this item will be copied to the destination.

• if a Center in Page command is used, this object will not be 
repositioned since it is assumed to be part of the border.

Background Objects

Text or picture items marked as “background” objects cannot be 
selected, modified or deleted using normal circuit editing techniques. 
This is used to prevent custom sheet backgrounds or border graphics 
from interfering with circuit editing operations. This is normally used in 
combination with the “border” status discussed above.

To select a background object, hold the SHIFT and CTRL keys pressed 
while clicking on it, or use the Background Layer Only command in the 
View menu. The Properties command can then be used to disable the 
background status.
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Text Style and Display Options

To set text display options and text style, select the text block by clicking on it with the 
Point cursor, then select the Properties command in the Options menu. This will 
display the following box:

This table summarizes the options available.

Text Style This button displays the text style options box which 
sets the text font, colour and frame options.

Anchor This button displays a box allowing you to set the text 
anchor point.  This is the point that remains fixed 
when the text box is resized due to content changes.  
This is relevant if the text is to be aligned with some 
other objects on the drawing.

Background/Border This tab contains options for making the selected text 
block a background or border. Background items 
cannot be affected by normal editing operations. In 
order to select it for editing, hold the M and  c keys 
pressed while clicking on it or select the Background 
Layer Only command in the View menu.

 Border objects will be treated as part of the sheet 
border.  That is, it will be updated by the Import Sheet 
Info command, copied to new pages as they are 
created, and unaffected by the Center in Page 
command. See “Setting Sheet Sizes and Borders” on 
page 184 for more information.
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See more information on using text notations in title blocks and sheet borders in 
“Setting Sheet Sizes and Borders” on page 184.

Using Text Variables

The text facility allows special entries called variables to be placed in text boxes. 
When the text is displayed or printed, the appropriate system quantity or attribute field 
value is substituted for the variable name. Any variable name that is not recognized 
will be displayed verbatim. This facility is intended to assist in creating title blocks and 
similar additions to the schematic with information such as the date, page number and 
title, revision level, engineer's name, etc. Using variables will allow this information to 
be entered in one place so that changes are reflected automatically on all schematic 
pages.

System Variables

System variables start with a “$” and are enumerated here:

Position These options allow you to fix the position of the item 
relative to one edge of the border.  This will cause the 
item to be repositioned automatically if the border size 
is modified.

$DATENOW This will be replaced by the system date written 
mm/dd/yy. This is the current date as maintained by 
the system clock.

$TIMENOW This will be replaced by the system time written 
hh:mm. This is the current time as maintained by the 
system clock.

$DATECREATED This will be replaced by the date the file was created, 
as maintained by the file system.

$TIMECREATED This will be replaced by the time the file was created, 
as maintained by the file system.

$DATEMODIFIED This will be replaced by the date the file was last 
modified, as maintained by the file system.

$TIMEMODIFIED This will be replaced by the time the file was last 
modified, as maintained by the file system.

$PAGENUM This will be replaced by the number of the page 
(within the current circuit level) the text is on.

$NUMPAGES This will be replaced by the total number of pages in 
the circuit level.

$PAGETITLE This will be replaced by the title of the page the text is 
on, as entered using the Pages command.

$PRINTPAGENUM This will be replaced by the page number in the 
printed sequence within the current Print command. 
This is used to number pages within a hierarchical 
design. NOTE: This is only valid for printed output. 
When it is drawn on the screen, it will show the same 
value as $PAGENUM.
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Note: The format used to display date and time values is determined by the Regional 
Settings control panel in Windows.

Attribute Variables

Attribute variables start with a “&” mark and are used to refer to fields stored in the 
attributes for the design. These can be used to place information at multiple points on 
a diagram which will be updated automatically when the design attributes are 
changed. For example, if the design attribute field Revision was defined for the design 
with the following contents:

2.1A Mar 18, 2008

then the variable &Revision would appear as “2.1A Mar 18, 2008" on the diagram.

See “Attributes” on page 79.

Editing Text with Variables

Text items on the schematic will normally be displayed with variables replaced by their 
values. When a text item is selected or clicked on with the Name cursor it is 
redisplayed in its raw format with the variable names shown without interpretation. 
This allows the items to be edited with the text in its actual stored position.

Text Frame Size with Variables

The framing rectangle for a text item is calculated after the variable substitution is 
done. This may cause the item to be highlighted or deleted incorrectly if the variable 
values are shorter than the names. These errors are not serious or permanent and 
will disappear when the screen is updated. The text box can be expanded as 
necessary by adding blanks at the end of any one line in the item.

Selecting a Graphic or Text Object

A single, non-background graphical or text item is selected by clicking the mouse 
button with the pointer positioned anywhere inside the item.

$PRINTNUMPAGES This will be replaced by the number of pages that will 
be printed by the current Print command. This is used 
to number pages within a hierarchical design. NOTE: 
This is only valid for printed output. When it is drawn 
on the screen, it will show the same value as 
$NUMPAGES.

$FILENAME This will be replaced by the name of the design file, 
not including its directory path.

$FILEPATH This will be replaced by the name of the design file, 
including its directory path.  If the file hasn’t been 
saved, this will be empty.

$CIRCUITNAME This will be replaced by the name of the circuit being 
printed. In the topmost circuit of a hierarchical design 
, this is the same as $FILENAME. In a subcircuit, this 
will be the hierarchical name of the circuit.
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Selecting a Background Object

To select a graphical or text item marked as “background” while editing a schematic, 
you must hold the M and  c keys pressed while clicking on it. Alternatively, you can 
select the Background Layer Only command in the View menu, which hides all normal 
schematic objects and enables all background items for editing.

Drawing Graphics

Graphic items such as lines, boxes, ovals, etc. can be drawn directly on the schematic 
diagram using the drawing tools.

Note: Items drawn with these tools have no circuit significance and will not be included in 
any netlists.

Setting Graphic Object Properties

All graphic items have various visible properties that can be set, such as line width, 
colour, text font, etc. To set the properties of any object, either:

• Right-click on the object and select the Properties command in the pop-up menu, 
or,

• Select the object and select the Properties command in the Options menu.

You can select multiple objects at the same time for this operation. Any changes will 
be applied to all selected objects.

The exact contents of the box that is displayed will depend on the type of object(s) 
selected.  A typical box such as the following will be presented for a rectangle:
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This table summarizes the features available in this box:

Line Width Allows you to specify the width of the line 
portion of the object.

Line Style Allows you to specify dotted or dashed 
lines. Note that there are limitations in line 
width when these options are used.

Line Color Specify the color of the line portion of all 
selected objects.

Fill Color Specify the fill color of any fillable selected 
objects.
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Grouping Graphic Objects

Any collection of graphic objects, text and pictures can be made into a "group", which 
allows the items to be moved and edited as a single item.

Creating a Group  

Select any collection of items by dragging the mouse across them and/or by holding 
the SHIFT key and clicking on the individual items. Now right-click on any item and 
select the Group command. Clicking on any item in the group will now select the entire 
collection as if it was one item.

Setting Properties on Grouped Items  

To set properties on a group, right-click on any item in the group and select the 
Properties command. Any changes made will be applied to all items in the group.

Ungrouping Grouped Items  

To revert a group back to a collection of separate items, right-click on any item in the 
group and select the Ungroup command.

Background/Border This tab contains options for making the 
selected text block a background or 
border. Background items cannot be 
affected by normal editing operations. In 
order to select it for editing, hold the M and  
c keys pressed while clicking on it or select 
the Background Layer Only command in 
the View menu.

 Border objects will be treated as part of 
the sheet border.  That is, it will be updated 
by the Import Sheet Info command, copied 
to new pages as they are created, and 
unaffected by the Center in Page 
command. See “Setting Sheet Sizes and 
Borders” on page 184 for more 
information. 

Position These options allow you to specify 
whether the graphic object should "stick" 
to one side of the border, i.e. should it be 
moved automatically to retain its position 
relative to the border if the sheet is resized. 
See “Setting Sheet Sizes and Borders” on 
page 184 for more information. 
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Rotating Graphical Objects

To rotate any graphic objects, right-click on the object (or on any one of a collection of 
objects) and select one of the four rotation commands: Flip Vertical, Flip Horizontal, 
Rotate Left or Rotate Right.

Setting Front-to-Back Ordering

Front-to-back ordering of graphic objects determines which items are drawn first and 
therefore appear "behind" other objects. To make an object appear behind all others, 
select the Send to Back command. To make an object appear in front of all others, 
select the Bring to Front command.

Aligning Graphical Objects

To align multiple graphical objects, simply select all the objects in question, right-click 
on any one of them and select one of the command in the Align submenu.

See “Setting Sheet Sizes and Borders” on page 184 for more information on creating 
title blocks and sheet borders.
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Attributes
This chapter describes the methods in OptiSPICE Schematics for entering, editing, 
displaying and using attributes.  Attributes are arbitrary blocks of text that can be 
associated with any device, signal or pin in a design, or with the design itself.  
Attributes have a wide variety of uses, including:

• Displaying device name, part type, value, etc. on the schematic.

• Storing manufacturing information such as catalog numbers, manufacturer's 
name, price, part description, etc.

• Storing data for use by external systems such as simulators, analysis tools, etc.

In addition, many OptiSPICE Schematics features use attributes as temporary or 
permanent storage locations for data relating to a device or signal.  For example, each 
device in a design has the name and location of the library it was read from stored in 
an attribute field.  This allows the library to be located easily for later updating.

Attribute Organization

Attribute Definition Table

Attributes are divided into named fields.  The list of allowable field names is stored 
with each design in the attribute definition table.  For each field, the table contains:

• the field name (up to 32 characters)

• what types of objects that field can be used in (devices, signals, pins or design)

• data entry constraints (maximum length, carriage returns, etc.)

• default settings, such as whether the field should be made visible on the diagram.

Once a field is defined in the table, its name is never typed again.  When attribute data 
is entered for a selected object, the field name is picked from a list of allowable fields.  
This eliminates any chance of accidentally misspelling the field name in one object.

Predefined Fields

When a new design is created, a default attribute definition table is created with the 
standard, predefined fields.  Predefined fields cannot be deleted from the design 
since many of them have specific internal functions in OptiSPICE Schematics.

User-defined Fields

You can add more fields to a design at any time using the Define Attribute Fields 
command in the Options menu.

Primary vs. Secondary Fields

OptiSPICE Schematics has 50 or more predefined fields that are used for various 
program features and more can be added by the user.  Most of these fields never 
need to be viewed or set directly by the user.  To reduce clutter, attribute fields can be 
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defined as being primary or secondary.  When entering attribute data, you can choose 
whether you wish to see “primary fields only” or “all fields”.

The primary/secondary setting is for viewing and editing convenience only and has no 
effect on the meaning or internal usage of the field.  This setting for individual fields 
can be changed at any time using the Define Attribute Fields command in the Options 
menu.

Definition vs. Instance Fields

In a hierarchical design, a single device, pin or signal in a sub-circuit may actually 
represent several physical objects.  This happens if the parent device containing the 
sub-circuit is used more than once in the design.

For this reason a distinction is made between fields that are associated with the 
definition of a sub-circuit and fields associated with the instance.

• Fields associated with the definition will be the same in all instances of the sub-
circuit.  Changing the value in one instance will affect all instances equally.

• Fields associated with the instance can take on a different value in each physical 
instance of the device, pin or signal.  Changing the value in one instance has no 
effect on the others.

When defining a new attribute field for use in a hierarchical design, careful 
consideration should be given to whether to consider it a definition or instance field.  
If the value of the field has a significant impact on the logical functioning of the sub-
circuit, then the field should probably be a definition field.  Thus, if two sub-circuits 
require different values in this field, then separate definition circuits will have to be 
created.  This makes it clearer to other users of the design that a distinction exists.

See “Hierarchical Design” on page 115 for more information. 

Attribute Limitations

Attribute fields have the following specific limitations:

• Maximum length of field name: 32 characters

• Maximum length of field data item: 2,000,000,000 characters.  Note: In principle, 
binary data could be pasted into an attribute field although this is not 
recommended since OptiSPICE Schematics provides no mechanism for 
displaying or editing this data.

• Maximum number of user-defined fields: 900

• Maximum number of displayed positions of a single attribute item: 100

Like all other circuit data, the amount of attribute data that can be associated with a 
design is limited by available memory.

Entering and Editing Attribute Data - Basic Procedure

To edit the attributes associated with a device, pin or signal, you can either:
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• Select the object of interest on the schematic (you can only enter data for one 
object at a time using this method), then select the Properties command in the 
Options menu.  In the info box that is displayed, click on the Attributes button.

• Right-click on the object and select the Attributes command in the menu.

To edit design attributes, select the Set Design Attributes command in the Options 
menu.

Any of these methods will display the general attribute editing box which is used to 
enter or edit attribute data on a single object:

By default the field list at the left side of this box shows only the primary fields available 
for the selected kind of object.  You can click on the All fields button to view all 
available fields.  Custom fields can be added to this list using the procedure outlined 
in “Defining a New Attribute Field” on page 89.

Entering Data Values

To edit the contents of a field, simply select the field name in the list.  The current 
contents of the field will be displayed in the editable text box.  Edit this value using the 
usual Macintosh text editing techniques.  Press the Done button or select another field 
when done.  When you select another field, data entered for the previous field is 
saved.  If the data you typed exceeded the maximum length for the field, or if it 
contained invalid characters for the field, then you will be asked to correct the data.

You can view or edit as many fields as desired while in this box.  No changes are 
made to the actual design data until you click the Done button.  Clicking Cancel will 
abandon all changes made while in this box.
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Restoring the Default Value

Clicking the Use Default Value button sets the value for the selected field to the default 
value stored with the symbol.  This is valid only for device and pin attributes for which 
a default value was specified.  If this button is inactive (grayed out) then the value is 
already the default value, or no default value is present.  Only devices and pins can 
have default values.

See “Setting Default Values” on page 89 for more information on entering default 
attribute values while editing a symbol.

Using the Value List Pop-up Menu

If the selected field has an associated value list field, then a pop-up value menu will 
appear just below the “Use Default Value” button.  An item selected out of this menu 
will cause the value text box to be updated accordingly.  This does not prevent the text 
data from being edited directly.  See more information on value list fields in “Using 
Value List Fields” on page 87.

Displaying an Attribute on the Schematic

To display device, signal or pin attribute text on the schematic:

• Edit the attribute value as desired.

• Turn on the Visible switch.

When you click Done, the attribute text will now be displayed in a default position near 
the device, pin or signal.  It can be dragged to the desired location using the pointer 
cursor.

Design attributes can be displayed on the schematic using text variables.  See “Using 
Text Variables” on page 72.

For information on setting the default position for an attribute on a symbol, see “Using 
Default Position Fields” on page 88.

Entering Design Attributes

To view or set attributes associated with the design itself, select the Design Attributes 
command in the Options menu.  This command displays the standard attribute data 
entry box allowing you to enter attribute data for the design itself. 

Note: The Visible option is not available for design attributes, since there is no single object 
on the schematic to associate them with.  Design attributes can be made visible by using 
text variables, described in  “Using Text Variables” on page 72.

Entering Pin Attributes

To enter or edit attributes for a pin, you can use any of the following methods to display 
the attribute editing box:

• Select the pin of interest on the schematic (make sure you are selecting the pin 
and not the signal, see “Selecting a Pin” on page 60), then select the Properties 
command in the Options menu.  In the pin info box that is displayed, click on the 
Attributes button.
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• Right-click on the pin and select the Attributes command in the menu.

• Select the device that the pin is attached to, select the Properties command to 
display the device properties box, then click the Pin Properties button in this box, 
then the Attributes button in the pin info box.

The attribute editing box for pins is identical to the one for devices, signals and the 
design, except that Next and Previous buttons appear at the bottom.  These can be 
used to view and edit other pins on the same device without having to return to the 
schematic and select them individually.

Controlling Attribute Display Characteristics

Rotating Attribute Text

To rotate an attribute text item that is already displayed on the schematic, follow these 
steps:

1 Right-click on the text item.  This will display the attribute pop-up menu.

2 Select the Rotate Right or Rotate Left command.

Hiding a Visible Attribute Value

If you wish to hide a device, pin or signal attribute value that is displayed on the 
schematic (that is, remove the displayed text from the schematic, but keep the value 
associated with the object), you can use any of these methods:

• Right-click on the text and select the Hide command.

• Right-click on the text and select the Edit command.  In the text edit box that 
appears, turn off the Visible switch.

• Display the general attribute editing box for the object, using the methods 
described earlier in this chapter.  Select the field in question and turn off the 
Visible switch.

• Click on the  tool in the tool palette, or select the Zap command in the Edit 
menu and then click on the attribute text you wish to hide.

Any of these methods removes the displayed text from the schematic without 
modifying the value that is stored with the object.

Note: If the value you are hiding is a signal name, this operation may have side effects on 
the connectivity represented by the signal.  See “Signal Connectivity Rules” on page 113 
for more information.

Design attributes can only be displayed on the schematic using text variables.  These are 
described in  “Using Text Variables” on page 72.

Clearing a Visible Attribute Value

If you wish to remove the displayed attribute text associated with a device, pin or 
signal and remove its value completely, you can:

• Right-click on the text and select the Clear command.
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• Right-click on the text and select the Edit command.  In the text edit box that 
appears, remove the text value.

• Display the general attribute editing box for the object, using the methods 
described earlier in this chapter.  Select the field in question and remove the text 
value.

Note: The first method above (the Clear command) actually performs a slightly different 
function to the other methods.  It removes the visible text on the schematic and sets the 
attribute to its default value.  For devices and pins, this means any value that was specified 
with the device symbol when it was created.

Displaying an Invisible Attribute Value

To display an attribute value that is already associated with a device, pin or signal, 
display the general attribute editing box using the methods described in “Entering and 
Editing Attribute Data - Basic Procedure” on page 80, then turn on the Visible switch.  
The value will be displayed in a default location near the object and can then be 
relocated as desired on the schematic.

Design attributes can only be displayed on the schematic using text variables.  These 
are described in  “Using Text Variables” on page 72.

Note: The Name attribute is a special case in that it can be displayed by simply clicking 
the text cursor on the object in question, in addition to the method described here.

Setting Attribute Text Style

The text style used to display attribute values on the diagram is determined by two 
settings:

• The text style set using the Design Preferences command is the default display 
style for all attribute fields.

• A text style can be set for a specific field using the Define Attribute Fields 
command. If set, this style overrides the default style for the design.

There is no way to set text style for an individual attribute item on the diagram.

Warning: Changing the attribute text style affects all visible attributes throughout the 
design.  This may alter text alignment and position to accommodate a different text size.

The attribute text style setting affects the following types of items:

• Device and signal names.

• Bus breakout and bus pin labels.

• All other attributes displayed on the diagram.

but does not affect:

• Border text (see “Setting Border Text Style” on page 190).

• Pin numbers (see “Setting Pin Number Text Characteristics” on page 68).

The text changes are applied when the OK button in the Design Preferences box is 
clicked.  For larger designs, there may be a substantial delay while new positions of 
all displayed attribute items are calculated.
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Setting Global Text Style

To set the global text style:

• Choose the Design Preferences command in the Drawing menu.

• Select the Text tab and click on the “Set Font...” button in the Attribute Text Font 
area.  This will display the following box:

This box allows you to select the text font, size and style used for all attributes 
displayed in the design.

• Select the desired font, size and style, then click OK.

• Click OK on the Design Preferences box.

Depending on the size of the design, there may be some delay at this point.  The 
program must check all visible attribute items to see if there position and framing is 
affected by the text change.

Setting Text Style for a Single Field

To set the text style for a chosen field:

• Select the Define Attribute Fields command in the Options menu.

• Click on the desired field in the field list.

• Click on the Text Style button.

• Choose the desired settings and click OK.

• Click OK in the Define Attribute Fields box.

Setting Attribute Justification

Attribute justification determines how text is aligned relative to the device it is 
associated with.  Generally, the program chooses a justification that is appropriate for 
the initial placement of the text and there will be no need to change it.  However, if text 
85



 ATTRIBUTES
is being modified frequently and does not reposition itself as desired, the justification 
can be modified individually for text items.

To set the justification, right-click on the text item in question and select the 
Justification command.  This command allows you to change the vertical and 
horizontal justification used in the positioning the attribute text on the diagram.  When 
this command is selected, the following box will be displayed:

The selected point on the text is considered to be the reference point for the given 
attribute block.  This point will be kept fixed if any field value or text style changes 
cause the box to be resized.

Note:  The Justification command affects only the position of the text relative to the 
associated object.  It does not affect the alignment of text in multi-line text items on the 
schematic.  OptiSPICE Schematics does not provide any method of choosing center or 
right justification of multi-line text items.

Displaying an Attribute Value in Multiple Locations

You can display a single attribute value in multiple locations on a schematic.  This is 
intended for use particularly with signals, which can be spread over large areas of a 
page or multiple pages.  If a value is displayed more than once, editing any one of the 
displayed values will affect all appearances of it.

To create multiple displayed attribute items, right-click on the text and select the 
Duplicate command.This command creates another visible occurrence of the same 
attribute field.  This text can then be dragged or rotated to any desired position on the 
schematic.

Showing the Field Name with an Attribute Value

The Show Field Name command allows you to display the field name with the value 
on the schematic.  When this item is checked, the display will be in the form 
“fieldName=value”.  Selecting this command again will cause the display to revert to 
the normal value display.  This command applies only to the selected field on the 
selected object.
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Tip: You can elect globally to show the field name for a certain field whenever it is used.  
See “Defining a New Attribute Field” on page 89 for more information.

Other Ways of Viewing and Editing Attributes

Editing Attributes on the Schematic

Any attribute value associated with a device, pin or signal that is displayed on the 
schematic can be edited right in place using the text tool.  To use the text tool, click 
on the  item in the tool palette, or select the Text item in the Edit menu.  When you 
click the pencil cursor on any displayed attribute value, a flashing cursor will appear 
in the text to indicate that it is editable.

Note:  OptiSPICE Schematics does not support in-place editing of attributes that appear 
rotated on the schematic.  If you click in such a value, a simple value editing box will be 
displayed instead of the edit cursor on the schematic.

An alternative method of editing a single displayed attribute field is to right-click on the 
text and select the Edit command.  This command opens a text box allowing you to 
edit the contents of the selected field.  All locations where this field is displayed on the 
schematic will be updated when the OK button is clicked.

Using Value List Sub-menus

A device or pin pop-up menu may contain one or more sub-menus as its last items.  
These sub-menus allow you to select from a list of possible values for an attribute 
field.  Selecting an item in one of these lists changes the value in the associated 
attribute field.

See “Using Value List Fields” on page 87 for information on creating your own value 
list fields.

Using Value List Fields

A value list field allows you to specify a list of possible values that can be used in a 
selected field.  This list of values if then displayed to the user at various locations, 
allowing easy selection of one of the available items.

A value list field has the same name as the associated field but with “.List” appended.  
When a field named “xxx.List” is seen by the program, it takes these steps:

• When the attribute edit box is displayed for a given object and the field “xxx” is 
selected, a pop-up menu is displayed containing all the possible values for the 
field.  The user may then select the appropriate value from the menu.

• When a pop-up menu is displayed by right-clicking on an object, a sub-menu with 
the field name “xxx” as its title will appear.  The list of possible field values will be 
displayed in the sub-menu.  The user can select one of these items to directly 
change the value of field “xxx”.

Value List Data Format

The value list field must contain a sequence of textual values following these rules:
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• Items must be separated by commas.  A comma will always be taken as a 
separator and therefore cannot be part of the value.

• The value string can contain any characters other than commas, but leading and 
trailing blanks will be removed.

• The length of a value string is limited to 16 characters.

• The maximum number of values is limited to 256.

Normally, a default value for the “xxx.List” field should be defined with the symbol in 
the library using the device symbol editor tool.  In this way, the value list will always 
be available whenever this device type is selected from the library.  If the field is 
defined in only one device on the diagram, the value list will only be available for that 
device.

Using Default Position Fields

For device or pin attribute fields that are to be displayed on the schematic, an 
associated field called a “default position field” can be created.  For example, this 
mechanism is used to provide default positions for the “Name” and “Part” fields used 
in all standard OptiSPICE Schematics libraries.  These standard fields can be used 
as an example.

A default position field has the same name as the associated field but with “.Pt” (for 
Point) appended.  When a field named “xxx.Pt” is seen by the program, it uses the 
values in this field to generate a default position for the “xxx” field.

Default Position Data Format

The default position field must contain a sequence of textual values following these 
rules:

• Two items, an X and a Y position, must be specified, separated by a comma.  
Leading an trailing non-numeric characters are ignored.

• The X and Y values are each decimal numbers representing an offset from the 
top-left corner of the device measured in 1/1000".  Negative values are allowed 
(negative is up and left).

• The X coordinate can be optionally followed by an upper case letter indicating 
horizontal justification, as follows:  “L” for left, “M” for middle, “R” for right.  I.e. the 
given number specifies the offset to the left, middle or right position of the 
displayed text.  If no letter appears, middle is assumed, i.e. the text will be 
centered at the given position.

• The X coordinate can be optionally followed by a lower case letter indicating 
which point on the symbol’s bounding box to use as the reference point, as 
follows:  “l” for the left edge, “m” for the midpoint, “r” for the right edge.  I.e. the 
given number specifies the offset from the left, middle or right position of the 
symbol.  If no letter appears, left is assumed.

• The Y coordinate can be optionally followed by an upper case letter indicating 
vertical justification, as follows:  “T” for top, “M” for middle, “B” for bottom.  I.e. the 
given number specifies the offset to the top, middle or bottom position of the 
displayed text.  If no letter appears, middle is assumed, i.e. the text will be 
centered at the given position.
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• The Y coordinate can be optionally followed by a lower case letter indicating 
where on the symbol the position is to be measured from, as follows:  “t” for top, 
“m” for middle, “b” for bottom.  I.e. the given number specifies the offset from the 
top, middle or bottom of the symbol’s bounding box.  If no letter appears, top is 
assumed.

Some examples of value points are:

Normally, a default value for the “xxx.Pt” field should be defined with the symbol in the 
library using the device symbol editor.  In this way, the value will be available for 
setting the default position of the associated field when the device is placed on the 
schematic.

Setting Default Values

A device symbol can have associated with it predefined default values for any number 
of fields.  Values can be specified for the device itself, and independently for each pin 
on the device.

When the standard attribute data box is displayed for a device, you will see a button 
labeled “Use Default Value”.  If this button is grayed out (disabled), then there is no 
default value or the value shown is already the default.

Defining a New Attribute Field

All changes in field definitions are done using the Define Attribute Fields command in 
the Options menu.  Selecting this command displays the following dialog box:

0R,0T The value will extend right and down from the top-
left corner of the device.

0Mm,0Bt The value will be centered above the symbol with 
the bottom of the text at the top of the symbol.

150,-75 The value will be centered at a position above and 
to the right of the top-left corner.

(400L,100) The value will extend left from a point to the right 
of the top-left corner of the device.  (Leading and 
trailing characters are ignored.)
89



 ATTRIBUTES
To create a new field:

• Select the •New Field• item in the list, if it is not already.

• Type the name of the field in the Field Name box.

• Select one or more of the boxes under “Allowed in object types”.

• Optionally enter a maximum length.

• Optionally enable any of the other field options.

• Click OK.  The new field will now appear in the attribute data entry box for the 
selected object types.

Setting Attribute Field Options

When a new field is created using the Define Attribute Fields command a number of 
options are available which determine how that field will behave in your design.  
These options are described in the following sections.

Note: Changing any of the following options in a field that has already been used in the 
design has no effect on items already displayed on the schematic.

Tip: To make a temporary change (e.g. to display a field that is not normally displayed) you 
can use the Duplicate button in the Define Attribute Fields box to create a new field 
containing the same data but with new display options.  This field can be deleted again 
when no longer needed.

Note the following characteristics of these settings:

• Changing the values of any of the option switches for an existing field do not affect 
any values already in the design.  Only new data will be affected.  See “Using 
Duplicate, Merge & Delete for Global Editing” on page 93 for tips on using the 
Duplicate function to update the way existing data is displayed.
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• The name and option settings for most predefined fields are fixed and will be 
disabled in this box.

• Regardless of changes made in this box, no design data is updated until you click 
the OK button.

Field Name

The Field Name box allows you to enter the name of a new field or rename an existing 
user-defined one.  If you rename a field so that it has the same name as another 
existing field, this becomes a Merge operation described in “Merging Two Existing 
Attribute Fields” on page 94.  You will be prompted to confirm a merge before 
proceeding.

Group with Name

When this switch is checked, any value entered for this field will be displayed beneath 
the Name field by default.  When the Name is moved, this field will also be moved.

This option can be used for fields that are typically shown with the name on a 
schematic. 

Show Field Name

When this switch is checked, the field name will be shown with the value on the 
schematic.

The Show Field Name option can also be controlled for each individual item on the 
schematic using the Show Field Name command in the attribute pop-up menu.

Allow Carriage Returns

If this switch is checked, then the Return key may be used to enter Carriage Return 
characters into this field.

Rotate Text With Object

If this box is checked, displayed values will be rotated if the associated object is 
rotated on the schematic.  Otherwise, when the object is rotated, the text will move to 
an appropriate new position but be drawn in the normal orientation.
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Visible by Default

If this box is checked, whenever a value is entered for this field it will be displayed on 
the schematic in a default position.  If the field is found in the default attributes for a 
device, the field will be displayed automatically on the diagram when the device is 
placed.

Note: Changing this setting has no effect on values already in the circuit.  If you want to 
globally show all the values of a field on the schematic, see “Permanently Showing Data 
Throughout a Design” on page 95.

Primary

If this box is checked, the field will be considered a “primary” field and will be displayed 
in all attribute entry boxes when “Primary Only” is selected.  It will also appear in the 
window that is displayed by the Attribute Probe ( ) cursor.

Link Value List to Part

If this box is checked, any change in the Part attribute field will cause a corresponding 
value for this field to be selected from a list of available values.

See “Using Value List Sub-menus” on page 87 for more information.

Read Only

This setting indicates that the field value cannot be changed directly by the user. The 
value can still be changed by scripts or internal processes.

Temporary

This setting indicates that the field value is not saved to the design file, i.e. it is only 
valid from when it is set until the file is closed.

Maximum Length

You can specify a maximum length (in characters) for the field data.  This value does 
not determine how much storage is allocated internally for the data, it only affects 
checks that are done when the user enters data.  All attribute data stored with the 
design occupies only the space required for its current value.

Duplicate

This button allows you to create a new field with the same settings and (optionally) 
data contents as an existing one.  You will be prompted to confirm the data duplication 
option before proceeding.  More information on this operation is given in the following 
section.
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Delete

This button allows you to permanently remove a field definition and all associated data 
from the design.

Warning: THIS CANNOT BE UNDONE!!!

More information on the delete operation is given in the following section.

Using Duplicate, Merge & Delete for Global Editing

The Duplicate, Merge and Delete Attribute functions do more than just add or delete 
a name in the attribute list.  They will actually scan the entire design and update the 
data stored with each object.  This makes them very powerful tools for updating your 
design.  First we will review how the functions are invoked, then mention some 
possible uses for them.

These three functions are all invoked from the Define Attribute Fields command in the 
Options menu.  No design data is modified until the OK button is clicked in the Define 
Attribute Fields box.

Note: When the design is updated, all Duplicates are done first, then all Merges and 
Deletes.  This means that a field can be duplicated, then the original source deleted, all in 
one invocation of the Define Attributes box.

Important: There is no guarantee of the order of execution within the Duplicates or within 
the Deletes and Merges.  Therefore, chains of operations (e.g. making a copy of a copy) 
are not guaranteed to work as expected.  If there is any doubt, perform one operation, then 
exit the Define Attributes box using the OK button, then perform the next operation. 

Warning: Each of these operations can result in data being updated throughout a design. 
and they cannot be undone! For large designs there may be a considerable delay after the 
OK button is clicked in the Define Attribute Fields box.

Globally Duplicating Attribute Data

The Duplicate operation adds a new field name to the list with characteristics the 
same as an existing one.  It will also optionally duplicate the data stored under that 
name throughout the design.

Note: The pre-defined fields in OptiSPICE Schematics cannot be renamed or removed.  
However, you can duplicate them, and the copy will be marked as “user-defined”, meaning 
that it can be deleted again or modified in any way.

A field is duplicated by selecting its name in the field list and then clicking on the 
Duplicate button in the Define Attributes dialog:

At this point a box will be displayed allowing you to choose one of the following 
options:
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One important feature of this Duplicate operation is that any attribute display options, 
such as “Visible by Default” or “Show with Field Name”, that are turned on before 
leaving the Define Attributes box will be applied to the duplicated data.  This means 
that a field that was formerly hidden can be duplicated and displayed throughout the 
entire design with just this one operation.

Merging Two Existing Attribute Fields

The Merge operation takes two existing attribute field definitions and merges them 
into one.  If a given object (device, signal, pin or design) has values in both of the 
original fields, the one being renamed takes precedence and the other is lost.

Note: Pre-defined fields cannot be renamed, so they cannot be merged into other fields.  
You can however merge a user-defined field into a pre-defined one.

There is no explicit button for the Merge operation.  Merge is invoked whenever a field 
is renamed so that its name matches another field's.  The procedure is as follows:

Duplicate Definition Only A new field will be defined with characteristics 
just like the one being duplicated, but it will 
have an empty value in each of the objects in 
the design.

Duplicate Data A new field will be defined and the associated 
value in each object in the design will also be 
duplicated and associated with the new field 
name.  Changing the value of the new field in 
a given object will have no effect on the 
original field.
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1 Click on the field to be renamed in the field list.  The data in this field will take 
precedence when the design is updated.

2 Type the new name (i.e. the name of the field you wish to merge to) into the 
Field Name text edit box.

3 Type the Tab key or click on any of the option switches to indicate that you 
have finished typing.

4 A box will be displayed asking you to confirm the merge.  Click the OK button:

The actual merging of design data does not take place until you click on the OK button 
in the Define Attributes box.

Note: You can only merge fields that have similar “Allowed in Object Types” settings.  E.g. 
you cannot merge a signal field into a device field.

Delete

The Delete operation removes the selected name from the list of available fields and 
removes all data values associated with the field throughout the design. Pre-defined 
fields cannot be deleted.

Warning: This operation cannot be undone and should be used with care. 

To delete a field, simply select its name in the field list and click on the Delete button:

A box will be displayed to confirm the Delete operation:  Click OK to proceed.

In any case, no design data is updated until the OK button is pressed on the Define 
Attributes box.

Permanently Showing Data Throughout a Design

The “Visible By Default” option in the Define Attributes box normally has no effect on 
values that already exist in the design.  Enabling the option for a field that is already 
in use affects only future entries.  However, the Duplicate and Merge operations can 
be used to update the display of existing data throughout the design.  This is done as 
follows:

1 Select the Define Attribute Fields command in the Options menu.

2 Select the field to be displayed in the field list.

3 Click on the Duplicate button:
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4 In the confirmation box, click on the Duplicate Data button:

 

5 You will now have a copy of the original field:  Make sure the newly-created 
field is selected in the list, then rename it back to the name of the original field.  
E.g. If the original field was “Value”, the duplicate will be “Value1” and we now 
select “Value1” and rename it back to “Value”.  Press the Tab key when you 
are finished typing.

6 The Merge confirmation box will appear.  Click the OK button.

7 Click on the “Visible By Default” option and any other display options desired.

8 Click the OK button to complete the operation

This operation in effect re-enters all the data into the selected field with the new 
display options.
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Making Signal Connections
This chapter provides more information on the advanced features available for 
making signal connections in OptiSPICE Schematics. This chapter will cover these 
additional methods of describing signal connections:

• Cross-page Connections and Automatic Page References

• Busses

• Bus Pins on Hierarchical Circuit Blocks

• Signal Auto-naming

• Signal Token Numbers

• Signal Connectivity Rules

Using Busses

The bussing facility in OptiSPICE Schematics allows any combination of named 
signals to be represented by a single line and any subset of these to be brought out 
through a “breakout” at any point along the bus line.

Properties of Busses

A bus is treated by OptiSPICE Schematics as a signal with special properties.  Thus, 
bus lines can be drawn and modified on the screen using all the same editing features 
available for signals.  Note these properties of busses:

• Only bus pins on devices can be connected directly to a bus.  All other 
connections must be made by using a breakout to access the desired internal 
signals.  A breakout is created using the New Breakout command in the Options 
menu.

Who Makes the Rules Anyway?

OptiSPICE Schematics has a set of rules that it applies to determine if 
a logical connection is made between two signals with the same name 
in different parts of a design.  These rules are outlined in “Signal 
Connectivity Rules” on page 113.  However, these may not be the only 
rules that apply, depending on where you are going with the schematic 
data. 

The safest course is to ensure that you never use the same signal 
name twice and to check this using the duplicate signal name checking 
scripts provided with the package. 
97



 MAKING SIGNAL CONNECTIONS
• You do not need to specify in advance what signals will be contained in a given 
bus.  Any signals that are present in a breakout or bus pin attached to a bus will 
become part of that bus and can be brought out through another breakout 
anywhere along the bus.

• Any two busses can be joined together, regardless of their internal signals.  When 
two different busses are merged, any signal in either bus becomes available 
anywhere along the combined bus.

• If you select a bus line, then do a Properties command from the Options menu the 
displayed info box will show a list of the signals currently contained in the bus.

• A given signal can be present only in one bus.  If you attempt to connect together 
two signals in different busses, a warning box will be displayed and the 
connection will be canceled.

• A bus can be created by drawing the bus lines first, then creating the breakouts 
to attach, or by creating a breakout and extending the bus line starting at the bus 
pin.  Bus lines are drawn or extended using exactly the same techniques as for 
signals, except that the Draw Bus command or cursor is used instead of Draw 
Signal.

Creating a Bus

A bus can be created by any one of these methods:

• Select the Draw Bus tool ( ) in the toolbar.  Draw any desired contiguous set 
of lines on the diagram using the usual signal drawing techniques.  This bus will 
have no internal signals initially.  Signals will be added implicitly when it is 
connected to any breakout or bus pin.

• Create a breakout symbol using the New Breakout command discussed on page 
“Using Bus Breakouts” on page 100.  The bus pin (backbone) of the breakout can 
now be extended using the normal pointer or the Draw Bus cursor.  The bus will 
contain all signals specified in the breakout.

• Extend a line out from an existing bus pin on a device using the normal pointer or 
the Draw Bus cursor.  The bus will contain all signals specified in the bus pin on 
the device.  Connections between bus internal pins and bus internal signals can 
be changed using the Properties command on the bus pin's pop-up menu.  See 
“Using Bus Pins” on page 103 for more information on bus pins.

Getting Bus Information

A list of internal signals can be seen by selecting a bus and using the Properties 
command, or by right-clicking on the bus and selecting the Bus Info command.  This 
action will display the following box:
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Here is a summary of the options presented in the bus information box:

Adding Signals to a Bus

There is no explicit command to add signals to a bus.  Signals are added to a bus each 
time a breakout or device bus pin is connected to the bus.  Any signals in the breakout 
or bus pin are implicitly added to the bus if they don't exist already.

Getting Information on Signals Inside a Bus

Information on signals that are contained in a bus can be accessed in several ways:

• Select the parent bus and select the Properties command in the Options menu, 
or right-click on the bus and select the Properties command, then use the signal 
list and Signal Properties button to display the signal info box, as described in 
“Getting Bus Information” on page 98.

• Right click on any bus pin attached to the bus, then choose the signal in the signal 
list and click the Signal Properties button, as described in “Getting Information on 
Signals in the Bus” on page 106.

Signals in Bus This is a list of the signals contained in the bus.  This list 
is determined by the breakouts and bus pins attached to 
the bus. 

Bus Attributes This button displays the general attribute data entry box 
for the selected bus. 

Signal PropertiesThis button displays the signal properties box for the 
signal selected in the list. 
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Using Bus Breakouts

Signals are attached to a bus via a special type of pseudo-device symbol called a 
“breakout”.  It is not legal to attach a signal line directly to a bus line and any attempt 
to do so will elicit a warning box.  In OptiSPICE Schematics, a breakout is treated as 
a device with certain special properties.  This means that it can be placed in any 
desired orientation, moved, duplicated, etc. using any of the device editing features 
available.

A typical breakout is used like this:

Any breakout can always be attached to any bus.  When a breakout is attached that 
contains signals unknown in that bus, the signals are implicitly added to the bus.  For 
example, if a second breakout was attached to the same bus containing only the 
signals A and B, all signals in all attached breakouts would be considered part of that 
bus.  In this case, the list would be A, B, N1, N2, N3, and, N4.

Any combination of the internal signals can now be brought out of the bus at any point, 
as in this addition to the above circuit:
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Creating a Breakout

To create a breakout, select New Breakout command in the Options menu, or right-
click on the bus that the breakout is to connect to and select the Breakout command.  
If the new breakout is to be similar to an existing one, first select the similar breakout 
or the bus to which the new breakout is to be connected.   This dialog box will appear:

If a bus or breakout was selected on the circuit diagram then the breakout info box will 
display a list of the signals in that bus or breakout, otherwise it will be empty.  If this 
list already matches the signals you want in the new breakout, then just click the “OK” 
button or hit Enter on the keyboard.  Otherwise, edit the signal list, noting these 
options:
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• blanks or commas can be used to separate individual names in this list, therefore 
bussed signals cannot have names containing a blank or comma.

• a range of numbered signals can be specified using these formats:

D0..7   or   D0..D7

is equivalent to

D0 D1 D2 D3 D4 D5 D6 D7

D15..0

is equivalent to

D15 D14 D13 D12 D11 D10 D9 D8 … D0

D15..D00

is equivalent to

D15 D14 D13 D12 D11 D10 D09 D08 D07 … D00

Note that the “..” format implies that bussed signal names cannot contain 
periods.

• the signals specified will always appear in the order given in this list from top to 
bottom in standard orientation.  We recommend always specifying numbered 
signals from lowest numbered to highest, as in the first example above, since this 
matches the standard library symbols.

• there is no fixed limit on the number of signals in a bus, but we recommend 
dividing busses up by function (i.e. address, data, control, etc.) for ease of editing.

• any combination of randomly-named signals can be included in the list, as in 
these examples:

D0..15 AS* UDS* LDS*

CLK FC0..3 MEMOP BRQ0..2

Once the list has been entered, click on the OK button or hit the Enter key.  An image 
of the breakout will now follow your mouse movements and can be placed and 
connected just like any other type of device.

Setting Breakout Pin Spacing

The number in the Pin Spacing box will be the spacing between signal pins on the 
breakout symbol, in grid units.  The default value is 2 to match the standard 
OptiSPICE Schematics libraries, but any number from 1 to 100 can be entered.

Editing Breakout Pins

The signal name notation that appears on a breakout pin is actually a pin attribute.  It 
can therefore be edited by the usual attribute editing mechanisms, i.e. either:

• Select the pin and choose the Properties command in the Options menu, then 
click the Attributes button, OR,
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• Click the text cursor directly in the text on the schematic, as follows:

• Type the desired new name.

• Press the Enter key.  The breakout pin and the attached signal will be renamed 
as entered.

Important: The notation on the breakout pin is always the same as the name of the 
attached signal name.  Changing the breakout pin renames the attached signal and will 
detach it from any like-named signals already in the bus.

Using Bus Pins

OptiSPICE Schematics supports user-created bus pins on devices.  A bus pin can be 
defined to have any collection of named internal pins.  Note these properties of bus 
pins:

• The bus pin itself does not represent a physical device pin.  It is only a graphical 
place-holder on the schematic representing a group of internal pins.  The bus pin 
itself never appears in a netlist.

• The internal pins represent physical device pins.  Even though they do not appear 
on the schematic, they can have all the same parameters as normal devices pins, 
including pin numbers and attributes.  These parameters can be accessed using 
the Bus Pin Options command in the pin pop-up menu.

• When a device with a bus pin is placed, it has a pre-created bus attached to it by 
default.  This bus will contain one signal for each internal pin, with the initial name 
of the signal being the same as the name as the pin.

• A “splicing” box can be displayed using the Bus Pin Options command in the pin 
pop-up menu.  This box allows any internal pin to be connected to any signal in 
the attached bus.

Changing Bus Pin Connections

When a bus is connected to a bus pin on a device or hierarchical block, the bus 
internal pins will by default connect to signals with the same name in the bus.  To 
change these default connections, use the Bus Pin Options command in the pin pop-
up menu.

This menu item will be enabled only when a bus pin on a device is selected.  It allows 
the association between the bus internal pins on the device and the signals in the bus 
to be changed.  This box will be displayed:
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The left-hand list shows the names of the pins contained in the selected bus pin.  The 
right-hand list shows all the signals in the attached bus.  For each pin in the pin list, 
the signal in the same row in the signal list is the one attached to it.  Signals in the 
signal list beyond the end of the pin list are not connected in this bus pin.  The 
following sections describe the operations available in this box.

Changing Signal Connections in a Bus Pin

Two buttons are provided to change the association between pins and signals.  The 
Join button causes the selected pin in the pin list to be joined to the selected signal in 
the signal list.  If the selected signal is already attached to another pin in the list, then 
the signals will be swapped (i.e. a signal can only connect to one pin and vice versa).  
The signal list will be updated to show the new relationship.

The Join Sequential button provides a quick method of joining multiple numbered pins 
and signals.  The selected pin is joined to the selected signal, as with Join, above.  If 
the signal and pin names both have a numeric part, both numbers are incremented 
and the corresponding signal and pin are joined.  This process is repeated until either 
the signal or pin name is not found in the list.

For example, given the lists appearing in the above picture, if pin D0 and signal D4 
are selected, then Join Selected will join D0-D4, D1-D5, D2-D6 and D3-D7.  Since 
there are no more numbered pins, the process would stop.  Note that although the 
signal and pin names are the same in this example, this is not a requirement.
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Adding Pins to the Bus Pin

The Add Pins button allows you to add internal pins to the selected bus pin.  When 
this option is clicked, the following box will be displayed:

Note: This operation effectively modifies the definition of the symbol and any subcircuit it 
may contain, making it different from its original library definition.  The pin changes are not 
permanent until the Bus Pin Options box is closed.

A list of pins can be typed into this box using the same format as the New Breakout 
command described in “Creating a Breakout” on page 101.  A pin type can be 
selected and will apply to all pins created using this operation.  If no pin type is needed 
in your application, select the default Input type.

Deleting Pins from the Bus Pin

Clicking the Delete Pins button will remove all internal pins currently selected in the 
list from the bus pin.  This operation does not become permanent until you close the 
Bus Pin Options box.

Note: This operation effectively modifies the definition of the symbol and any subcircuit it 
may contain, making it different from its original library definition.

Adding Signals to the Bus

The Add Bus Sigs button allows you to add signals to the signal list so that they can 
then be joined to device pins.  Clicking this button displays this box:
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A list of signals can be typed into this box using the same format as the New Breakout 
command described in “Creating a Breakout” on page 101.  Following are examples 
of allowable formats:

D0..7

D0..15 AS* UDS* LDS*

CLK FC0..3 MEMOP BRQ0..2

The order of entry will affect the order that the signals appear in the list, but is 
otherwise not significant.

Note: These signals are only added temporarily.  When you close the Bus Pin Options box, 
all signals that are not connected to any pin are removed from the bus.

Getting Pin Information on Internal Pins

The Pin Properties button brings up the standard Pin Properties box for the pin 
selected in the pin list.  See the Properties command for more information.

Getting Information on Signals in the Bus

The Signal Properties button brings up the standard signal info box for the signal 
selected in the signal list. 

Displaying a Bus Pin Annotation

If this option is enabled, a list of the connections made in the bus pin will be displayed 
adjacent to the pin.  This is done by creating a value in the BusInfo attribute field for 
the selected bus pin.  This value can be edited manually, if desired, but will be updated 
automatically each time this box is displayed.  The format of the signal list is the format 
used by the Add Bus Sigs option, above.
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Inter-page Connections

Signals drawn on different pages will initially have no logical connection, even if the 
names are the same (see the rules “Signal Connectivity Rules” on page 113).  Inter-
page connections are made using the Page Connector pseudo-device which is in the 
Pseudo Devs library.  When attached to a signal line, the Page Connector makes the 
name of that signal known across all pages, i.e. any like-named signal on another 
page which also has a page connector will be logically connected to this one.  The 
Page Connector can be placed anywhere along the signal line although it is normally 
convenient to place it at the edge of the page.  The Page Connector itself can be 
named (in order to take advantage of the automatic page references mechanism 
described below), but it must have the same name as the attached signal.  Changing 
the name of the Page Connector (using the naming procedure for devices) will also 
change the name of the attached signal.  Likewise, changing the name of the signal 
will rename any attached Page Connectors.

Automatic Display of Page References

OptiSPICE Schematics has an Automatic Page Reference facility which displays the 
page number and position of any Page Connectors associated with a given signal.  
These page references are automatically displayed immediately adjacent to any Page 
Connector as soon as multiple Page Connectors are attached to the same signal.

For example, in this next case both pages have signals named FO with Page 
Connectors attached, so the two FO signals are logically connected.  Note that both 
Page Connectors are notated with the page number and grid reference:

When a name is applied to the Page Connector itself, the page reference will appear 
under the name.

As long as automatic updating is enabled, these references will be updated 
automatically when any Page Connectors or attached signals are added, deleted, 
moved or renamed.

Enabling and Disabling Automatic Page References

Automatic page reference updating is controlled by the Design Preferences command 
in the Drawing menu.  Automatic references are enabled whenever the Automatic 
Page References box is checked.  This means that page reference text will 
automatically be placed next to any named Page Connector that is placed in the 
design, and will be updated whenever any page connector is moved.  If they are 
disabled, the current page reference settings will be left untouched when any 
schematic editing is done.
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Manually Updating Page References

If automatic page references are disabled, page references will be updated only when 
the Update Now button in the Design Preferences box is clicked.  This can be used 
for large designs where page reference updating may cause delays while editing.

Setting Page Reference Format

To change the page reference format, select the Design Preferences command in the 
Drawing menu.  Two aspects of the page reference format can be controlled:

• The “Format” text item controls the appearance of each page reference in the 
reference list.

• The “Max. Width” item controls the number of references that will appear on each 
line before creating a new line.  For signals with many connections, this prevents 
unwieldy page reference strings.

Three characters are special in the format string:

The default format is “P-XY” which generates pages references like “2-C4” (i.e. page 
2, grid position C4).  All characters other than the special ones above will be placed 
in the page reference list verbatim.

The maximum length of a format string is 16 characters.

Connecting Busses Across Pages

Busses can also be connected between pages by the same method, except that the 
Bus Page Connector must be used in place of the Page Connector.  This is illustrated 
in this simple circuit:

P will be replaced by the page number

X will be replaced by the X grid position

Y will be replaced by the Y grid position
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Using Page Connectors on Internal Bus Signals

Note that a Bus Page Connector does not make the names of the internal signals 
known globally, only the bus itself.  To bring an individual internal bus signal across to 
another page, one of the following methods can be used:

1) Make the entire bus global using a bus page connector, then use a breakout to 
access the desired signal, as in this example:

2) Place signal page connectors on the individual signal on both pages, as shown 
here:

Changing the Page Connector Symbol

Note that the symbol for the Page Connector device can be changed using the device 
symbol editor tool just as with any other device.  In order that the resulting symbol be 
recognized by the program as a Page Connector, you must either start with an 
existing Page Connector symbol, or set the primitive type setting appropriately.

Tracing Connections Through Page Connectors

If a Page Connector device is selected in the schematic, the Properties command 
displays this box:
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This is essentially the same box as is displayed for the signal Pin List command, 
except that only Page Connectors are listed.  Following on each item is the page 
number and grid reference of the item.

To display the selected page connector, either:

• select the item in the list and click the Go To button,

OR

• double-click on the item in the list.

Using Signal Auto-Naming

OptiSPICE Schematics has an automatic name assignment feature that ensures that 
every signal object that is created has a distinct name.  This ensures that it is always 
possible to track items in a netlist to a signal on the schematic.  Signal auto-naming 
is enabled by default when a new design is created, unless the selected template has 
specifically disabled it.

When Auto-Naming is enabled, all signals will be given a default name when they are 
created.  In addition, whenever an editing operation causes a single signal to be 
broken into two, or part of a signal to be copied without a visible name label, a new, 
unique name will be auto-assigned.  This ensures that every object in a design has a 
unique name and can be identified in a netlist.

Note: The program generates new names using a specified prefix and the signal’s token 
number, which will produce a unique name in most cases.  However, the program does not 
check for uniqueness.  If you have manually assigned a name to another signal that 
matches the auto-assigned format, there is the possibility that an auto-assigned name may 
already exist. 
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Enabling Auto-Naming

Auto-Naming is enabled by selecting the Signal Naming Options command in the 
Naming and Packaging Options sub-menu in the Options menu.  This will display the 
following options box:

Checking the “auto-assign” box causes all devices placed in the design subsequently 
to be given a default name if they are not already named.

If the “Visible” option is selected, the default name will be displayed on the diagram 
adjacent to the device or signal when it is created.

The “default signal name prefix” text box allows you to specify the characters to be 
used as a basis for auto-generated names.  Changing this value does not affect 
existing names.

Disabling Signal Auto-naming

Signal auto-naming can be disabled by taking these steps:

• Select the Signal Naming Options command in the Naming and Packaging 
Options sub-menu in the Options menu.

• Turn off the Auto-assign box.

Warning: We do not recommend disabling auto-naming.  When signal auto-naming is 
disabled, no modifications are made by the program to existing signal names.  For 
example, if you split an existing signal into two parts, both parts will retain the existing name 
until you explicitly change it.  This may result in an apparent short in a netlist.

How Names are Generated

The auto-generated name consists of two parts, the fixed prefix and the numeric 
suffix.  The prefix portion is derived from the signal name prefix set using the Design 
Preferences command (which is stored in the design’s SigPrefix attribute field).

The numeric portion of the name is generated using a table of signal names used in 
the circuit.  This value is guaranteed to be unique within a circuit level. This table is 
not updated immediately after every editing operation and so doesn’t guarantee to fill 
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in all unused numeric values.  Thus, in a design that has been edited, sequential 
numbering is not guaranteed.
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Signal Connectivity Rules

This section provides a complete reference for all the methods used to interconnect 
signals.  Each of these items is covered in more detail elsewhere in this manual.

• OptiSPICE Schematics automatically checks for a connection whenever the 
endpoint of a signal segment is moved.  In most circumstances, any two lines that 
appear graphically connected are also logically connected.  However, there are 
some editing operations that can cause two lines to overlap without creating a 
logical connection, for example:

In this case, the corner of one signal overlaps another, but the free ends never touch.  
Since the program only checks free ends for connections, no connection is made 
between these items.  This can be seen visually in this case by the lack of a 
connection dot at the intersection.  In addition, clicking on either of the signals would 
highlight only the lines belonging to that signal.

• Signal names must be visible to be checked for connections, unless a Signal 
Connector device (e.g. Ground) is attached.  If you use an attribute editing 
command to make a formerly visible name invisible, any connections caused by 
that name will be broken.

• Signal names are known throughout a single page.  Like-named signal traces on 
a single page are thus logically connected for simulation and netlisting purposes.  
Whenever a signal name is added or changed, the circuit is checked for a change 
in connectivity.  If the name is now the same as another signal on this page, the 
two signals are merged into one.  If this signal segment was previously connected 
by name to others and the name is changed, then the logical connection is 
broken.  Whenever a name change causes two signals to be connected, both 
parts will flash on the screen to confirm the connection.

• Signal names are global across all pages of the circuit when a page connector 
symbol is added to the signal line.  Thus if the name is changed on a signal line 
having a page connector then all circuit pages are checked for like-named signals 
having page connectors.  If any such signals are found then a logical connection 
is made between them.

• Signals which are contained in busses are a special case.  All signals contained 
in busses have a name, even if this is not displayed on the diagram.  However, 
the names of bussed signals will not be used to make logical connections unless 
an explicit name label has been added to the signal line.
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• For example, if you have a bus containing a signal named CLK and a separate 
signal line also named CLK, there will be no logical connection between these two 
signals.  The name appearing on the bus breakout is part of the breakout symbol 
and is not considered to be a name label.  If an explicit label is added to the 
bussed CLK signal (using the Name cursor) then the two CLKs will be logically 
connected.

• The same rules discussed above for signals also apply to busses.  Whenever two 
busses are logically connected, all like-named internal signals also become 
logically connected.  Note that connecting busses across pages requires a “Bus 
Page Connector” device rather than a “Page Connector” to avoid compatibility 
problems between bus and signal connections.
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Hierarchical Design
This chapter provides background and detailed procedures for the hierarchical design 
(subcircuit design) features of OptiSPICE Schematics.

General Concepts

What is Hierarchy?

“Hierarchy” refers to the ability to have a “device” symbol in a schematic actually 
represent an arbitrary circuit block.  The “pins” on the device symbol represent 
connections to specific input-output points on the internal circuit.  For clarity, a device 
symbol that represents an internal circuit will be called a “hierarchical block”.

Hierarchical design provides a powerful way of representing complex designs in 
compact and readable form.  A top-level diagram of your system can show only major 
functional blocks.  These blocks can then be opened to show more and more design 
detail.

Hierarchical design in effect adds a “third dimension” to a schematic diagram.  It also 
raises some complex issues that should be understood before embarking on a major 
design.  Please review this chapter carefully before making extensive use of the 
hierarchical features of OptiSPICE Schematics.

A Simple Hierarchy Example

The following diagram is the master circuit, or top level, of our design example:

Note that it contains two symbols, both representing hierarchical blocks.  Both 
symbols are of the same type, “NAND”, and therefore share the same internal circuit 
definition.  The two blocks are named “X1” and “X2”.  Opening either one of these 
blocks reveals the following internal circuit:
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This circuit consists of six device symbols, “M1”, “M2”, “M3”, “M4”, “C1”, “VDD”, and 
“Ground”, representing physical devices, and a number of “port connector” symbols.  
The port connectors define the interface between the internal circuit and the pins on 
the symbol representing it.

Note the following characteristics of this simple design:

• The block “NAND” has been used twice, so there are actually two M1s, one inside 
X1 and one inside X2.  We say that there are two instances of M1.

• The signals “A”, “B” and “Y” in the internal circuit will actually get absorbed into 
the attached signals in the parent circuit because they are attached to port 
connectors.  They do not exist independently in the physical circuit.

• Signal “SIGX” does not connect to a port connector, so it represents a separate 
signal in the internal circuit.  Like the devices M1, etc., each signal in NAND 
actually represents two physical signals.

These characteristics of a hierarchical design raise the following issues:

• Device and signal names inside hierarchical blocks are not unique if the block has 
been used more than once.  Therefore, a mechanism is needed to create a 
unique name for use in a netlist.

• Signals attached to port connectors get absorbed into the signal attached to the 
parent symbol's pin.  If this too is attached to a port connector, the process repeats 
upward until a unique signal is found.  The name that will appear in the netlist will 
be the name of the highest-level signal.

These issues are addressed in the following sections.

Definition vs. Instance

In OptiSPICE Schematics, circuit data for hierarchical blocks is separated into two 
groups:

• Definition data is all information about the structure and connectivity of a circuit, 
plus the contents of all attributes not marked as “instance” fields.  Definition data 
is associated with the parent symbol and will therefore be identical for all usages 
of the parent symbol.

• Instance data refers to data kept with each physical instance of a device.  For 
example, in the simple design used in the previous section, M1 will have two sets 
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of instance data associated with it, one for each physical device that it represents.  
Instance data consists of pin numbers, interactive simulation data and any 
attribute fields marked as “instance” fields.

In a hierarchical design, only one set of definition data is kept for each hierarchical 
block type, whereas separate instance data is kept for each instance.

More information on defining and using instance attribute fields is given in “Definition 
vs. Instance Fields” on page 80.

Navigating in Hierarchical Designs

Hierarchy adds a third dimension to a design that requires some additional 
commands to allow you to move between levels.  Here are some of the techniques 
available in OptiSPICE Schematics for navigating around a hierarchical design:

• The Push Into command (or simply double-clicking on a subcircuit block) opens 
the subcircuit in a new circuit window.  The Pop Up command performs the 
converse operation, closing the current subcircuit window and displaying its 
parent device symbol.  These commands are described in the following sections.

• Any utility tool (like Browser or Find) that can display a found object will open a 
subcircuit containing the object.  These tools are described elsewhere in this 
manual.

Opening (Pushing Into) a Subcircuit

The Push Into command opens the internal circuit of the given device in a separate 
window.

Note: The Push Into command is available in the Options menu as well as in the device 
pop-up menu, i.e. by right-clicking on the device.

This menu item will be disabled (grayed out) under any of the following conditions:

• The device is not a SUBCCT (subcircuit) primitive type

• The device has its “restrict open” switch set in the Properties box

If the selected device has no internal circuit, you will be asked whether you wish to 
create one.  Clicking OK will create a circuit containing only the default port 
connectors matching the parent device.

Simply double-clicking on a device is a short-cut for the Push Into command.

Closing (Popping Out of) a Subcircuit

The Pop Up command closes the current subcircuit and displays the circuit page 
containing the parent device.

Tip: The Pop Up command is also available in the circuit pop-up menu.  That is, right click 
anywhere in a circuit window not near any circuit objects.

Note: Clicking in the close box at the upper left corner of the window is equivalent to the 
Pop Up command, except that no attempt is made to display the parent device’s window.
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Locking and Unlocking Subcircuits

A subcircuit can be locked to prevent accidental opening.  This is intended for cases 
where the subcircuit is derived from a library or is used only to implement a simulation 
model which should not be edited as part of the parent design.

To lock and unlock a subcircuit from the schematic:

1 Locate the subcircuit’s parent device symbol in the schematic and select it.

2 Select the Properties command in the Options menu.

3 Check or uncheck the Lock Opening Subcircuit box, as desired.

4 Click OK.

Tip: The default locked status can be set when creating a hierarchical block symbol by 
setting the value of the Restrict attribute  field while editing the symbol using the device 
symbol editor tool.  The allowable values for this field are given in “Appendix A -Predefined 
Attribute Fields” on page 291.

Creating a Hierarchical Block - Top Down

In concept, a hierarchical design can be created from the top down or the bottom up.  
In practice, most design processes probably use a mixture of the two methods, 
depending on the order in which system components were designed.

Working top down means creating the highest level of the design first and then 
working downward to more detailed levels.  In practice, this means that you create 
and place the symbol for a hierarchy block first, before you necessarily even know 
what the internals of the block will look like.  Once you have completely created the 
higher-level circuit including the symbols for all the hierarchy blocks it uses, you then 
proceed to define the internal circuits of the blocks.

input/output pin definition

To create a hierarchical block from the top down:

1 Create the block symbol using the Create Subcircuit Block command or the 
symbol editor.

2 Place the symbol on the schematic.

3 Create the internal circuit by pushing into the new symbol.

These steps are described in the following sections.

Creating a Block Symbol

Symbols for hierarchical blocks can be created using the Create Subcircuit Block 
command in the Options menu, or using symbol editor tool.  The device symbol editor 
provides the most flexibility in creating whatever type of symbol you want, but is more 
involved and requires familiarity with that tool.  For this example we will use the Create 
Subcircuit Block command.
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1 Select the Create Subcircuit Block command in the Subcircuit submenu of the 
Options menu.

2 Select the last option - “None Create an Empty Block Symbol” and click Next

3 In the “Left Pin Names” text box enter a list of pins to appear on the left-hand 
side of the symbol.  Following are some examples of pin lists:

See “Adding Sequential Pin Names” on page 159 for more information.

Pin List Pin Description Symbol

A B C Three signal pins A, B and C

D0..7 Eight signal pins D0, D1, D2, ... D7

DATA[D0..7] A bus pin called DATA containing 8 
internal pins D0, D1, ... D7

CLK,,,D0..7 Nine pins in all with extra space 
between CLK and the others
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1 In the “Right Pin Names” text box enter a list of pins to appear on the right-
hand side of the symbol, using the same format as above.

2 Click the “Next” button.

3 Select the first name option “Display the name using the Part attribute”

4 Enter a suitable name in the name box and click Next.

5 If you do not already have a suitable temporary library file open, create or 
open one now using the New Lib or Open Lib buttons.

6 Save the new part into the temporary library by clicking Finish.

Placing the Block Symbol

Hierarchical block symbols are placed just like any other device symbol:

1 In the Parts palette, locate the item you just saved.

2 Drag and drop the symbol where desired on the schematic.

Auto-Creating the Internal Circuit

In this section we will take advantage of the fact that OptiSPICE Schematics creates 
a default internal circuit template when you open an empty block symbol.  It is also 
possible to create your own internal circuit from scratch.  This is discussed below in 
the section on “bottom-up” block creation.

1 Right-click on the hierarchical block symbol.

2 Select the Push Into command.

3 A box will appear asking you to confirm that you wish to create a new internal 
circuit.  Click the OK button.

A new circuit window will now open with the default port connectors laid out according 
to these rules:

• A default port connector symbol is placed for each pin on the parent block, placed 
according to their position on the symbol.

• Each pin on each port connector has its type set according to the rules outlined 
in “Setting the Port Pin Type” on page 130.

Creating a Hierarchical Block - Bottom Up

Any open design can be made into the subcircuit of a hierarchical block symbol.  To 
create the internal circuit first and work upwards, follow these steps:

Hierarchical Block Primitive Type

Hierarchical block symbols are simply device symbols which have 
the primitive type “SUBCCT”, or subcircuit.  Device symbols with any 
other primitive type cannot be used as hierarchical blocks.  SUBCCT 
is the default primitive type when creating symbols with device 
symbol editor, so it is normally not necessary to change this setting.
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1 Create or open the design file that is to become the internal circuit and define 
its port interface.

2 Create and place the hierarchical block symbol in the target design using the 
Create Subcircuit Block command.

For this simple procedure we will make use of the Create Subcircuit Block command 
which performs a number of automatic operations for you.  It is also possible to do 
some of these steps manually to get more control over the symbol graphics and port 
interface.  These two extra steps are also described in the following sections:

• Creating the hierarchical block symbol using the device symbol editor tool is 
described in “Creating a Symbol for an Existing Subcircuit” on page 127.

• Linking the subcircuit to the symbol using the Attach Subcircuit command is 
described in “Attaching a Subcircuit” on page 126.

Note: This procedure links the subcircuit to the symbol only for this design.  You can also 
store the subcircuit permanently with the symbol in the library.  This allows it to be easily 
used in multiple designs without having to use the Attach Internal command each time.  
See “Creating a Part With a Subcircuit” on page 173 for details on how this is done.

Creating a Subcircuit

Creating a circuit that is to be attached to a parent symbol is exactly the same as 
creating an independent design, except for the necessity of defining the port interface.  
Note the following issues when creating the subcircuit:

• Each signal that is to be an input/output point for the subcircuit (that is, a pin on 
the parent symbol) must have an attached port connector.

• The name of the port connector device must exactly match the name of the 
associated pin on the parent symbol.

• For each port, choose a port connector type (input, output or bidirectional) 
appropriate to the signal flow in your circuit.

• Bus ports require special care in creation and naming of port connector symbols.  
Review the rules given earlier in this chapter carefully.

See “Creating and Using Port Connectors” on page 129 for complete details.

The following sample shows how port connectors are attached to the connection 
points in a simple circuit:
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Note: You may wish to save this circuit as a design file for safekeeping, but this file will not 
be associated with the target hierarchical design in any way.  The Place Subcircuit 
command described next will completely incorporate the subcircuit data into the target 
design with no reference to any external files.  More information on alternate ways of 
storing subcircuits is given in “Associating a Subcircuit with a Device Symbol” on page 124.

Placing a Subcircuit

In this section we will use the Create Subcircuit Block command to auto-generate a 
symbol corresponding to the subcircuit created above, and then place it in the target 
design.  To do this:

1 Open or create both the subcircuit and the target circuit.

2 Bring to the front the target circuit window into which you wish to place the 
hierarchical block.

3 Select the Create Subcircuit Block command in the Subcircuit sub-menu of 
the Options menu.  This will display a list of the open designs, except the 
topmost one, which is assumed to be the target.

4 Choose the circuit that is to become the subcircuit.

5 Click the OK button.  Depending on the size of the subcircuit and the 
complexity of the symbol required, this operation may take a while.  When the 
processing is complete, the cursor will be replaced by an image of the new 
hierarchical block.

6 Place the new symbol in the desired position in the target circuit.

Printing Hierarchical Designs

A hierarchical design has an extra dimension which must be taken into account in 
determining the order of page printing.
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Determining Print Page Order

When a design is printed, the master circuit of the design is printed first in its entirety.  
Then, each hierarchical block is printed, followed by all hierarchical blocks it contains.  
For example, given the following structure of nested hierarchical blocks:

The print order would be: A, L, W, X, M, Y, Z.  The order of printing of hierarchical 
blocks inside a single circuit is determined only by internal storage order and cannot 
be controlled by the user.  E.g. W and X could be reversed above.

Setting Printing Scope

To set the scope of printing in a hierarchical design, choose the Design Preferences 
command in the Drawing menu and select the Printing tab.

Three options are available:

• Print current circuit only: With this setting, the Print command will print only pages 
belonging to the circuit level in the current window.  With this setting, the page 
numbers shown by the “Show Printed Page Breaks” option can be used to select 
a subset of pages to print.

• Print all unrestricted circuits: With this setting, the design's master circuit and all 
unlocked internal circuits will be printed.  (The “locked” setting is controlled by a 
check box in the Properties command for the parent device.)  With this setting, 
the page numbers shown by the “Show Printed Page Breaks” option will not be 
relevant since they are numbered separately for each internal circuit.

• Print entire design: Print the design's master circuit and all internal circuits, 
regardless of “locked” status.

Printing Sequential Page Numbers in a Hierarchical Design

When a hierarchical design is printed, the $PRINTPAGENUMBER text variable can 
be used to apply sequential page numbers to the printed sheets.
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Note: This text variable only applies during a Print operation.  When it is drawn on the 
screen, it is interpreted the same way as the PAGENUMBER variable, i.e. it gives the page 
number within the circuit.

See more information on text variables in “Using Text Variables” on page 72.

Associating a Subcircuit with a Device Symbol

There are a number of ways that a subcircuit can become associated with its parent 
device in a hierarchical design:

• The subcircuit can be stored with the symbol in the library.  This is referred to in 
OptiSPICE Schematics as an “internal subcircuit”.  See “Creating a Part With a 
Subcircuit” on page 173 for information on using the device symbol editor to 
attach a subcircuit to a symbol.  Also see “Copying Symbols from a Design to a 
Library” on page 146 for information on using the Save to Lib command to store 
a symbol from a schematic to a library, including its subcircuit.

• The symbol can be stored in a library with no associated subcircuit and one can 
be created or attached to it interactively after it has been placed in the schematic.  
This procedure is described in “Creating a Hierarchical Block - Top Down” on 
page 118.

Warning: When you attach or detach device subcircuits, you are in effect changing the 
definition of the device.  This always affects all other devices of the same type in the same 
design.  This applies to all the subcircuit commands following and any other subcircuit 
editing operation in OptiSPICE Schematics.  If you want to affect only a single device, you 
must first use the Make Unique Type command in the Part Type sub-menu to isolate it from 
others of the same type.  See a more complete description of this command in “Making a 
Single Device Into a Unique Type” on page 149.

Working with Subcircuits

The commands described in this section are intended to assist in assembling 
separate circuits into a complete, hierarchical design, changing the organization of a 
design, and moving or copying subcircuits between designs.  See “Creating a Part 
With a Subcircuit” on page 173 for more information on storing a subcircuit with a 
symbol in a library.

Placing a Subcircuit Block in a Parent Circuit

The Place Subcircuit command is a shortcut for creating a symbol to represent an 
internal subcircuit and placing it in a higher-level circuit.  This command performs 
these steps:

• Displays a selection box allowing you select any other open design to become a 
new subcircuit block.

• Invokes the device symbol editor’s Auto Create Symbol function to generate a 
rectangular symbol with pins representing the ports defined in the subcircuit.

• Attaches the selected design as a subcircuit of the new symbol.

• Enters device placement mode, allowing you to place the new symbol in the 
current circuit.
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Note that the generated symbol is not saved to a library, so if you cancel the device 
placement mode, you can only recover the symbol by going through the same 
process.  If you wish to modify the auto-generated symbol after it is used, this can be 
done using the Edit Symbol command described in “Editing a Device Symbol in a 
Schematic” on page 154.
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Attaching a Subcircuit

The Attach Subcircuit command in the Subcircuit menu allows you to select an open 
design to attach as a subcircuit to the selected device.  When this command is 
selected, the following box will appear:

Warning: This operation cannot be Undone!!!

Clicking Attach on the Attach Internal box will cause the following actions to be taken:

• If the current design (i.e. the one containing the parent device) contains other 
devices of the same type as the selected device, then a separate, temporary type 
will be created for the selected device.  This allows the definition of this type to be 
temporarily modified by the addition of the subcircuit.  The other devices of the 
same type will be updated when you close the attached subcircuit.

• The attribute definition table in the selected internal circuit is compared with the 
table in the master design.  If the Attach operation would result in new fields being 
defined in the master design's table, then you will be prompted for confirmation.  
If you click OK, then new fields are merged into the master design's table.

• Attribute values associated with the internal circuit are merged into the master 
design.  If a given field already has a value in the master design, the value in the 
internal circuit is discarded.

• The logical linkage between the selected device and the new internal circuit is 
completed.  If any mismatch is detected between the port connectors defined in 
the internal circuit and the pins on the parent device, you will be warned.

• The title of the internal circuit is updated to reflect its hierarchical position in the 
master design.

• Auto-packaging, if enabled, is disabled since this operation potentially invalidates 
the design's package table.

• The newly-attached internal circuit's window is brought to the front.  It is now 
considered to be an internal circuit that has been opened for editing and modified.  
When you close the internal circuit, you will be asked if you wish to update other 
devices of the same type.
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Detaching a Subcircuit

The Detach Subcircuit command makes the currently displayed subcircuit into a 
separate design and redefines the parent device as having no internal circuit.

Warning: This operation permanently removes the subcircuit from the selected device and 
all other devices of the same type in the selected design.  If you do not wish to update other 
devices in the design, use the Make Unique command to isolate the selected device first.

The Detach operation cannot be Undone!!!

In particular, Detach Internal performs the following operations on the subcircuit 
displayed in the frontmost window:

• The circuit is unlinked from its parent device, making it into a separate design.

• The title of the subcircuit is set to a default “Designxxx” name.

• The internal circuits of all other devices of the same type in the design are 
removed.

• Auto-packaging, if enabled, is disabled since this operation potentially invalidates 
the design's package table.

Discarding a Subcircuit

To discard the subcircuit associated with a parent device:

• Locate and select the parent device in its circuit.

• Select the Discard Subcircuit command in the Subcircuit menu.

Warning:  All data associated with the subcircuit is destroyed by this command.  This 
cannot be undone!

The Discard Subcircuit command redefines the selected device (and all others of the 
same type) as having no internal circuit.

Creating a Symbol for an Existing Subcircuit

To create a symbol for a subcircuit that has already been created an is open in a 
OptiSPICE Schematics window:

1 Select the New command in the File menu and choose the Device Symbol 
document type.

2 Select the Subcircuit & Part Type command in the Options menu.

3 Click on the Imported Port Definition Only button.  This will display a list of all 
currently open designs.
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Note: Choosing the Internal Subcircuit option instead will cause the circuit definition to be 
saved in the library with the symbol.

4 Select the desired internal circuit in the list and click the Internal button.

The device symbol editor now examines the selected circuit and creates a list of pins 
matching the port connectors in the circuit.

5 Select the Auto Create Symbol command in the Options menu.

6 Click on the Extract Pin List button.

This will place input and output pins in default positions in the Left and Right Pin 
Names boxes.  You may move names between these boxes as desired to determine 
placement of pins.  Be careful not to add or delete any names.  You can also change 
the part name that will appear in the symbol, if desired.
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7 Click on the Generate button.  A default symbol will now appear in the device 
symbol editor window.

This symbol can be edited manually using the drawing tools.

1 Create a temporary library to save the symbol in.  This is done using the New 
Lib command in the Parts palette pop-up menu.

2 Select the Save As command in the File menu.  Select a suitable part name 
and double-click on the new library that was created in the last step.

3 Close the device symbol editor window.

Saving a Symbol with a Subcircuit to a Library

If you have created a hierarchy block symbol and its associated definition in a design 
and wish to save it in a library for use in other designs, follow these steps:

1 Create or open the desired destination library.

2 Locate and select the parent device symbol in your design.

3 Select the Save to Lib command in the Part Type sub-menu.

4 In the Save to Lib box, turn on the “Internal circuit” checkbox to indicate that 
the internal circuit should be saved in the library.

5 Click the Save button.

Creating and Using Port Connectors

Port connectors are special pseudo-device symbols that associate a pin on a 
hierarchical block symbol with a signal in an internal circuit.  Pre-defined port 
connector symbols for the three most commonly used pin functions are provided in 
the Pseudo Devs library with OptiSPICE Schematics: Port In (Input), Port Out 
(Output) and Port Bidir (Bidirectional).  For cases involving bus pins or any 
requirement for special symbol graphics, this section describes how to create custom 
port connector symbols.

Note: If you are working top down in a hierarchical design, you should rarely have to make 
your own port connector symbols.  See “Creating a Hierarchical Block - Top Down” on 
page 118 for more information.  If you are working bottom up, then you will need to define 
the port interface for a circuit using port connectors before making the parent symbol.  See 
“Creating a Hierarchical Block - Bottom Up” on page 120 for a higher level view of this 
procedure.
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The procedure for creating port connector symbol graphics is described in “Creating 
a Port Connector” on page 179.

Setting the Port Pin Type

If pin type (input, output, bidirectional, etc.) is significant for your design, then the 
following rules should be noted when creating and using Port Connectors:

• The pin on the Port Connector symbol is normally of the opposite type to the 
corresponding pin on the parent device symbol.  E.g. A signal coming in to the 
hierarchical block is actually an output from the port connector pin.

• OptiSPICE Schematics does not check correctness of pin types on port 
connectors.

• When an internal circuit is auto-generated, port connectors of a type opposite the 
parent pin are placed automatically.

This figure illustrates these points:

If the parent device pin is an output then it must be driven by the internal circuit, the 
internal circuit's port connector should have an input pin.  To connect a signal in an 
internal circuit with an input pin on a parent device use the “Port Out” connector in the 
“Pseudo Devs” library.

If the parent device pin is Bidirectional then the internal circuit's port connector should 
have a bidirectional pin as well.

Note: When the pin function on a port connector is examined from the schematic module 
via the Properties dialog, the function shown is that of the parent type pin.  This means that 
if the parent type pin is an input then the matching internal circuit port connector's pin will 
show as an input pin in the pin properties dialog.  If you examine the port connector in the 
device symbol editor's pin palette, the same pin will show as an output.

For normal signals (i.e. not buses) you can either:
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• Use one of the Port devices from Pseudo Devs library: Port Bidir, Port In or Port 
Out.  These need to be named to match the pin names of the parent device.

• Use the New Port Connector command to auto-generate a port connector 
symbol.  This procedure is described below.

Using the New Port Connector command to Create a Signal Port

To use this command:

1 Select the New Port Connector command in the Subcircuit submenu of the 
Options menu.

2 Select the desired port type: input, output or bidirectional.  Note that the type 
chosen here is the port type as seen from the parent symbol’s point of view.  
E.g. if this is to be an input into the subcircuit, add an Input port type.  An Input 
port type actually adds an output pin to the port connector as this is an output 
driving the subcircuit.

Important: For bus ports, you have to define the exact list of internal signals to be included 
in the port.  See the section below for more detailed instructions.

3 Enter the name of the port in the Port Name box.   This name must match 
exactly the name of the pin on the parent symbol.  This setting actually sets 
the Name attribute of the resulting port connector and can easily be edited 
later if needed.

4 Click the Place button to place the new symbol in the circuit.

Creating Bus Ports

Connections can be made between busses across hierarchy levels using Bus Port 
Connectors.  Bus pins on a parent device symbol must be matched with a Bus Port 
Connector having identical internal pins.  For this reason, Bus Port Connectors must 
always be custom made, with any, or a combination, of these methods:

• Using the auto-generate function that creates a subcircuit “shell” for you 
automatically when you create a new subcircuit.  This is described in “Creating a 
Hierarchical Block - Top Down” on page 118.

• Use the New Port Connector command to auto-generate a port connector 
symbol.  This procedure is described below.

• Using the device symbol editor tool to create a device symbol with the appropriate 
pins, either from scratch, or using an existing bus port connector as a guide.  This 
method is described in “Creating Bus Ports” on page 131.

Important:  Unlike Bus Page Connectors,  Bus Port Connectors do not export all the 
signals in the attached bus, only the ones for which is has explicit Bus Internal pins.
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Creating a Bus Port Connector Using the New Port Connector Command

The New Port Connector command is the easiest way to create a bus port connector 
when working “bottom up”, i.e. you have not yet created the parent symbol.  To use 
this command:

1 If the bus to which you plan to connect the port connector already exists, 
select it first.  This way, all signals already in the bus will automatically be 
added to the list without any further action.

2 Select the New Port Connector command in the Subcircuit submenu of the 
Options menu.

3 Select the Bus option.

4 Check the “Internal Pin List”.  If you had already selected a bus before 
entering this command, the list may already have the items you need.  If not 
they will need to be added.

5 To add more pins, enter the pin name (or a list or range of pin names) into the 
Pin Name box, then click the desired type of port pin.  The name format used 
here is the same as is used in the New Breakout command and other similar 
commands.   See “Creating a Breakout” on page 101.for details on this 
format.

Note: For many applications, the port  type is not significant.  See “What Pin Types are 
Used For” on page 303.for a discussion of the uses of this setting.

If you do need to select the port type, note that the type chosen here is the port type as 
seen from the parent symbol’s point of view.  E.g. if this is to be an input into the subcircuit, 
add an Input port type.  An Input port type actually adds an output pin to the port connector 
as this is an output driving the subcircuit.

6 When you have added all the required internal pins, enter the port name into 
the Port Name box.  This name must match exactly the name of the pin on 
the parent symbol.  This setting actually sets the Name attribute of the 
resulting port connector and can easily be edited later if needed.

7 Click the Place button to go to device placement mode with the generated 
port connector symbol.

Important: If you cancel device placement, the symbol is not saved anywhere and you will 
have to repeat the above procedure.

Bus Pin Name Matching

Note the following rules for name matching in bus ports:

• As with other Port Connectors, a Bus Port Connector must be 
given a Name exactly matching the pin name of the bus pin on 
the parent device.

• The internal pins in the parent bus pin must exactly match the 
internal pins on the Bus Port Connectors bus pin.

• The pin name of the bus pin itself on the Bus Port Connector is 
not significant.

• As with normal ports, the names of the signals attached to the 
Bus Port Connector's pin are not significant.
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Modifying an Existing Bus Port

An existing bus pin and its corresponding bus port connector can be modified in any 
of the following ways:

• To add or delete internal pins from a bus pin, right-click on the bus pin and select 
the Bus Pin Options command.  See “Adding Pins to the Bus Pin” on page 105 
for more information.

Important: If you select a bus pin on a parent symbol that has a subcircuit, the Bus Pin 
Options command will automatically modify the corresponding bus port connector in the 
subcircuit so that it matches.  THE REVERSE IS NOT TRUE!  Using the Bus Pin Options 
command on a bus port connector in a subcircuit does not automatically update the 
corresponding parent pin.  This must be done manually!

• To make any graphical modifications to either the parent symbol or a port 
connector in the subcircuit, you must use the device symbol editor tool.  See 
“Editing an Existing Part on a Schematic” on page 158 and “Creating a Port 
Connector” on page 179 for more details.  It is the user’s responsibility to ensure 
that matching modifications are made to both the parent symbol and the port 
connectors.
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 SEARCHING AND BROWSING TOOLS
Searching and Browsing Tools

Introduction

The purpose of this chapter is to describe the usage of a number of tools that can be 
used to locate and update circuit objects in a design.  These include:

• The Find tool is used to locate devices, signals or pins in a schematic by name or 
attribute values.  Once the objects are found they may be sequentially selected 
and viewed or selected as a group to be operated on with some other tool.  For 
example, you might locate all capacitors with a certain Value setting, then use the 
Browser to display those selected items and enter a modified value. The Find tool 
is script based, that is, it calls the report generator tool to run a script file and then 
uses the output of the script to locate the objects that the script describes.  For 
this reason, it has considerably more flexibility than just as a “find by name” tool.  
Any processing that can be done in a script can be used to locate objects.

• The Browser is a tool used to view and navigate attributes data in spreadsheet-
style format.  Rows of the spreadsheet display objects in the schematic, either 
devices, signals, pins or nets.  A cell of the spreadsheet displays an attribute 
value for the object in that row and the attribute field name in that column. .

The remainder of the chapter is covering these tools in more detail.
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Using the Find Tool

Starting Find

To invoke Find, select Find in the Drawing menu.  This opens the find panel:

The following sections provide details on the usage of the various controls in this 
window.

Search Click this button to start the search.  This runs the 
search script and displays the results in the item 
list.
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Locating Found Objects on the Schematic

If the “Show on Schematic” box is checked, the current object will be located on the 
schematic and selected each time an item is selected in the results list.

Some types of circuit objects may not be able to be shown:  Bus internal pins and 
signals have no visible manifestation on the schematic.  If one of these is found by the 
script, its containing bus will be selected.

Marking Located Objects as OK

The “Mark as OK” button allows you to indicate that a found object is not actually an 
error and should not be found again by the same test.  This allows you to keep “false 
alarms” out of the test results so that actual errors will be more easily located in future 
checks.

Note: This feature may not be implemented in all scripts.  If the script does not generate 
the information required, this button will be disabled.

? - Script Help Click this button to display notes describing the 
selected search script and how it is used.

Script Selector This pop-up menu displays a list of all available 
search scripts.  To get more information on a 
script, select it in this list and click the “?” script help 
button.

Search Text This box is where you type text that is used by the 
script to locate objects.  For example, if you select 
a “find devices by name” script, type the name of 
the device you want to find here.  The usage of this 
text is completely up to the script, and some scripts 
may ignore it.

Search Result 
Summary

After a search is completed, the script will display 
a summary of results in this box.

Search Result List When a search is completed, this list will contain a 
list of all items found by the script.  This will 
typically be a list of objects in the design matching 
some criteria, but the script can make use of this 
list any way it likes.

Show in Schematic If this switch is on, the Find tool will attempt to 
locate the corresponding object in the schematic 
each time an item in the result list is clicked.  If the 
script has not provided any object information with 
the result items, this will not be available.

Mark as OK If the script implements the Mark as OK function 
(described below), this button will allow you to 
mark a selected item so that it will not be found 
again.

Item Info This box displays more detailed information on an 
item selected in the results list.
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Clearing the Mark as OK Settings

The Mark as OK settings stored with objects by previous error checks can be removed 
in either of these ways:

• Use Export to run a Clear OK Errors script provided.  This will not locate any 
objects, but it will clear the Mark as OK settings for all objects in the circuit.

• Manually remove any value from the OKErrors attribute field in the device, signal 
or pin in question.  The numeric value stored by the script is taken as a set of bits 
that mask out specific errors.  Setting the value to “0” or removing it completely 
indicates that all error checks should be performed on this object again.

Using the Browser Tool

Opening the Browser

To open the Browser, select the Browser item in the View menu.  This opens a 
spreadsheet window.

Close Box Click this control to close the Browser window.  Another 
method of closing is to select the Browser item in the View 
menu.

File Menu This menu contains the Save As command, which allows 
you to save the contents of the spreadsheet as a text file.

Edit Menu This menu contains the standard clipboard editing 
commands which allow you to operate on selected cells in 
the spreadsheet.

Options Menu This menu contains options to control the type of objects 
displayed and how they are selected.

Level Menu The menu shows the circuit hierarchy upwards from the 
current circuit and allows you to move up by selecting an 
item.  NOTE: This menu only appears when a subcircuit 
in a hierarchical design is current.
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By default the Browser will initially display all devices in the current circuit.  If any 
objects are selected in the schematic, the Browser will display only selected devices 
or signals.  Selected devices have priority over selected signals.

Closing the Browser

To close the Browser window, either click in the Close box (the small X button at the 
corner of the window), or select the Browser item again in the View menu.

Updating the Browser Window

The Browser will update any time a change occurs in the schematic that effects the 
data displayed in the spreadsheet, or when its scope is set to Circuit and the current 
circuit changes.

Selecting the Type of Objects Displayed

Note: The Browser is controlled by the separate File, Edit and Options menus on the 
Browser panel itself.  The menus in the main application menu bar do not affect the 
Browser.  Specifically, the Cut, Copy and Paste edit menu items in the main menu bar will 
still operate on the selected circuit items and not on the spreadsheet.

The Object Type submenu under Options allows you to change the type of object 
being displayed.  There are eight different types of objects that may be displayed 
Devices, Signals, Pins, Nets, and selected Devices, Signals, Pins, and Nets.

If the “Selected” form of an object is chosen to be displayed, e.g. Selected Devices, 
then only items which are selected in the schematic will be displayed.  Similarly, if 
Selected Signals is chosen in the Object Type menu, then only signals that are 
selected in the schematic will be listed in the spreadsheet.

Attribute Type 
Selector

This list allows you to select what type of fields are shown 
in the Attribute List.  By default, only Primary fields are 
shown, i.e. attribute fields marked as “Primary” in the 
Define Attribute Fields command.  You can also elect to 
show:

Secondary fields—Fields not marked as “Primary”

Pseudo attributes—Text values that are associated with 
an item by the system, but are not normal attribute fields, 
including the part name and graphical information.

Definition fields—All attribute fields not marked “Keep with 
Instance” in the Define Attribute Fields table.

Instance fields—All attribute fields marked “Keep with 
Instance” in the Define Attribute Fields table.
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Determining Where to Search for Objects

When looking for objects, the Browser will limit its search scope by using the selection 
made in the scope menu pop-up.  There are four different scopes:

Displaying Attributes

To add an attribute field to the spreadsheet, simply double-click its name in the 
attribute list.

Note: The Nets and Selected Nets object types display a different format in the 
spreadsheet and do not allow attributes to be added.

Attributes are divided into three groups:

The attribute field names appearing in the list will change as the type of object 
selected for display is changed.  Only attributes that apply to a given object type are 
displayed.  For example, the attribute field “Part” is associated with Devices but will 
not be associated with Signals.

If an attribute name is checked in the attribute list then it will be added as a new 
column at the end of the spreadsheet.  Double-clicking a checked attribute name 
removes the associated attribute from the spreadsheet.

Design In this scope the entire design hierarchy is search for 
objects of the correct type.  This scope has a side-effect.  
Some of the objects attribute values displayed may not be 
editable because of definition/instance conflict resolution.  
The uneditable objects and/or fields will be displayed with 
a gray background.

Circuit In this scope the search is limited to the pages of the 
circuit with the most active window.

Here Down In this scope the search for objects is in the circuit with the 
active most window and in all circuits below it in the 
hierarchy.  Some of the objects and/or fields may not be 
editable for the same reasons as explained in Design 
scope.

Page This scope only looks for objects in the circuit with the 
most active window and in addition only looks at the page 
associated with that window.

Pseudo Attributes These are characteristics about the object that 
the schematic knows but are not true attributes.  
These attributes may not be edited.

Primary Attributes These are attribute that have been selected in the 
Define Attribute Fields command and marked as 
“Primary”.  This is done to allow easier access to 
the more common attributes.

Secondary Attributes These are all the attributes that are not marked as 
primary (see above).
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Changing Attribute Values

Selecting and Editing Cells

To edit a cell, just click on it and start typing.  Cells that are shaded gray are displaying 
values that cannot be edited in the spreadsheet

Modifying the value of a cell will cause the corresponding attribute value of the object 
in the schematic to change.

Warning: The schematic data is updated immediately and there is no undo.

Using the Edit Menu Commands

The Edit menu in the Browser panel contains the standard clipboard editing 
commands Cut, Copy, Paste, and Clear, plus four additional menu items:

Disallowed Editing Changes

Any editing change that may cause a structural change to the connectivity of the 
schematic will be disallowed and aborted by the Browser.  There are only a few 
special cases that will cause this to happen. For example:

• Renaming a visible signal to the same name as another visible signal on the same 
page would cause the two signals to become one signal.

• Making a signal visible which has the same name as an already visible signal with 
the same name would cause the two signals to become one signal.

Saving and Printing Data in a Browser Window

The Save As command in the Browser’s File menu provides a method of directly 
saving data that appears in the spreadsheet display.  There is no direct printing 
command to print the contents of the spreadsheet, but you can open the resulting test 
file in any text editor or word processor to format it for printing.

Fill Down The Fill Down command takes the selection rectangle 
and copies the values in the cells at the top of the 
selection to all the selected cells below them.

Fill Right The Fill Right command takes the selection rectangle 
and copies the values in the cells at the left of the 
selection to all the selected cells to the right of them.

Make Visible The Make Visible command takes the object 
attributes affected by the selection rectangle and 
makes them visible in the schematic.  This command 
applies only to attribute values (not pseudo-attributes 
like the part name) and only to visible objects.  For 
example, it is not possible to display attributes 
associated with bus internal signals.

Make Invisible The Make Invisible command takes the object 
attributes affected by the selection rectangle and 
makes them invisible in the schematic.
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Browser Clipboard Data Format

The Browser exports data in a tab-delimited text format commonly used by 
spreadsheet and database programs.  The following points summarize this format:

• Items appearing on one line in the spreadsheet display appear on one text line.

• Items on one line are separated by a tab character.

• Lines are terminated by a single carriage return character.

• If an item contains anything other than alphanumeric characters and spaces it is 
enclosed in double quotes.  If it contains a double-quote character, that character 
is doubled, i.e. it is preceded by a second double-quote.

Note that attribute items can themselves contain carriage returns and other control 
characters.  Such items will be enclosed in double-quotes in the clipboard text.

Showing Objects in the Schematic

When the Show in Schematic option in the Options menu is checked, the Browser will 
always attempt to display the associated schematic object whenever a cell is selected 
in the spreadsheet.

The Browser may sometimes not be able to show the object.  The reason for this is 
generally that the object was not in an open window, or does not have a visible 
representation, e.g. bus internal signals.

Sorting Displayed Objects

Items are always displayed in the spreadsheet sorted in order by the first column.  If 
the values in the first column are the same, the second columns is used, etc.  The sort 
order can be changed by re-ordering the columns so that the primary sort value is in 
the first column

Adjusting the Spreadsheet

Resizing Columns

Columns may be resized by moving the cursor into the column heading area and 
positioning it over the vertical dividing line.  The cursor when correctly positioned it will 
change shape.  Press the mouse button and drag the line to size the column to its 
desired size.  Rows cannot be resized.

Moving Columns

Columns are reordered by moving the cursor into the column heading area and 
positioning it over the column heading to move.  Hold the Shift key and drag the label 
to its new position.

Tip: It can be useful to move columns so that the sorting mechanism will base the sort on 
the new ordering of the columns.
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Device Symbols and Libraries
Device symbols are an important resource in your design creation process.  Whether 
you primarily use the symbols provided with OptiSPICE Schematics, or you create 
special libraries for your own use, the completeness and accuracy of this data has a 
major effect on your design flow.  Library files generally outlast any one design and 
are used for many years across many projects. OptiSPICE Schematics provides a 
variety of features for creating and editing the symbols themselves and for 
maintaining symbol library files.

This chapter covers these topics:

• The creation and maintenance of symbol library files.

• The creation and editing of individual device symbols using the device symbol 
editor tool.

• The attribute fields that are commonly used in symbols to implement auto-naming 
and other OptiSPICE Schematics features.

• How to use the standard libraries that come with OptiSPICE Schematics.

• Schematic operations that affect symbol definitions.

Working With Symbol Libraries

The symbols and related parameters for OptiSPICE Schematics devices are stored 
in data files called symbol libraries.  For each device type in a library the following data 
is stored:

• General information on the type, such as number of pins, number inputs, number 
of outputs, type name, default attributes, position, orientation and type of each 
pin, etc.

• A picture representing the symbol for this part type.

• A polygon outlining the symbol, used for highlighting and erasing the symbol.

• An optional internal circuit definition.

The following sections deal with the creation and maintenance of library files.  Later 
parts of this chapter deal with editing the symbols themselves.

Terminology Note

It is important to distinguish between the definition of a symbol that is 
stored in a library, and an instance or usage of it in a schematic.  In 
this manual we use several different terms to refer to the definition of 
a device symbol in a library.  If we use the term symbol, part, part 
type, or just type, we are referring to the definition of a device symbol 
in a library.  The term symbol is used when we are primarily interested 
in the graphical representation of a device, but a symbol is always 
stored with related pin definition information and text attributes.
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Creating a New Library

To create a new, empty symbol library file is created using either of these methods:

1 Right-click anywhere in the Parts palette.  In the pop-up menu that appears, 
select the New Lib command.

In either case, a standard file save box will appear.  Enter the desired name for the 
library and select a disk directory.  The library created and opened automatically so it 
appears in the Parts palette. 

Designs and Libraries

Whenever select a device symbol from a library and use it in a design, 
all information needed to display and edit that device is retained with the 
design.  (Of course, only one copy is kept, regardless of how many times 
you use the same symbol in one design.)  No further access to the library 
itself is required.  This is done to ensure that a design file is always a 
complete entity and that future changes to a library will not inadvertently 
render an old design incorrect.

However, there are frequently times when you would like to update a 
symbol in a library and then copy the changes into one or several 
designs.  Conversely, you may have edited a symbol or its subcircuit on 
a single design and wish to save the changes back to a library for use 
elsewhere.

For these reasons, OptiSPICE Schematics does retain some 
information with each symbol about its “home” library and provides a 
number of features to allow transfer and updating of symbols between 
designs and libraries.  Each time a new symbol is used in a design (i.e. 
one that hasn’t been used in this design before) the library name, file 
path and “last modified” date are stored in the attribute fields LibName, 
LibPath and LibDate, respectively.  These are used by the Update from 
Lib command to locate the original library and determine if it has 
changed since we used it.

In addition, whenever the definition of a device symbol is modified, a 
new “checksum” value is calculated.  This is also used as a check to 
verify the equivalence of two symbols whenever one is loaded from a 
library.

Two utility tools are provided with OptiSPICE Schematics to allow the 
mass transfer of all the symbols in a design to a library, or to place one 
each of all the symbols in a library in a design, for testing or modification.  
These tools are described in “Copying Symbols from a Design to a 
Library” on page 146.
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Manually Opening a Library

To open any library file on your disk:

1 Right-click anywhere in the Parts palette.  In the pop-up menu that appears, 
select the New Lib command.

In either case, a standard file open box will appear.  Locate the desired file in the usual 
way.  The library will be opened and appear in the Parts palette.  A small amount of 
memory is occupied by each open library file.

Automatically Opening Libraries at Startup

Libraries can be opened automatically when the program starts by any of these 
methods:

• Open the library using the Open Lib command and check the “Automatically open 
this library at startup” checkbox. This places the library on the auto-open list, 
which can be managed using the Auto Open Libs command.

• Select the Auto Open Libs command and click the Add button to add a new item 
to the list.

• Placing the library (or a shortcut to it) in the Libs folder inside the OptiSPICE 
Schematics program folder.

• Placing a command in the OptiSPICE Schematics initialization file 
(Schematics.INI) to specifically open the library using the LIBRARY or 
LIBRARYFOLDER setup file keywords. 

Note: By default, when OptiSPICE Schematics is installed, a folder called Libs is created 
containing the initial libraries.  This default folder is itself specified using the 
LIBRARYFOLDER keyword in the INI file and can be changed if desired.
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Manually Closing a Library

To close any open library file, either:

• Slide down the File menu to the Libraries sub-menu.  In this sub-menu, select the 
Close Lib command,

 or,

• Right-click anywhere in the Parts palette.  In the pop-up menu that appears, 
select the Close Lib command.

In either case, a list of the open library files will appear.  You can use the SHIFT and 
CTRL keys to select multiple files to be closed in one operation and then press the 
Close Lib button.  Alternatively, you can simply double-click on the name of a single 
library.

Note: Any information required for symbols used in any open designs will be automatically 
retained in memory.  Once you have used a symbol in a design, all information required 
has been copied into the design’s data.  No further access to the library itself is required.

Copying Symbols from One Library to Another

To copy one or more symbols from one library to another, follow these steps:

1 Make sure the source and destination libraries are open in the Parts palette.  
If not, follow the steps under “Manually Opening a Library” on page 145.

2 Select the Lib Maintenance command, either in the Libraries sub-menu of the 
File menu, or by right-clicking in the Parts palette.

3 Select the source library in the pop-up library selection menu above the 
“Source Lib” list.

4 Select the destination library in the pop-up library selection menu above the 
“Dest Lib” list.

5 Select the symbols to be copied in the source list.  You can select multiple 
items using the M and c keys.

6 Click the Copy button.

The copy operation will now proceed, with status messages appearing in the 
Messages area at the bottom of the box.

Copying Symbols from a Design to a Library

See “Saving a Symbol Definition from a Schematic to a Library” on page 153.
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Deleting Symbols from a Library

One or more symbols may be permanently deleted from a library by following these 
steps:

1 Make sure the target library is open in the Parts palette.  If not, follow the 
steps in “Manually Opening a Library” on page 145.

2 Select the Lib Maintenance command, either in the Libraries sub-menu of the 
File menu, or by holding the š key pressed while clicking in the Parts palette.

3 Select the target library in the pop-up library selection menu above the 
“Source Lib” list.

4 Select the symbols to be deleted in the source list.  You can select multiple 
items using the M and c keys.

5 Click the Delete button.  You will be prompted to confirm the operation before 
the items are permanently deleted.

Warming:  The Delete operation cannot be undone!

Duplicating a Symbol Within a Library

You can duplicate a symbol within a single library by following these steps:

1 Make sure the target library is open in the Parts palette.  If not, follow the 
steps in “Manually Opening a Library” on page 145.

2 Select the Lib Maintenance command, either in the Libraries sub-menu of the 
File menu, or by holding the š key pressed while clicking in the Parts palette.

3 Select the target library in the pop-up library selection menu above the 
“Source Lib” list.

4 Select the symbols to be deleted in the source list.  You can select multiple 
items using the M and c keys.

5 Click the Duplicate button.  You will be prompted for each selected item to 
enter a new name.  Names must be unique within a library.

Renaming a Symbol in a Library

You can rename a single symbol in a library by following these steps:

1 Make sure the target library is open in the Parts palette.  If not, follow the 
steps under “Manually Opening a Library” on page 145.

2 Select the Lib Maintenance command, either in the Libraries sub-menu of the 
File menu, or by holding the š key pressed while clicking in the Parts palette.

3 Select the target library in the pop-up library selection menu above the 
“Source Lib” list.

4 Select the symbols to be renamed in the source list.  You can select multiple 
items using the M and c keys.

5 Click the Rename button.  You will be prompted for each selected item to 
enter a new name.  Names must be unique within a library.
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Getting Information on a Symbol in a Library

You can display information on a symbol, such as the exact location of the source 
library and a summary of attribute values, by right-clicking on the item in the parts 
palette, then selecting the Properties command.  Part information cannot be modified 
in this display.  To modify part attributes and other properties, select the Edit Part 
command and use the symbol editor facilities to make the desired changes.

Reordering Symbols Within a Library

Several options are available in the Library Maintenance box for reordering symbols 
within a library.  These options do not affect the data associated with any symbol, they 
merely change the order in which they are indexed in the library file, which affects 
ordering in some internal operations.

Note: Items displayed in the Parts palette are always sorted alphabetically, so this 
procedure will not affect the displayed list.

First, to display this box, select the Lib Maintenance command, either in the Libraries 
sub-menu of the File menu, or by holding the š key pressed while clicking in the Parts 
palette.  Two kinds of reordering operations are available:

• The Promote and Demote buttons cause the selected items in the Source Lib to 
be moved up or down the list, respectively.

• The Sort button sorts the entire list alphabetically, with the numeric part of any 
name treated as an integer.  The adjacent arrow buttons determine the direction 
of the sort.

Compacting a Library

When parts are deleted from a library, the free space in the file is not automatically 
recovered.  In most cases this is not a significant overhead.  However, if a large 
percentage of the parts in a library have been deleted then you may wish to compact 
the file.  To do this:

1 Create a new, empty library which will become the target for the Compact 
operation.

2 Select the Lib Maintenance command.

3 Select the library to be compacted as the Source Lib.

4 Select the new, empty library as the Dest Lib.

5 Click on the Compact button.

Important: Verify that the new destination library is correct before discarding the old copy.

Using Circuit Elements as Library Items

In addition to regular symbol libraries, OptiSPICE Schematics allows you to create 
libraries of circuit elements or scraps that can be used in designs in a manner similar 
to placing a symbol. This can be used, for example, to keep commonly-used graphics 
like title blocks and background elements, circuit scraps, groups of symbols in a pre-
aligned format, etc. Each element in such a library is actually a complete design file 
and can contain any desired circuit elements. Dragging such an element from the 
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library palette actually copies the entire contents of the source file into the destination 
design at the indiated location.

Setting Up a Library of Circuit Elements

A circuit element library is simply a folder that contains normal design files. To set up 
such a folder:

• Place a command in the OptiSPICE Schematics initialization file (Schematics.INI) 
to specify the desired folder using the LIBRARYFOLDER setup file keywords.

• Place design files (.osch) in the folder containing the desired elements. Each 
design file will appear as one element in the library list with the file name as the 
element name. Only items on page 1 of the design are copied when the element 
is used.

Operations on Symbols in a Schematic

Making a Single Device Into a Unique Type

This command makes the selected device into a unique type.  In other words, even if 
other devices in the same design were originally drawn from the same library, this one 
will now be considered to be unique.  This is primarily intended for hierarchical 
designs.  This allows the internal circuit for the selected device to be modified or 
deleted without affecting other similar devices.
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Updating a Symbol from a Library

The Update from Lib command updates the definition of the selected device from its 
original source library.  There are a variety of options available to determine how 
attributes and subcircuits are updated and how a source symbol definition is selected.

Warning: Depending upon the options selected, this command may replace the entire 
internal circuit of the selected device.  THIS CANNOT BE UNDONE!

Selecting the Update from Lib command in the Part Type sub-menu of the Options 
menu causes the following box to be displayed:

Note: The box that appears may be simpler than that shown above.  Only options that are 
relevant to the specific device selected are shown.

The first option pop-up menu allows you to select how the source library will be 
located:

Original Library This selection will locate the original library that 
the device was derived from using information 
stored in its attribute fields.  As long as the library 
can be located and a part with the same name 
can be located in the library, you will not be 
prompted to locate a source.

Select New Source This selection will cause a sequence of two 
prompt boxes to be displayed requesting a library 
and then a part within the library.  This new 
symbol will be used to update the selected 
device.
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Next, you need to select which devices on the schematic you wish to update.  The 
choices are:

The Attribute Update Options pop-up menu allows you to choose how attribute values 
are updated in the event that the new symbol definition has different values than the 
existing device instance:

Note: The Name and InstName fields are not modified by the Update operation, regardless 
of attribute update setting.

Update This Device 
Only

Only the selected device will be updated.  NOTE: 
This in effect redefines the device to be different 
from others that were originally derived from the 
same library part.

Update All Devices of 
Same Type

This will update all devices in the design that were 
originally derived from the same part type.  Note 
that this is determined by the internal logical 
linkage between the device instances and the 
part definition, not by the type name.  If you have 
multiple type definitions with the same name in 
your design, this option will only update the 
devices linked to the same type as the selected 
one.

Update All Devices with 
Same Type Name

This option will update all devices derived from a 
type with the same name as the selected one, 
even if the definitions have become separated by 
some previous operation.  This is specifically 
intended to remedy the case where a design 
inadvertently contains multiple definitions of 
similar devices.

Keep All Old Values This selection tells OptiSPICE Schematics to 
maintain all attribute values exactly as they are in 
the current instance, even if the new symbol 
definition has different values.

Keep Old Values 
Modified in Instance

This selection indicates that you wish to keep any 
attribute values in the device instance that were 
changed from the default value in the original 
definition.  Any values that still have the default 
specified in the old symbol will be updated to the 
new default value in the new symbol.

Use New Non-null 
Values

This item indicates that you wish to use the value 
specified in the new definition, if there is one, but 
keep any old values that are not overridden by 
new ones.

Use All New Values In this case, the updated instance will have 
exactly the values in the new definition, even if 
they are empty.  All attribute data present in the 
old definition will have been replaced by new 
values.
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Two other options appear in the Attributes section:

Finally, if either the existing instance or the definition in the library, or both, have 
subcircuits, then you need to choose which circuit you wish to keep.

Recalculate 
displayed attribute 
positions

This checkbox allows you to determine whether 
displayed attribute values will be left at their old 
positions or recalculated to fit with the symbol.  If 
the symbol has not changed in shape appreciably 
and you have manually repositioned the 
displayed values, you may wish to turn off this 
option.

Update attributes 
only - symbol not 
changed

If this box is checked, only attribute values are 
affected, the device symbol, pins, subcircuit and 
other aspects of the part type will not be affected.

Update Internal Circuit from 
Library

If the selected device has an internal circuit 
it is removed.  If the new library part 
definition has an internal circuit as new one 
is created.

Keep Existing Internal 
Circuit

Any existing internal circuit is kept and only 
the symbol is updated.  Note that if you 
make this selection, the part definition in 
the design will be marked as having been 
changed since it is not the same as the 
library definition.
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Saving a Symbol Definition from a Schematic to a Library 

The Save to Lib command saves a type definition for the selected device to a library.  
The following box will be displayed:

This table summarizes the options available.

Save Symbol Image in its 
Original Orientation

This saves the type definition with the 
symbol image as it was originally drawn.

Save the Symbol Rotated 
as it Appears for the 
Selected Device

Selecting this option causes the type 
definition to be saved with the symbol 
rotated as it currently appears.

Save Internal Circuit 
Definition

If this box is checked, the internal circuit 
attached to the selected device will be 
saved with the part definition.

All attributes in selected 
instance

If this option is selected, all the attribute 
values associated with the selected device 
will be made part of the saved library part.

Save positions of all visible 
attributes in the selected 
instance

If this box is checked, then a “.Pt” position 
field will be created for each attribute that is 
visible on the instance and for which the 
associated “.Pt” field is defined in the 
design’s attribute table.

Attributes in original 
definition only

If this option is selected, only attributes that 
were originally defined for the library part 
will be saved.

Part Name The part name under which the new library 
entry will be saved.

Open Library This button allows you to open any existing 
library file on disk to add to the destination 
library list

New Lib This button will display a standard file save 
box allowing you to create a new, empty 
library.
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Saving All the Symbols in a Design to a Library

To make a library containing all the symbol definitions used in a circuit:

• Ensure that the circuit whose symbols you want to save are in the frontmost 
window.

• Ensure that the library you wish to write the symbols to is selected in the Parts 
palette.  If it is not, either select it from the library selection menu in the Parts 
palette, or use the New Lib command to create one.

• Select the Circuit to Library command in the Part Type submenu of the Options 
menu.

• Click on the OK button.

Editing a Device Symbol in a Schematic

See “Editing an Existing Part on a Schematic” on page 158.

Creating a Design With One of Each Symbol in a Library

The are a number of cases where it is useful to create a design that contains one of 
each symbol in a library, such as:

• To test a library to ensure that all symbols appear, print and netlist correctly.

• To perform mass modifications on part attributes using the schematic tools such 
as the Browser.  See also “Saving All the Symbols in a Design to a Library” on 
page 154.

To perform this operation, follow these steps:

1 Create a new, empty design using any desired template.

2 Open or select the desired library so that it is the current one displayed in the 
Parts palette.

3 Select the Library to Circuit command in the Part Type submenu of the 
Options menu.

4 Click the OK button.

The Library to Circuit command will proceed to place symbols on the schematic in 
columns based on the sizes of the symbols.  If it runs out of room on the page, it 
automatically creates a new circuit page.  The naming of the devices and display of 
attributes are determined by the template’s settings in the same way as if you had 
placed the parts manually.

Warning: This process can require a large amount of memory.  Because every device in 
the resulting design has a unique symbol definition, a large amount of data is loaded into 
memory while the design is open.

Editing Device Symbols

Symbols are created and edited using the device symbol editor tool.  In addition to 
drawing symbols, the device symbol editor can also be used for general graphics (e.g. 
title blocks or simple mechanical drawings) for use on OptiSPICE Schematics. It 
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provides a complete, object-oriented drawing environment with standard drawing 
tools, as well as specific functions tailored for symbol creation.

Creating a New Part from Scratch—Basic Procedure

To create a new device symbol with no initial attribute settings or graphics, either:

• Select the New command in the File menu, then choose the Device Symbol 
document type, or:

• Right-click in the Parts palette and select the New Part command.

Tip: In many cases, you may wish to start with an existing symbol that has settings similar 
to the one you require, rather than creating a complete new one.

Step 1—Drawing the Graphics

Draw the graphical shape which represents the part.  Do this using the line, rectangle, 
rounded-rectangle, oval/circle, arc, and polygon tools.

Important: Device pins must be added using the pin tools.  Do not draw any of the part's 
pins with the basic graphic tools.

For more detailed information on using the graphical drawing tools, see “Editing 
Symbol Graphics” on page 163.

Step 2—Adding Pins to the Symbol

Place pins on the part using any of the pin placement tools:

This toolbar provides two types of pins:

• The first group allows placement of normal pins (i.e. not bus pins).

• The second group is used to place bus pins, i.e. pins that represent a group of 
named internal signals.
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Note: Since we are creating a discrete component symbol with no text on it, we should first 
disable the pin name display, which is on by default.  To do this click in an unused part of 
the drawing area to make sure nothing is selected, then selected the Properties command 
in the Objects menu.  Select the Pin tab and turn off the Visible switch.

Note that the crossbar portion of the T pin symbol is shown only for alignment 
purposes and indicates where the pin attaches to the body of the symbol.  It is not 
drawn when the symbol appears in a schematic.  Here is what the example symbol 
looks like with the three pin elements placed:

For more background and alternate procedures for pin placement, see “Placing Pins 
on a Symbol” on page 167.

Step 3—Setting Pin Information

Once you have placed the pins on the symbol, you will see that an entry in the pin list 
has been added for each pin.

For this example we want to name the pins “Source”, “Gate”, and “Drain”.  In addition 
we want to give them the following pin number “S”, “G”, and “D”.

Note: Depending on the order in which you placed the pin symbols, they may not be in the 
list in the same order as this example.  You can check the association of names to pins by 
clicking on an item in the list and observing which pin on the drawing is highlighted.

To change the name of a pin:
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1 Double-click on the item in the list.

2 Enter the name, in this case “Source” for example.

3 Press the Enter key to terminate editing.

While this first pin is still highlighted in the list, we can enter its pin number by typing 
it in the Pin Number box.  Enter “S” for this example.  When you click anywhere else, 
you will see the pin number appear in the graphics.

Depending on your application, the Pin Type setting may or may not be significant.  
See “Setting the Pin Type” on page 172 for more information.  In this case, we will 
leave it as the default “input” type.

Set the pin name and number for the other pins in a similar fashion.

The actual names given to the pins in this simple form of part are not critical.  It is a 
good idea though to use meaningful names for these reasons:

• These names will be seen in the Schematic tool's pin properties dialog.

• They can be extracted in netlist output.

• They are used when binding pins to ports in subcircuits.

• In the case of bus internal pins, they are used when connecting bus pins on the 
part to busses.

Step 4—Saving the Part

To save the part to a library:

1 Select the Save As item in the File menu.

2 Enter the name for the part.  This is the name that will appear in the Parts 
palette.

3 Choose the desired destination library.

4 Click Save.

Important: The procedure given here allows you to produce a symbol with only the 
simplest graphical and netlisting requirements.  Details of creating the symbol and the 
various settings that may be required for specific applications are covered in later sections 
157



 DEVICE SYMBOLS AND LIBRARIES
of this manual, and in other chapters on specific OptiSPICE Schematics functions:  You 
may wish to refer to any of the following sections:

• A simple procedure for creating simple schematic symbols and hierarchy blocks 
is given in the tutorial section entitled “Device Symbol Editing and Hierarchical 
Design” on page 21.

• For details on the drawing tools available for creating symbols, see “Drawing the 
Graphics and Placing Pins on the Subcircuit Symbol” on page 175.

• For information on the general entry of part and pin attributes, see “Setting Part 
and Pin Attributes” on page 162.

• For pin settings and how they may affect simulation or netlists, see “Step 3—
Setting Pin Information” on page 156..

• For information on creating pseudo-device symbols, see “Creating a Port 
Connector” on page 179 and the sections that follow it.

Editing an Existing Part in a Library

To edit an existing part in a library:

1 Right-click on the desired item in the Parts palette, then select “Edit Part” from 
the pop-up menu.

In response to either of these operations, a copy of the symbol definition is loaded into 
a device symbol editor window.  No changes to the source library will be made until 
you save the symbol back to its original library.

Note: Editing a symbol in a library does not automatically update designs that have used 
that symbol.  For more information, see “Designs and Libraries” on page 144.

Editing an Existing Part on a Schematic

To edit the symbol of a device that is already placed in a schematic without modifying 
the library it came from, right-click on the device and select the Edit Symbol 
command.  This actually saves the symbol to a temporary library, and then opens it in 
the symbol editor.  You can then make any desired changes to the symbol and close 
the editor.  At that point, you will be asked to confirm that you wish to replace the 
original symbol, and, if applicable, any others of the same type in the schematic.

If the symbol on the schematic has been rotated from the orientation it was originally 
drawn in, this command will display an option to use either the original orientation or 
the new one.

Note: This process is similar to using the Update from Lib command to update an existing 
device instance from an updated library and has many of the same options.  See “Updating 
a Symbol from a Library” on page 150.

Closing the Device Symbol Editor Window

An open device symbol editor window can be closed by either clicking in the close box 
at the upper left corner or selecting the Close command in the File menu.  If any 
changes have been made to the open part, you will be prompted to save or discard 
the changes.
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Saving an Edited Part Back to its Original Library

The Save command saves the contents of the current window back to the library it 
was read from.  If the open part was not read from a library (i.e. it was just created), 
this item will be disabled.

Saving the Part Under a New Name

To save an open symbol under a new name, or to a library other than the one from 
which it was read, select the Save As command in the File menu.

When you select this menu item, the “Save As” dialog will appear.  It requires that a 
library name be selected from the list and that a name for the part be entered in the 
lower box.  In this example the Connectors library has been selected and the part's 
name has been left to default to “Part1”.  A name entered will become the name of the 
part in the library, and the title of the window will be updated to correspond to the new 
part name.

Only open libraries appear in the list.  You can use the New Lib and Open Lib buttons 
on this box to create a new, empty library, or open any other existing library to 
complete the save.

Warning: We do not recommend saving your own parts in the standard libraries provided 
with OptiSPICE Schematics, although the program will not prevent you from doing so.  
When installing future program upgrades, these libraries may be replaced automatically, 
erasing any changes you have made!

Zooming the Symbol Editor Window

The Reduce/Enlarge/Normal Size commands in the View menu allow you to adjust 
the scale at which an object is viewed.  The default setting for the device symbol editor 
is to display objects at the same size as they will appear in the schematic at Normal 
Size.

There is also a Magnifying Glass tool  in the toolbar which allows you to select 
an area of the symbol to zoom in on.

Adding Sequential Pin Names

The basic procedure for adding pins to a symbol is described in “Step 2—Adding Pins 
to the Symbol” on page 155.  However, the basic procedure requires that the pin 
name and number be entered manually for each pin, which can be rather tedious for 
large numbers of sequentially numbered pins.  To solve this problem, the Add Pins 
command allows you to enter a sequence of names in a format similar to that used 
for bus breakout creation and for the Auto Create Symbol command.  These pins are 
added to the pin list, but not placed on the symbol.  After the pins have been added 
to the pin list, you can place the pins sequentially on the graphic with no further typing 
required.

Tip: You can use the Auto Create Symbol command to specify the pin names and auto-
generate a rectangular symbol in one operation.  See “Automatically Creating Symbols” on 
page 176 for more information.
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The Add Pins command displays the following box:

Pin names, and optionally their pin numbers, may be entered into the box.  The pins 
are created and merged with the contents of the pin list when a carriage return or 
enter key is pressed or when the Add button is clicked.  The Add Pins palette does 
not create graphic pins, only pins for the pin list.

The created pins are merged with the names in the pin list.  If a like named pin already 
exists in the list then it may be reordered to appear in the same order as in the Add 
Pins palette.  If a pin being added has a pin number defined then this pin number will 
replace the pin number in the like named pin.

Syntax for Pin Names in Add Pins

Here are the rules for how a list of pin names is entered:

• Pin names may be up to 16 characters long.

• Normal pin names (that is, not bus pins or bus internal pins) may be specified as 
individual names, e.g.: A B C D, or as sequences, e.g.: A0..3.  After each pin 
name or pin name sequence an optional pin number specification is allowed.

• A pin number specification defines the pin number(s) associated with the 
proceeding pin name or pin name sequence.  The specification starts with an ( 
and ends with an ).  For a single pin name the pin number specification should 
contain a single number.  For a pin name sequence multiple numbers and 
sequences may appear between the brackets.

• In the picture above CLK and OE both define normal pin names which have pin 
numbers 10 and 17, respectfully.  The sequence A0..7 defines the pin names A0 
through A7.  These pin names were also given pin numbers.  The pin numbers 1 
2 3 4 11 12 13 and 14 were assigned.

• It is also possible to skip a pin name when assigning pin numbers to a pin name 
sequence.  Consider the previous example, if we didn't want to assign the number 
11 but wanted all other pin names to get the same number, we would do the 
following: A0..7(1..4,,12..14) instead of A0..7(1..4 11..14).  Two commas in a row 
causes a pin to be skipped when assigning the pin numbers. Three commas 
cause two pins to be skipped.  Four commas, etc.
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• Bus pin names are denoted by a name followed by [...].  Bus pins do not need to 
have internal pin names defined and may not have pin numbers.

• Bus internal pin names must appear between a [ and a ].  They have the same 
format as normal pin names and may have pin numbers.  Internal pin names may 
be added without adding a bus name pin by not placing a bus name in front of the 
[].  For example, [A B C] adds the internal pin names “A”, “B”, and “C” to the pin 
list.

• The pin function (input, output, etc.) can be specified by placing a "|" character 
followed by a letter denoting the type.  All following pins will have the specified 
type until another "|" specification is found.  The allowable pin type characters are:

For example:

|I CLK,,D0..7 |O Q0..7

Deleting Pins

In a device symbol editor window, pins exist both in the graphic representation of the 
symbol and in the pin list.  They have to be deleted from both places before they are 
completely removed from the part definition.

To remove a graphical pin from the symbol, simply select it by clicking on it and delete 
it with the delete key in the usual way.  Note that this does not remove the 
corresponding entry from the pin list.  If you wish to replace the pin, for example to 
use a different orientation, you can simply select the item in the list and place the 
appropriate pin graphic from the palette.

To remove the selected pins in the pin list and their associated graphic pins:

I Input

O Output

3 3-state output

B Bidirectional

C Open collector

E Open emitter

L Low

H High

N No connection

P Power

D Driver

A Analog
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1 Select the pin or pins in the pin list that you wish to delete.  You can select 
more pins by holding the M or c keys while clicking in the list.

2 Hit the Delete key on the keyboard.  It will display a confirmation box before 
proceeding to delete the pin entries.

Setting Part and Pin Attributes

To edit the attributes associated with a part select the Part Attributes command in the 
Options menu.  To edit the attributes associated with a pin, select a pin in the pin list 
and then select the Pin Attributes command from the Options menu.  The only visible 
difference between the part attribute dialog and the pin attribute dialog is the addition 
of “Next” and “Previous” buttons at the bottom of the window.

Attributes defined while in the device symbol editor will be associated with the part in 
the library.  These will become the default attributes for the part when it is placed in a 
circuit.

Important: Only attribute fields that have a value are stored with the symbol.  When you 
save the symbol to a library, any fields with null values are stripped off to save storage.  
This has the side effect that you cannot create a “place holder” field definition in a symbol 
for future use without putting a value in it. 

:

Always Visible This setting indicates that the select field should always 
be made visible on the schematic when the device is 
placed, regardless of the visibility setting for this field in 
the target design.  This setting does not prevent the field 
from being removed after the device is placed, it just sets 
the initial state.
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Tip: You can set the default visibility independently for each attribute field defined in a 
design.  This is done by selecting the Define Attribute Fields command in the Options menu 
and setting the “Visible by default” option as desired for each field.

For more information on how to create and modify attributes see “Operations that 
simply copy the symbol definition intact, such as the Copy button in the Library 
Maintenance box, do not change the date stamp.” on page 182.

Editing Symbol Graphics

Using the Drawing Tools

The 8 items in the top half of the toolbar represent standard drawing tools.

Default Visibility This setting indicates that we wish to make the field visible 
only if it is defined as Visible by Default in the design in 
which it is placed.

Never Visible This indicates that the field value should not be displayed 
when the device is placed, regardless of the design's 
Visible by Default setting for this field.  This does not 
prevent the value from being displayed later, it just sets 
the initial state.

Attribute Field Definitions in Symbols and Designs

In OptiSPICE Schematics, symbol definitions are completely independent of 
any particular design or library file.  For this reason, symbols carry around 
their own definitions of the attribute fields that are associated with them.  By 
default, when you create a new symbol, you see the attribute definitions for 
the design that is currently open, or a default set if no design is open.   
However, the New Field button in the Part Attributes box allows you to add 
new field definitions that affect only this one part definition.  This operation 
does not automatically add the same field to the current design.

When you place a symbol in a design for the first time, the program compares 
the attribute fields defined in the symbol to those defined in the design's 
symbol table.  If there are any new fields in the symbol, you will be asked if 
you wish to add them to the design's table.  Your choices in this case are to 
either:

• Click the OK button and allow the program to automatically add the field 
definitions to the design's attribute table.  The program will attempt to 
make reasonable settings for the maximum length, default visibility and 
other settings, based on the current value, or,

• You can click Cancel to stop the device placement and add the fields 
manually to the design's table using the Define Attribute Fields 
command.  In general, this is preferred, since it gives you more control 
over the option settings for the field.
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Drawing Lines, Rectangles, Circles, Etc.

The shape tools in the toolbar, and the corresponding commands in the Tools menu, 
are used to draw standard graphic objects.  Here are some notes on the usage of 
these tools:

• Once an item is drawn, it can be repositioned or resized by using the selection 
pointer tool and clicking and dragging on the “handles” at the ends of the object.

• While drawing or adjusting an object, you can use two keys on the keyboard to 
change the way the object is positioned:

• Holding the Shift key down forces the object to be vertical, horizontal, or the 
same on both axes.  In other words, if you are drawing a rectangle, it will be 
forced to a square shape, an ellipse will be forced to a circle, and a line will 
be forced to vertical, horizontal or 45 degrees, whichever is closest to the 
current position.

• Holding the c key down, disables the Snap to Grid option, if it is currently on.  
This allows you to micro-position graphic items without reference to the grid.

• The arrow keys on the keyboard can be used to “nudge” selected objects slightly 
in any direction to achieve finer positioning than is possible with the mouse.

• Holding the Shift key down while using the arrow keys, adjusts the size of an 
object in one-screen-dot increments.

Setting Line Width, Line Color and Fill Color

The Line Width, Line Color and Fill Color commands in the Objects menu allow you 
to control these visible characteristics of any group of selected objects.  If there are 
selected objects when an item is changed, then the selected objects will be given the 
new characteristic.  If there are no graphical objects selected when a change is made, 
the default setting is changed and graphical objects created in the future will use the 
new default setting.

Drawing Arcs

Arcs are drawn in a manner similar to the other graphical objects, except that an 
additional command is available to control the start and stop angles of the arc.  In a 
manner similar to the other object property commands, you can either select an 
existing arc and then use the Properties command to change its characteristics, or 
you can select Properties first to set the default settings and then draw the arc with 
the arc tool.
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Drawing Rounded Rectangles

Rounded rectangles are drawn in a manner similar to the other graphical objects, 
except that an additional command is available to control the radius of the rounded 
corners.  In a manner similar to the other object property commands, you can either 
select an existing arc and then use the Properties command to change its 
characteristics, or you can select Properties first to set the default settings and then 
draw the item with the rounded rectangle tool.

Drawing Text

To draw text items:

1 Click on the text tool (A) in the toolbar.

2 Click in the desired starting location in the drawing area.

3 Type the text on the keyboard.

4 Click anywhere outside the text box to terminate entry.

5 If you want to change the font or size settings, switch to the pointer tool and 
select the text item.  Then choose the Text Font command in the Objects 
menu, or select any of the available rotation options in the Text Rotation 
submenu.

Reordering Graphical Objects Front-To-Back

The Bring To Front and Send To Back commands are used to set the front-to-back 
ordering of the selected objects relative to the other graphic objects.

Grouping Graphical Objects

The Group and Ungroup commands allow you to make multiple graphic objects, 
except pins, be treated as a single object or visa versa.

Aligning Graphical Objects

The Align sub-menu allows you to pick how the selected objects will be aligned.  For 
example, Align Left causes all of the selected objects to be moved such that their left 
edges are aligned with the left most selected object's left edge.

Rotating and Flipping Graphical Objects

Any object or group of objects can be rotated 90 degrees or flipped on either axis by 
one of these methods:

• Click on the object to select it, then select the desired command from the 
Rotate/Flip submenu in the Objects menu.

• Right-click on the object and select the desired command from the Rotate/Flip 
submenu.

Setting Grids

The Grids command allows you to specify the visible grid spacing and the snap-to 
grids for objects drawn using the drawing tools.
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Display Grid Checkbox This check box determines whether visible 
grid lines are shown in the drawing 
workspace of the symbol editor window.  The 
spacing between these grid lines is 
determined by the value in the “Grid Spacing” 
field.

Snap On Checkbox This check box determines whether the 
corners of objects made with the drawing 
tools are moved to the nearest snap-to grid 
point.

Grid Spacing This number determines the spacing 
between the visible grid lines.  The units are 
in screen dots at the default zoom level.

Snap Spacing This number determines the spacing 
between snap-to points for the drawing tools 
(not including pins).  This does not affect 
objects that have already been placed.  The 
units are in screen dots at the default zoom 
level.

Pin Snap Spacing This number determines the snap-to grid for 
device pins.  This must be a multiple of 5 to 
meet the OptiSPICE Schematics pin grid 
requirements.  The units are in screen dots at 
the default zoom level.
166



 DEVICE SYMBOLS AND LIBRARIES
Placing Pins on a Symbol

The toolbar contains the tools needed to place connection pins on the symbol.

• The first group of pin tools is used to create normal pins (i.e. not bus pins) on the 
part in any of the four orientations.

• The second group of pins are used to place bus pins on the part in any of the four 
orientations.  Bus pins are described in more detail in “Placing a Bus Pin” on 
page 170.

Tip: You can also place pins or groups of pins from the Symbol Gallery window.  If you have 
special types of pin graphics or groupings of multiple pins that you use often, you can place 
these in the Symbol Gallery for quick access.  See “Adding Elements to the Symbol 
Gallery” on page 171 for more information.

 When placing pins, a graphical pin is associated with a name in the pin list.  The 
association is made by applying the following rules and using the first one that 
matches.

• Associate a selected pin name in the pin list which is unplaced and is of the same 
type.  I.e.: normal pins can't be associated with bus pin names or internal bus pin 
names.

• Associate an unplaced pin name of the correct type which follows the first 
selected pin name.  Pin names are examined in a cyclic order so if the bottom of 
the pin list is reached the search continues from the beginning.

• If no association is made then a new pin name of the correct type is created and 
added to the bottom of the list.

Showing, Hiding, Editing or Moving a Pin’s Name

By default, when you place a pin on the symbol, the name of the pin is included in the 
symbol adjacent to the pin graphic.  Here are a number of ways of changing this name 
display:

• To show or hide the pin name on one or more pins, select the pins on the symbol 
or in the pin list, then select the Properties command in the Objects menu.  On 
the Pins tab, turn the Visible switch on or off as desired.  Alternatively, you can 
right-click on a single pin and check or uncheck the Show Pin Name command.

• You can change the default name visibility and text font so that you can place a 
number of pins in a row with the same settings.  To do this, click in an unused area 
of the drawing window to deselect all graphic objects.  Next, select the Properties 
command in the Objects menu and click on the Pin tab.  Turn the Visible switch 
on or off or use the Text Font button as desired.  Future pins will then use this 
setting until it is changed. 
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The Symbol Editor’s Pin List

The pin list box contains a scrollable list of the pin names associated with this device.  This 
list is derived from the following sources:

n If the symbol was opened from an existing part, then the initial name list will be the
pin names associated with the part.

n If a pin tool is clicked in the drawing workspace, a new name may be added with
the form “PINxx” where xx is a sequential number.  This is only done if there were
no unplaced pins in the list.

n If an open OptiSPICE Schematics circuit is selected as an internal circuit, or a
saved OptiSPICE Schematics circuit is selected as an external circuit, then the
names of the port connectors in the circuit will be merged with the names in the pin
list.

n The Add Pins command (page 159) can be used to create a list of pins to be merged
with the pin names in the pin list.  

n The Auto Create Symbol command (page 176) can be used to specify all the pin
names and pin numbers for a device symbol.

When the automatic “show pin name” feature is used, the pin name that appears in the pin 
list must be exactly the same as the graphical annotation which appears next to the pin in 
the part's symbol.  The result is that changing a pin name in the pin list will cause the anno-
tation next to a graphical pin to automatically change.  For cases where it is necessary to 
show a pin annotation that is different from the pin’s logical name, you can hide the auto-
matic pin name and use a normal text object to add any desired label.  See “Showing, Hid-
ing, Editing or Moving a Pin’s Name” on page 167.

Any pin that has been NOT been placed (i.e. it has no corresponding graphical pin object 
which appears as part the symbol) will be shown in red in the list.  Bus pins are marked in 
the list with a bolder pin icon and will be followed by their internal pins.

Bus Internal Pins

Bus Pins

Normal Pins
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• To move a displayed pin name relative to its pin, you must first “unlink” it from the 
pin by right-clicking on the pin and selecting the Unlink Name command.  This 
converts the label to a normal text object which can be moved and set as desired.  
You then “link” it back to the pin by right-clicking on the text item and selecting the 
Link to Pin command.  This associates it with the pin so that it again follows the 
pin when moved.  IMPORTANT: The Link to Pin command searches for a pin with 
exactly the same name as the given text.  You cannot link an arbitrary text item to 
any pin.

Note: There is no rule that says you have to use the “Show Pin Name” feature to display 
pin names on the symbol.  This is a convenient way of labelling pins, but does restrict the 
label to be exactly the same as the logical pin name.  If you wish to use normal text objects 
to create pin notations, you can certainly do that, but you will then be responsible for 
keeping everything aligned if you move the pins.

• To edit a pin’s name or function, right-click on the pin on the symbol and select 
the Properties command.  Use the settings on the Pin tab to change the pin name 
and function.  Alternatively, you can modify a pin’s name by double-clicking on it 
in the pin list.  See “Setting the Pin Name” on page 171 for more information on 
name usage and restrictions.

Setting the Default Pin Name Prefix

By default, when a new pin is added to the symbol, it is named PINx, where x is a 
number that will be incremented automatically.  For bus pins, the default prefix is BUS.  
There are a couple of ways of controlling this name prefix:

• The default name used for new pins can be set in the initialization file. 

• When pins are added from the Symbol Gallery, the existing name of the pin (i.e. 
the name it was stored with) is used as the prefix when creating a new name.  See 
“Using Elements from the Symbol Gallery” on page 171 for more information.

If a placed pin (i.e.: it is shown with a black icon next to its name) is 
selected then both the pin and the graphical name will be selected.  
The opposite is also true.  If a graphical pin is selected the associated 
item in the pin list will be highlighted as well.  Internal pin names 
never have graphical associations, therefore selecting an internal pin 
name never selects a graphical pin.

The relationship between pin names in the pin list and graphical pins 
is not symmetrical.  Every graphical pin must have a pin name, but 
every pin name does not necessarily have an associated graphical 
pin.  This can lead to some surprises.  For example,

• Selecting all graphical pins in the drawing workspace may not 
select all pin names: unplaced and internal pin names will not be 
selected.

• Deselecting all graphical pins in the drawing workspace may not 
deselect all pin names.  Additional unplaced or internal names 
may have been initially selected.
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Placing a Bus Pin

Bus pins allow busses to be connected to the part.  A bus pin's functionality is 
determined by the internal pins it contains.  These can be specified when the symbol 
is created, or modified later on the schematic using the 

To add a bus pin to a symbol you need to perform two steps:

1 Use the Add Pins command to add the bus pin to the pin list and specify its 
bus internal pins.  This command is described in “Adding Sequential Pin 
Names” on page 159.

2 Place the graphical bus pin using the techniques described in “Placing Pins 
on a Symbol” on page 167.

Saving Frequently-Used Graphics and Pins

The Symbol Editor has a special graphics palette, called the Symbol Gallery, that can 
be used to save frequently used graphic elements, customized pin types, and groups 
of elements for future use.  For example, if you frequently need to add pins to a symbol 
with special graphics indicating the function of the pin, you can add one complete 
group to the Symbol Gallery and then simply drag and drop it into future symbols 
when needed.

Displaying the Symbol Gallery Window

To display the Symbol Gallery panel, select the Symbol Gallery item in the View menu.

Hiding the Symbol Gallery Window

To hide the Symbol Gallery panel, select the Symbol Gallery item in the View menu to 
uncheck it, or click the X “go away” box in the upper right corner of the panel.
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Using Elements from the Symbol Gallery

To add an item displayed in the Symbol Gallery list to the symbol editing window, 
simply drag and drop it at the desired location.  Here are some additional notes on this 
operation:

• The complete item dragged from the list will be added to the current symbol as a 
grouped graphic item.  If you then wish to edit the individual elements of the new 
item, you can right-click on it and select the Ungroup command.

• The placed item can be rotated to a new orientation by right-clicking on the item 
and choosing one of the Rotate or Flip commands.

• If the placed item contains one or more pins, these will be added to the pin list or 
matched with existing, unplaced items in the list.  The program attempts to use 
the name that was assigned to the pin when it was added to the element, but will 
add or increment a numeric portion of the name in order to create a unique name.

Adding Elements to the Symbol Gallery

The Symbol Gallery is simply a normal symbol library file which is selected to have its 
contents displayed in the Symbol Gallery list.  Thus, all the usual methods for creating, 
editing and updating symbols can be used on items in the library.

The Symbol Gallery file is not normally open by default, so it must be explicitly opened 
before you can save items to it or edit it.  To open this file, right-click in the parts list 
and select the Open Lib command.  Use the file open box to select the Symbol Gallery 
file.

In a default OptiSPICE Schematics installation, this file is called “symbol_gallery.clf” 
and is located inside a folder called Data Files inside the OptiSPICE Schematics 
program folder.  If the OptiSPICE Schematics initialization file has been modified to 
specify a different file, you will have to locate that file. 

Specifying a Symbol Gallery File

The source of the items in the Symbol Gallery list is a single, standard OptiSPICE 
Schematics library file that is specified in the INI file. 

Entering Pin Information

Selecting Items in the Pin List

Clicking on an item in the pin list selects that item and the associated graphic in the 
drawing area, if any.  The Shift key on the keyboard can be used to add to an existing 
selection, in the usual way.

Setting the Pin Name

To set a pin name:
171



 DEVICE SYMBOLS AND LIBRARIES
1 Double-click on the pin in the pin list.

2 Type the new name.

3 Press Enter to finish name entry.

Here are the rules for pin names:

• Names are limited to 16 characters.

• Pin names must be unique within a part, except for bus internal pins.  Bus internal 
pins only need to be unique within their own bus.

• The program does not restrict what characters can be used in pin names, but we 
recommend using only alphanumeric characters and a limited set of punctuation 
characters unless you have some particular reason to use other symbols.

Tip: You can also set the pin name, number and function by right-clicking on the pin 
graphic or on the name in the list and selecting the Properties command.

Setting the Pin Number

A four character identifier is displayed in the pin number field.  Even though this is 
referred to as a number it may contain any valid character.  For example, “10”, “Q4”, 
“E123”, and “In” are all valid pin numbers.  The value entered for the number is 
displayed on the stem of a pin.

Setting the Pin Type

The pin type (e.g. input, output, etc.) is selected using the Pin Function pop-up menu.  
The pop-up will only be displayed for pins of type “Normal” or “Bus Internal”.  Pins of 
type “Bus” do not have their own type.

Using the pop-up menu the following functions may be assigned to the pin: Input, 
Output, Tristate, Bidirectional, Open Collector, Open Emitter, Tied High, Tied Low, 
Latched Input, Latched Output, Clocked Input, Clocked Output, Clock Input, and No 
Connect.

You can apply a new pin type setting to any number of selected pins.  If more then 
one pin is selected in the pin list then the function pop-up menu will show a current 
value only if all selected items are the same.  In any case, selecting a new setting will 
affect all selected pins.

Displaying the Pin Name

To automatically display the name of a pin next to the pin graphic, you can either:

• Select the pin and choose the Properties command, then check or uncheck the 
Visible box, as desired.

• Right-click on the pin and check or uncheck the Show Pin Name command, as 
desired.

See “Showing, Hiding, Editing or Moving a Pin’s Name” on page 167 for more 
information.
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Reordering Pins in the Pin List

Pins can be reordered in the list by simply clicking and dragging them to the desired 
new position.  This pin order does not affect the graphical appearance of the symbol, 
but may affect netlists generated from schematics containing the symbol. The netlist 
format depends upon the device pin order matching the order expected by the target 
simulator.

Creating a Part With a Subcircuit

This section describes how to associate a hierarchical subcircuit definition with a part 
stored in a library.  This is useful if the subcircuit definition will be relatively unchanging 
and is likely to be used in a number of different designs.

It is also possible to associate a subcircuit with a device after it has been placed on 
the schematic.

Creating the Port Interface

A part's subcircuit is a schematic circuit which is associated with the part such that it 
is considered to be the part contents.  A circuit which is to be used as a subcircuit must 
include parts called port connectors.  Port connectors, which are named, allow signals 
in the circuit to be associated with pins on an enclosing part.  Port connectors make 
this association by name, i.e.: a port connector named “A0” will only associate with a 
pin with the same name.

Selecting the Subcircuit

The easiest method to create a part with an associated subcircuit is to begin by 
selecting the schematic circuit to be used as the subcircuit.

To select the circuit to be used as the part's subcircuit you must also define the type 
of part being made.  Select the Subcircuit and Part Type command from the Options 
menu.
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This dialog allows you to select among several different options:

Create a subcircuit 
symbol, but don't store a 
circuit with it yet

This is the default.  It indicates that the part 
being made has no associated subcircuit, 
but it doesn't rule out that a subcircuit may 
be attached by the schematic capture 
section of OptiSPICE Schematics.

Import the port list from 
an open circuit, but don't 
attached the circuit.

This is similar to the No Subcircuit option.  
No subcircuit becomes associated with the 
part, but a port interface is extracted from a 
circuit for use with the part.  Selecting this 
option prompts you to pick an open 
schematic circuit.  The port names are read 
from the circuit without attaching the circuit 
to the part.  Like the above option, this 
doesn't stop a subcircuit from being 
attached later.  Since a subcircuit wasn't 
attached to the part, the port interface is 
only associated with the part for the length 
of the editing session.

Create a subcircuit 
symbol and select an 
open circuit to attach to it.

This option prompts for an open circuit to 
associate with the part being created as its 
subcircuit.  The circuit definition is saved 
with the part in the library.  This operation 
also imports the circuit's port interface so 
that the names of the ports appear in the list 
and you can place the corresponding 
graphical pins on the symbol.
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There are some subcircuit options in the lower part of the dialog:

Drawing the Graphics and Placing Pins on the Subcircuit Symbol

The graphic image of the part may be drawn and the pins placed on it in the same way 
as was described in “Editing Device Symbols” on page 154.

You can also generate a symbol automatically using the Auto Create Symbol 
command.  See the section Auto Creating a Symbol.

Opening the Subcircuit Associated with a Symbol

If the symbol currently being edited has a subcircuit already stored with it in the library, 
you can use the Open Subcircuit command in the Options menu to open it for editing.  
This opens the subcircuit in a design window as if it was an independent design.

Important: Modifying and saving the design that was opened with this command DOES 
NOT automatically update the symbol or the library it was read from.  If you wish to update 
the symbol, you must use the Subcircuit and Part Type command and use the “Create a 
subcircuit symbol and select an open circuit to attach to it” option to reattach the modified 
circuit to the symbol.

Set to Symbol Only type, 
never has a subcircuit.

This option is like the No Subcircuit option 
except its doesn't allow the schematic 
capture part of OptiSPICE Schematics to 
associate a subcircuit with the part in the 
future.

Delete existing pins 
before adding pins 
defined in subcircuit

This option is only enabled when the 
selection made above results in a port 
interface being imported.  If this box is 
checked, when the “Done” button is pressed 
all of the old pins in the pin list will be 
deleted.  This allows a new port interface to 
be brought in without any conflicts with the 
existing pin list.  If this option wasn't checked 
then port names would be merged with the 
names in the list.  Duplicate pin names and 
their related properties remain unchanged, 
except they are now associated with the 
new port.  Unmatched pin names in the pin 
list remain exactly the same.

Lock subcircuit by default 
so the subcircuit can't be 
opened

This option has the effect of saying, “Yes.  
There is a subcircuit, but in general you don't 
want to go into it”.  This causes the 
schematic capture part of OptiSPICE 
Schematics to prompt to make sure it is 
really OK to enter the subcircuit before doing 
so.

Locate a new subcircuit 
definition

This button allows you to replace the 
subcircuit in a symbol that already has a 
circuit associated with it.
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Automatically Creating Symbols

The Auto Create Symbol command in the device symbol editor tool will generate a 
standard, rectangular symbol given a list of names for the pins on each side of the 
symbol.

Auto-creating Rectangular Symbols

The Auto Create Symbol command will create standard rectangular symbols given a 
list of the desired input and output pin names.  For maximum flexibility, the symbol 
generated consists of separate graphic objects and is completely editable after it is 
generated.

The current settings for line width, fill patterns, color, text font, size and style, etc. are 
used in generating the symbol.  The only exception to this is the type name text placed 
in the center of the symbol, which is written 3 points larger than the current setting and 
in bold.

Selecting the Auto Create Symbol command displays this box:

The pin name boxes will contain the information entered the last time the device 
symbol editor was invoked for this part.  These can be modified as desired.  The new 
settings will be merged with pin list when the Generate button is pressed.

Entering Pin Names

The four pin name boxes allow you to specify the names of pins to appear on the left, 
right, top and bottom of the device symbol. Here are the rules for how a list of pin 
names is entered:

• Pin names may be up to 32 characters long.

• Pins are specified bottom to top.
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• Since spaces are used to separate names, it is not possible to specify names 
containing spaces with this command

• Normal pin names (that is, not bus pins or bus internal pins) may be specified as 
individual names, e.g.: A B C D, or as sequences, e.g.: A0..3.

• After each pin name or pin name sequence an optional pin number specification 
is allowed.

• A pin number specification defines the pin number(s) associated with the 
preceeding pin name or pin name sequence.  The specification starts with an 
opening parenthesis “(” and ends with a closing parenthesis “)”.  For a single pin 
name the pin number specification should contain a single number.  For a pin 
name sequence multiple numbers and sequences may appear between the 
brackets.

• Bus pin names are denoted by a name followed by “[...]”.  Bus pins do not need 
to have internal pin names defined and may not have pin numbers.

• Bus internal pin names must appear between a [ and a ].  They have the same 
format as normal pin names and may have pin numbers.  Internal pin names may 
be added without adding a bus name pin by not placing a bus name in front of the 
[].  For example, [A B C] adds the internal pin names A, B, and C to the pin list.

• The pin type can be specified by placing a "|” character followed by a letter 
denoting the type.  All following pins will have the specified type until another "|” 
specification is found.  The allowable pin type characters are:

• Items in a list can be separated by blanks or commas.  Placing an extra commas 
between two items adds extra space between the pins on the symbol.  A single 
comma is ignored (i.e. it serves just to separate the items), 2 commas inserts one 
extra grid space, etc.  Additional space can be added with more commas.

I input

O output

3 3-state output

B bidirectional

C open collector

E open emitter

L low

H high

N no connection

P power

D driver

A analog
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Auto Create Pin List Examples

Here are some examples applying the rules discussed above:

Entering the Symbol Name

The symbol name text box allows you to specify the text that will appear centered at 
the top of the symbol.  This also becomes the new name for the part.

A B C D Adds 4 input pins A, B, C and D

D0..7 Adds 8 input pins D0, D1, D2 ... 
D7

D7..0 Adds 8 input pins D7, D6, D5 ... 
D0

|O Q0..7 Adds 8 output pins Q0, Q1, Q2 ... 
Q7

|B DATA[D0..31] Adds a bus pin with 32 internal 
pins of type bidirectional

CLK,,,D0..7 Adds a single pin called CLK, then 
some space, then 8 pins D0 to D7
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Generating the Symbol

The Generate button causes the current contents of the active drawing window to be 
erased and replaced by the generated symbol.  The pin list will be merged with the 
new pins described in the dialog.  This symbol consists of standard graphic objects so 
it can be edited using any of the drawing tools provided.

An example of a device produced by the Auto Create Symbol:

Using Pins Already in the List

The Extract Pin List button updates the pin name boxes with the names extracted 
from the main pin list.  Pins which are inputs and busses are placed on the left, outputs 
are placed on the right.  This is typically used when you are creating a symbol for 
subcircuit and the pin list has already been defined by importing it from the circuit 
definition.

Creating a Breakout

A breakout is a special device that allows signals to be associated with a bus.  It 
consists of 1 Bus pin, no internal pins, and N normal pins.  Because the device type 
is breakout the normal pins will be connected to like named signals in the bus.

Creating a Port Connector

Port connectors have the property of associating a signal or bus with a pin on an 
enclosing part.  The association is made by name.  The port's Name is compared to 
the pin names on the parent part.  Internal pins in busses are matched by pin name.
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Creating a Signal Port Connector

A port connector for a signal must have a pin which is of the correct type to interface 
the signal to the parent part's pin.  For example, an input pin on the port connector 
would be correct to connect to a output pin on the parent part.  The name of the port 
connector pin is not important.  Only the name assigned to the port connector once it 
is placed is important; it must be the same as the parents pin.

Creating a Bus Port Connector

A port connector for a bus must have a bus pin which contains pins of the correct type.  
For example, a bus pin with three internal pins A (input), B (input), and C (output) 
would be correct to connect to a parent part's bus pin which contained pins A (output), 
B (output), C (input).  The name of the port connector bus pin is not important, but the 
internal pins must have the same name.  Once the port connector is placed in a circuit 
its reference name is important, it must be the same as the parent's pin name.

Bus Port Connector Example

For this example, assume that the following simple device has a bus pin called 
CONTROL containing internal pins CLK, MEMW/, and MEMR/.

To create the corresponding Bus Port Connector using the symbol editor, follow these 
steps:

1 Select the New command in the File menu and choose the Device Symbol 
document type.

2 From the Options menu select “Add Pins...”

3 Enter the following string

PORT[CLK MEMW/ MEMR/]

See “Adding Sequential Pin Names” on page 159 for Add Pins syntax for ranges of 
numbered signals, etc.

You should now see a pin list like the following:
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4 For each bus internal pin set the pin function as appropriate, i.e. the opposite 
of the function of the parent pin.  We will assume that the CLK signal is an 
input to the block and that MEMW/ and MEMR/ are outputs:

• Select the first internal pin name from the symbol editor's pin list.  In this 
example it is CLK.

• Use the pin function pop-up menu at the top of the list to select Output for 
the pin function.

• Click on the next pin in the list.
• For the remaining pins MEMW/ and MEMR/ the default value of Input is 

correct since the parent pin is an output. Check that the remaining pins 
are correct.

5 Create a symbol for the connector, perhaps a simple rectangle.

6 Select the bus pin, PORT in the pin name list.

7 Place a bus pin from the device symbol editor's tool palette.

8 Set the primitive type for the device.

• Select “Subcircuit & Part Type...” from the Options menu.
• From the “Subcircuit & Part Type” dialog select “Primitive, Use Caution”

• From the pop-up choose “PORT CONNECTOR”.
• Select “Done”.

9 From the “File” menu choose “Save As...”

10 Choose or create a working library to save the part.

11 Close the device symbol editor window.

12 Place your new Bus Port Connector in your internal circuit.

Note:  The pin name of the bus pin itself (in this case “PORT”) is not important.  The 
association between the Bus Port Connector and the parent bus pin is made by the name 
applied to the Bus Port Connector symbol itself.  I.e. The same Bus Port Connector symbol 
can be used for any bus with the same internal signal names. 

Creating a Page Connector

Page connectors have the property of exporting the signal allowing it to be connected 
to across all pages in a circuit.
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Making a Signal Page Connector

The graphical appearance of a signal page connector is not important.  The only 
characteristics it must have are:

• It must have only a single input pin.  The name of the pin is not important.

• It’s primitive type must be set to Page Connector using the device symbol editor’s 
Subcircuit and Part Type command.

Making a Bus Page Connector

A page connector for a bus is the same as a signal page connector except that is has 
only a single bus pin with no internal pins.

Symbol Date Stamping

Whenever a symbol in a library is modified, an attribute field called 
DateStamp.Symbol is automatically updated with the current time.  Since all attributes 
associated with a symbol are copied into a design when a symbol is used, this can be 
used to determine whether a symbol has been modified since it was used.

The date stamp is stored using the system’s internal integer date format, that is, an 
unsigned integer representing the number of seconds since January 1, 1970.  To 
create a more human-readable date value, the Export tool has date conversion 
functions available.

The following operations cause the DateStamp.Symbol field to be updated in the part 
definition:

• Saving the symbol using a Save or Save As command in the device symbol 
editor.

• Using the Save to Lib command to save a part from a schematic to a library with 
the “Use attributes in selected instance” option turned on.  If this option is off, the 
datestamp is not updated since the part is not being modified.

• Saving parts to a library using the Circuit to Library command.

Operations that simply copy the symbol definition intact, such as the Copy button in 
the Library Maintenance box, do not change the date stamp.
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Design Templates and Customization
This chapter is about how to customize OptiSPICE Schematics to fit your particular 
design application by creating design templates, libraries and making use of other 
customization features.  Customizations can range from small changes to symbol 
libraries or design templates to implementing major new applications using 
OptiSPICE Schematics as a base.

Some of the topics covered here include:

• How to use the design kits supplied with OptiSPICE Schematics

• How to make simple changes to the design kits supplied (such as adding your 
company logo to the sheet templates)

Creating Design Templates

Important: Don’t modify the design templates provided with the package without copying 
them first!  You may wish to return to them later if your application changes.Any design 
template must be derived from the default OptiSPICE template in order to create the netlist 
and run the simulation.

In OptiSPICE Schematics, a design template is simply a normal design file that has 
its sheet size, attribute fields, and other settings pre-defined for the application at 
hand.  The simplest way to create a template may be to take an existing design that 

Design Templates vs. Sheet Templates

This chapter covers two related topics: design templates and sheet 
templates.  Both of these things are standard OptiSPICE Schematics design 
files from which initial setup data is imported, but they have different usages:

• A design template is intended to be used as the source for a New 
command.  When a design template is selected in the New Design box, 
the design template file is opened and all the circuit data and settings it 
contains become the starting point for a new design.  More information 
on this process is given in “Creating Design Templates” on page 183.

•  A sheet template is intended for use with the Import Sheet Info 
command and is used to set only the sheet border, title block, print setup 
and other settings related to the printable sheet.  The Import 
Sheet Info command is covered in “Importing Sheet Settings 
from Another Design, Page or Template” on page 185.

There is no reason why a design template cannot be set up with all the sheet 
settings you need for your design.  This eliminates the need to ever refer to 
a sheet template.  However, sheet templates can be used to apply different 
border styles and settings to different parts of a single design.  In addition, 
separating out the sheet functions can reduce the number of design 
templates you need to have available. 
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is set up the way you like it, delete all the circuit elements and extra pages out of it 
and save it in the appropriate template directory.

When you create a new design using one of the template files listed, OptiSPICE 
Schematics just reads the file in the normal way, then renames it “Design1” (or the 
next available number), and disassociates it from the original file so that it cannot 
accidentally be Saved on top of the template.  In all other respects, New Design is the 
same as doing an Open on the template design.  All the settings and contents of the 
design template file become part of the new design.

Contents of a Design Template

The template should be set up so that the user can just start in placing device symbols 
and signal lines without worrying about whether the border will fit on the printer, the 
netlist will come out OK, etc.  This table defines the items that you may want to include 
or set up in a template file, and gives you a reference to the section in the manual that 
discusses the issue..

Working from an Existing Design Template

If you are modifying an existing template that is used in an application similar to yours, 
here are the minimum things that you need to change:

• If the template has text notes on the schematic, modify them to reflect the new 
usage of the template.

• The template should be saved under a different name that reflects its new usage.

Where Design Templates are Stored

In order to appear in the template list in the New Design box, template files must be 
stored in the folder specified in the Templates keyword in the INI file.  In the standard 
OptiSPICE Schematics installation, this folder is called Templates.

Setting Sheet Sizes and Borders

OptiSPICE Schematics does not have any built-in knowledge of sheet sizes.  Sheet 
border information can either be customized for each design or imported from an 
existing design file or template.  This section describes the methods used for setting 
the sheet size and border for a schematic and the use of various options for adjusting 
the schematic border to the available output device.

Design Kit Issue Where to Look

A title block “Creating a Title Block” on 
page 189

A sheet background, or auto-border settings “Setting Sheet Sizes and 
Borders” on page 184

A printer page setup, possibly with the reduction 
set as needed.  Note that there is a new “Scale 
to Fit” sheet option that allows automatic scaling 
to fit your printer

“Setting Sheet Sizes and 
Borders” on page 184
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About Sheet and Border Settings

OptiSPICE Schematics supports very flexible use of plotters and printers for output 
on a variety of media.  For this reason, there can be complex interactions between the 
drawing area allocated for each page and the way the schematic is presented when 
it is output on various kinds of output devices.  Various settings allow you to:

• Have the schematic border adjust automatically to the current printer page setup.

• Have the schematic border retain a fixed logical size and have the printer scaling 
adjust automatically to fit the schematic on a single sheet.

• Have the schematic border retain a fixed physical size and be broken into the 
required number of printed sheets for output.

The following information is considered to be part of the complete sheet definition:

• The overall height and width of the drawing area.

• The origin and spacing of the location grid.

• The format of text used in the border.

• Whether or not the border size should be linked to the current printer page setup.

• Whether or not the page should auto-expand to multiple sheets.

• Any text and picture objects marked as “border” items.

OptiSPICE Schematics allows sheet size and border layouts to be set by one of two 
methods:

• Importing an existing layout using the Import Sheet Info command.  This is the 
simplest method of setting the sheet size for a new design or template, but it 
assumes you have an existing design that has the desired settings.

• Creating a custom layout using the Sheet Wizard command.  This command, and 
the associated text and picture capabilities, allows all aspects of the sheet size, 
drawing grid, border text style, title blocks and graphics to be set up to meet your 
drawing standards.

Importing Sheet Settings from Another Design, Page or Template

If you have another page in the current circuit, or an existing design or template file 
that has the sheet size and border settings that you want, you can import those 
settings into the current design using the Import Sheet Info command.  This command 
performs this sequence of operations:

• Deletes all text and picture objects marked as “Border” items from the current 
page or design.

• Copies all text and picture objects marked as “Border” items in the source design 
or page into the current design or page.  You can change this setting on any 
number of graphic items at once by selecting the desired items, the right-clicking 
on any one of them and selecting the Properties command

• Copies the sheet and border settings (sheet width, grid settings, border text 
settings, etc.) from the source design or page to the current design or page.

• Optionally copies the printer page setup from the source design to the current 
design.
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Note these important points regarding this operation:

• If the source for the import is a design file, only the items and settings on page 1 
of the source design are imported.  There is no provision for importing different 
settings from multiple pages.

• The import operation does not affect any circuit items or attribute settings in the 
destination design.

Setting Custom Sheet Size using Sheet Wizard

The Sheet Size Wizard command in the Drawing menu gives you full control over the 
size of the drawing area that appears on the screen and how it is printed on the 
available output device.  This section will describe the various options that are 
available.

1 To open the Sheet Wizard, select the Sheet Size Wizard command in the 
Drawing menu.

Selecting Which Pages to Modify

If your design consists of only a single page and no hierarchy levels, the Wizard will 
immediately display the first page of sheet settings and you can skip this section.  If 
your design contains multiple pages or circuit blocks, you will first see this panel:

Settings can be applied to individual pages or to the entire design.

1 If the first panel of the Wizard displays the Page Selection choice, then select 
whether you want to change only the current page or all pages, then click 
Next.  If the selected range contains a variety of settings, you will be warned 
that they will be overridden and you will have to click Next again.

Selecting Fixed or Auto-Scaled Border

OptiSPICE Schematics provides two general types of sheet size settings:

• Scale border to match printer setup—Selecting this option causes the current 
printer setup to be used to determine the sheet size.  Any changes in print setup 
(using the Print Setup command in the File menu) will immediately affect the 
sheet border.  This is the recommended setting for most cases as it provides a 
guaranteed match between the drawing area and your output device.  The only 
disadvantage of using this setting is that the sheet size will change if you change 
printers.  Most printers have slightly different printable areas, even on the same 
size paper.
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• Fixed border size—Selecting this option causes fixed values to be used for the 
border size and position (as it appears on the screen), regardless of printer page 
setup.  The advantage of this setting is that the sheet configuration will remain 
fixed regardless of changing output devices.  The disadvantages are that the 
border size may not fit exactly to the aspect ratio of the printable area on your 
printer.

2 Choose the desired border scaling method and click Next.

Working with Scaled Border Size

Once you have elected to scale the border to match your printer settings, you will be 
presented with these options:

• Single printed page—When this option is selected, the drawing border on the 
screen will always match your current printer page setup.  Any change in printer 
setup will automatically be reflected in the sheet you see on the screen.  This is 
the simplest setting and recommended for most case.

• Auto-expand—This setting also adjusts to match the printer page setup, but 
automatically expands to use multiple pages if you draw outside the current 
border.  This will allow you to assemble larger drawings by piecing together a 
number of smaller sheets.

• Advanced—The Advanced setting is similar to Auto-expand, but allows you to 
specify exactly how many sheets high and wide you want the printed out put to 
appear on, plus it allows an additional scale factor to be applied to shrink or 
expand the output.

Working with Fixed Border Size

When you select the Fixed Border Size option and click Next, you will be presented 
with the sheet size controls:

Using these controls, you can either select one of the standard sheet sizes listed, or 
enter any desired custom size.

Note: These settings only determine the size that the sheet will appear on the screen and 
do not select a corresponding paper size for your printer.  Printer settings must be adjusted 
appropriately using the Print Setup command..

3 Enter the desired sheet size and click Next.

The next step in the Wizard allows you to choose how the page will be adjusted for 
printing.  Since you have specified that you wish the drawing to appear a fixed size on 
the screen, the program needs to know what to do if the visible page does not exactly 
match the printable area available on the paper.  You have two general options:
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• Scale to fit printed page—In this case, OptiSPICE Schematics will scale the 
drawing to fit into the available printed area for the selected printer.  You can use 
the controls to specify that you want the drawing to be stretched onto multiple 
pieces of paper.

• Fixed scale factor—With this setting active, the program will scale the drawing 
by a fixed amount (default 100%) for printing.  This guarantees that the drawing 
will be a known size on paper, but may require that it be broken into multiple 
printed pages, depending on the settings.

Setting Border and Background Grid Settings with the Border Wizard

The Border Wizard command in the Drawing menu allows you to set these 
parameters:

• The size and visibility of the default drawing border.

• The layout of letter and numbers in the reference grid that is used to locate items 
on a sheet.

• The size and visibility of the background grid.

This table summarizes the first page of Border Wizard controls and options:

When you click Next, you will be presented options for the layout of the major grid 
lines that are drawn in the background.  The major grid lines are the darker lines 
drawn in the background.  You can select later how many minor (lighter) grid lines are 
drawn in between the major lines.

Note: Even if you choose not to display the drawing grid, these settings affect how the 
letter/number reference grid is calculated.  This information is used and displayed by 
a number of reports and commands.

Border Orientation These switches determine the usage of letters and 
numbers for sheet grid references.  This setting will 
affect the position displayed on Page Connectors, in 
the Pin List box and in report output.

Show default border on 
screen

This switch determines whether the default sheet 
border is drawn around the drawing area on the 
screen.

Print default border This switch determines whether the default sheet 
border is drawn in printed or PICT file output.

Border Font This button displays the standard text style dialog box 
allowing you to select the text style for the default 
border.  This has no effect if both Print Default Border 
and Draw Default Border are off.

Border Width These switches allow you to specify an exact width for 
the border or have it calculated automatically based 
on the text size setting.

Specify the number of 
grid sections

If you choose this option, you can use the controls to 
specify exactly how many grid sections are displayed.  
The size of the grid sections will be adjusted 
automatically to match any changes in sheet size.
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The last page of border options includes these settings:

Creating a Title Block

OptiSPICE Schematics has a number of features which can assist in creating title 
blocks which will contain information that is automatically updated.:

• Create the graphic on the diagram using the using the built-in drawing tools, or 
paste an externally-created graphic using Paste command.

• Select the graphic and set it to be a background and border object using the 
Properties command.  Once it has been converted to background, it will not be 
selected again (unless you use the Background Layer Only command) and you 
can use text notations to draw on top of it.

• If desired, use the Position settings in the Properties command to fix the position 
of the title block relative to the border. This ensures that if the sheet size is 
changed, the block will stay in the same relative position.

• Use text variables to add dates and titles to the block.

Creating Custom Sheet Border Graphics

Any graphic or text objects can be made part of the sheet border.  To do this:

• select the object.

Specify the size of the 
grid sections

This setting forces the grid sections to be a fixed size, 
regardless of changes in overall sheet size.  In this 
case, the grid section width may not exactly divide 
into the sheet width, so you must also specify how to 
handle any leftover space.

Show background grid 
on screen

If this switch is on, the background grid determined by 
the previous settings is drawn on the screen.

Print background grid This switch determines whether the background grid 
is included in printed or graphics file output.

Number of minor grids 
per major grid

This number determines how many minor grid 
divisions are drawn per major division.  The default 
value is 3, entering 1 in effect disables minor grid 
lines.
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• choose the Properties command in the Options menu.

• enable the “Make Background” and “Make Border” switches.

• click OK.

The object will now be treated as part of the sheet background.

Setting Text Styles

Setting Pin Number Text Style

The text style for pin numbers is set globally for the entire design.  It cannot be set 
individually for pins.

To set pin number text style:

1 Select the Design Preferences command in the Drawing menu.

2 Select the Text tab.

3 Click on the Pin Text button.

4 Select the desired text font, size and style in the style box.

5 Click OK on the text box, then OK on the Design Preferences box.

Depending on the size of the design, there may be a short delay at this point while 
sizes and positions of text items are recalculated.

Setting Attribute Text Style

The text style for attributes is set globally for the entire design.  It cannot be set 
individually for each item or for each field.

To set attribute text style:

1 Select the Design Preferences command in the Drawing menu.

2 Select the Text tab.

3 Click on the Attr Text button.

4 Select the desired text font, size and style in the style box.

5 Click OK on the text box, then OK on the Design Preferences box.

Depending on the size of the design, there may be a short delay at this point while 
sizes and positions of text items are recalculated.

Setting Border Text Style

Text style can be set for the reference letters and numbers appearing in an auto-
generated sheet border.  To do this:
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1 Select the Border Wizard command in the Drawing menu.

2 Depending on the page settings in your design, you may have to click Next 
once or twice until the “Border Font” button appears.

3 Click on the Border Font button.

4 Select the desired text style.

5 Click OK on the text style box, then Next and Finish to complete the Wizard.
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Setting Text Block Text Style

Text style can be set individually for each text block.  To do this:

1 Select the text block by clicking on it.

2 Select the Properties command in the Options menu.

3 Click on the Text Style button.

4 Select the desired text style.

5 Click OK on the text style box, then OK on the text info box.

Creating Multipage Templates

OptiSPICE Schematics allows a circuit to be represented on multiple pages with 
logical connections between pages.  When a new circuit is created, it is assumed to 
have a single page.  A new page is added to the circuit by selecting the Pages 
command in the Drawing menu and clicking on the New Page button.

Sheet Border Setup for Multi-Page Designs

When a new page is added to a circuit, all border information and text and picture 
objects marked as “border” items are copied automatically from the preceding page 
(i.e. what was formerly the last page).  For this reason, it is most convenient to set up 
the first page of the circuit with the desired border arrangement before adding other 
pages.

Borders on all pages in a design can be updated later if needed using the Import 
Sheet Info command.
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Report and Netlist Generation

Introduction to the Export Tool

This chapter provides basic information on using the Export tool for netlisting and 
error checking with existing scripts.  Some information is provided on simple 
modifications to report generation scripts that can be made without an in-depth 
knowledge of the command language.  Detailed information on the script language 
can be found in the OptiSPICE Schematics Export Script Language Reference 
(separate manual on disk).

Note: Many statements about the operation of netlist generation scripts must be 
considered to be generalizations.  Since the script itself is essentially a program that gets 
executed, almost any aspect of its behavior can be altered to suit the application.  If you 
are using one of the scripts supplied with the package, check the notes provided in the 
script for more information (see “Viewing Format Notes” on page 194).

General Information on Export

The Export tool provides powerful and customizable text report generation, error 
checking, back annotation and design analysis capabilities.  The tool works from a 
script defined in a text command language which allows you to read data from the 
design and from external text files, and to generate text data out to files and back into 
the design itself.  OptiSPICE Schematics includes a number of scripts for generating 
common industry netlist formats and bills of materials, and performing error checking 
tasks.  For cross-platform applications, the Export can directly generate files 
compatible with DOS, Windows, Macintosh or Unix systems.

The Export tool also works in conjunction with other OptiSPICE Schematics tools, 
notably Find, to perform a variety of design searching and checking tasks.

The Find tool is described in “Using the Find Tool” on page 136.

Output File Formats

Export creates text files which are intended to be incorporated into other 
documentation or transmitted to other systems.  Files are saved with a file type of 
“TEXT”, so they are accessible to almost any word processing program or text editor.

For creating human-readable printed reports, you will generally get the best results by 
converting the file to a font such as Courier, which has fixed character spacing or by 
using tabs to space out columnar information.  No font or formatting information is 
stored with the files.

Output File Name

The default output file name is the design file name with “ RPT” added.  However, the 
script file can set any desired file name and optionally prompt the user for a new name 
before the file is saved.
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Generating Standard Netlist and Report Formats

A netlist or report is generated by opening the design you wish to work from, then 
using the Export command to run the appropriate script

Important: Many of the standard formats provided with OptiSPICE Schematics rely on 
specific attribute data being entered in the design.  Use the Notes button described below 
to get specific details on each script file, or check the ReadMe file provided with the design 
kit.  If you use a report script that is not from the same design kit as the design template 
that you started with, make sure you know the requirements of the netlist script.

Basic Report Export Procedure

1 Select the Export item in the File menu.  The following selection will appear:

2 Choose the Text Formats option and click Next.

3 Choose the desired format script from the list.  By default, the last item used 
will be selected in the list.

4 To run a script, click the Finish button.

The procedure after that is determined by the script file.  Most script files will put up a 
standard file creation box to allow you to specify the name of the output file.

For information on the graphics export options, see “Saving a Circuit Page in WMF, 
DXF or PDF Graphics Formats” on page 30.

Adding a Script to the Script List

If the script you want to run does not appear in the list, click the Browse button to 
choose a script file to add to the list of available scripts.  Clicking this button will bring 
up a standard file box displaying all text files with names ending in “.RFM”.  Select the 
desired script file by double-clicking on it.

Viewing Format Notes

The standard script files supplied with OptiSPICE Schematics will contain a number 
of comments explaining the usage and requirements of the script.  Some formats may 
rely on certain attribute fields being present in devices in the circuit.  These notes can 
be viewed using the Notes button in the Export box:
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Opening the Report on Completion

The “Open finished report on completion” option causes OptiSPICE Schematics to 
open the file in the built-in text editor when the report is completed.

Note: Some report scripts may generate multiple files or possibly none at all.  This option 
will attempt to open the last file created, if any.

Device Reporting Options

The listing of devices and device internal circuits can be controlled using the Report 
Options button in the Properties command for a device.  The following options are 
available:

For more details on setting device information and options, see “Displaying and 
Setting Device Information” on page 51.

Signal Reporting Options

The listing of signals can be controlled by setting the Omit from report option on a 
selected signal.  For more information, see “Getting and Setting Signal Information” 
on page 60.

Common Changes to Standard Report Forms

It may be desirable to make minor modifications to one of the standard report scripts 
in order to tailor it to your design needs.  This section covers some common changes 
that can be made without an in-depth understanding of the script file format.  Each of 
these features is covered in more depth in the OptiSPICE Schematics Script 
Language Reference (separate manual on disk).

Important: Before modifying any script that comes with OptiSPICE Schematics, make a 
backup copy of the original so you will have a reference to go back to.

Omit from report Nothing about this device or hierarchical 
block will appear in the netlist.

Report this device This device or block will appear in the 
netlist as if it has no internal circuit.

Report subcircuit The internal circuit of this device will appear 
in the netlist.  I.e. in a  hierarchical netlist, 
the internal circuit will be defined, in a 
flattened netlist, the internal circuit will be 
substituted and this device will not appear 
at all.
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Script files can be viewed and edited using a text utility such as Notepad or any 
standard word processor.  If using a word processor, be sure to save the file using a 
“Text Only” option so that no extra formatting information is included.

General Rules

Report scripts consist of text with commands embedded in it.  Items starting with a “$” 
are commands to the Export and items starting with “&” are references to attribute 
fields or script variables.  Any other text encountered, including blanks, punctuation, 
and control characters, is simply passed through to the output file.  This means that 
you can place almost anything in a script and it will become part of the output file.  The 
only place where Export is fussy about format is in the arguments to “$” commands, 
which usually have to meet some requirements.  Anything appearing in braces “{}” is 
a comment.

Default File Name

The default output file name for a report script is determined by the 
$CREATEREPORT command in a script file.  Following is a typical example:

$CREATEREPORT($DESIGNNAME.NET) $PROMPT

The contents of the parentheses determines the default name of the output file.  The 
keyword $DESIGNNAME substitutes the name of the current design file.  All other 
characters inside the parentheses are used verbatim.  The $PROMPT keyword 
indicates that a standard file box should be displayed to confirm the file name.  If this 
keyword is not present, the file is saved in the same folder as the design without any 
prompt.

If no $CREATEREPORT command is present in the script (or if the script generates 
some output before it is encountered), a name will be generated by adding the word 
“Report” to the design name and prompting the user.

Attribute Field Usage

Attribute field data is heavily used in generating netlist output files.  Most of the 
standard script files are set up to use the pre-defined attribute fields.  These are easily 
modified to use customized fields which you have added to your design.

Attribute fields are referenced in a script file using the form:

&fieldName

Wherever this format is used, any other field name can be substituted.  For example, 
a typical device listing will appear as follows in a script file:

$DEVICES$DEVNAME &Part

The “&Part” item will be substituted with the contents of the Part attribute field.  Any 
other field name can be referenced as desired, or additional ones can be added to the 
line.
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Extracting Power and Ground Connections from Attributes

The Export tool provides two general methods of specifying an attribute field that is 
going to be used to list power and ground pins.  The first, and most direct, method is 
the $SIGSOURCE command.  You will frequently see a line like this one in a report 
script:

$SIGSOURCE(Ground)

This line indicates that any pins listed in a field named Ground on a device should be 
added to the net with the same name in the netlist.  If you have power and ground 
fields that are commonly used in all your designs, you can simply add more lines like 
the one above to the report script.  See the OptiSPICE Schematics Script Language 
Reference (separate manual on disk) for more options on this keyword.

Another method which provides more flexibility in specifying different power and 
ground fields for each design is the $DESIGNSIGSOURCE command, as in:

$DESIGNSIGSOURCE(SigSources)

This command specifies that a design attribute field named SigSources should be 
searched for a list of power and ground fields.  This is in most ways equivalent to 
putting a list of $SIGSOURCE lines in a special report script for that design.  See the 
entry for "$DESIGNSIGSOURCE" in the OptiSPICE Schematics Script Language 
Reference (separate manual on disk) for more information.

For a more complete discussion of the various methods for making power and ground 
connections, see the OptiSPICE Schematics Script Language Reference (separate 
manual on disk).

Script Errors

Two general types of errors can occur in generating a report:

• Script syntax or execution errors—The Export command language is such that 
any items in the script file that are not recognized as commands are transmitted 
to the output file unmodified.  Thus, most errors do not result in an explicit error 
message, but generate unexpected results in the output file.  If an error is 
detected in an area of the script that requires a specific format, a message box is 
displayed showing the line number of the error.  If such an error appears while 
running a script provided with OptiSPICE Schematics, contact our Technical 
Support department for assistance.  If you have created or modified the script 
yourself, refer to the OptiSPICE Schematics Script Language Reference 
(separate manual on disk) for assistance in correcting the problem.

• Design data errors—A number of circuit data errors can occur during report 
generation, including unnumbered pins, excessive string length, missing or 
incorrect attribute values, etc.  It is the responsibility of the script to check for the 
errors that may affect the type of output being generated.  Errors can be displayed 
immediately in the form of an alert box, or may be logged to an output file, 
depending on the design of the script.  See the Format Notes or ReadMe file 
supplied with the design kit you are using for more information.
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Cross-Platform Compatibility of Scripts and Report Output 
Files

One of the well-known aggravations of the computer industry is the lack 
of agreement on line termination characters in text files across various 
computers and operating systems.  In order to make it easy to work in 
a mixed operating environment, Export provides a great deal of 
flexibility in reading input and generating output.

Line Termination in Script Files

When reading a script input file, Export accepts a single carriage return, 
a single line feed, or a combination of these in either order as a line 
terminator.  This means that a text file from any Windows, Macintosh or 
Unix system can be used as input without affecting the output format.  
Script files created on a Macintosh can be used as input to Export in 
OptiSPICE Schematics for Windows and vice versa, even if they do not 
display correctly in a text editor on the executing platform.

Line Termination in Output Files

The line termination format that is used in the report output generated 
by Export is determined by the $LINETERMINATOR command in the 
script file and does not depend on the line termination used in the script 
file.  If no such command is present in the script file, then the output files 
will be terminated in the native format of the machine the script is being 
run on.  Note that Export also has the capability of generating a 
secondary “transcript” file for error logging, etc.  This file always uses 
the line termination of the host computer system.

See more information on line termination in the section “Line Terminators” in the 
OptiSPICE Schematics Script Language Reference (separate manual on disk).
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Appendix A - Ini File Format
The “Schematics.INI” file is divided into sections.  Each section starts with a section 
heading contained within square braces, e.g. [Drawing].  Within a section each non-
blank line is either a statement or a comment.  A statement is a keyword, which speci-
fies an option, followed by an equal sign, which is a separator, followed by the option's 
value.  Statements are terminated by a carriage return.  A comment is any line that starts 
with “//”.

Specifying File and Folder (Directory) Names

A number of the INI file keywords are used to specify file and folder locations for 
various purposes.  This section describes a number of features available to make it 
easier and more flexible to specify the locations of items on disk.

Absolute and Relative Path Names

Folders can be specified using either an absolute (i.e. starting with a drive name) or 
relative path.  If the path begins with a drive or server name, the path is absolute, 
otherwise it is relative to the location of the OptiSPICE Schematics application.  The 
following are valid statements:

Directory = Libs

specifies a folder called Libs but does not give its absolute location.  In this case, the 
program looks first in the root folder, if any, then in the “start in” folder specified when 
the program was started, then in the folder containing the application itself.  In most 
installations, these three locations are all the same and only the application folder is 
searched.

For some file types, such as ".exe" application files, OptiSPICE Schematics will also 
search in the system folder.  This allows commonly-used applications such as 
NotePad to be specified without a directory path.

Using Environment and Registry Variables

Most places in the INI file (as well as Export scripts) that allow you to specify a file or 
folder name, also allow references to Windows environment variables and registry 
entries as sources of information about file location.  This is primarily intended for use 
in cases where references are needed to other applications or data files that may not 
be installed with OptiSPICE Schematics and are not in a fixed location.

It is beyond the scope of this section to discuss how environment or registry entries 
are set up.  Please refer to the appropriate Windows documentation.

Important: The value of the variable is placed in the resulting name strictly by text 
substitution without any checking.  It is the user’s responsibility to ensure that this results 
in a valid file name with appropriate name separator characters (e.g. backslashes between 
directory names), etc.  For example, in the above case, the variable DataDir should contain 
a terminating backslash character in order to create a valid file name when it is combined 
with the other text in the file name.  Also note that some commonly-used system 
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environment variables such as PATH may contain a list of alternate directories to search.  
When used in this context, OptiSPICE Schematics DOES NOT automatically break out 
such lists and search all the specified directories. 

Using Common System Locations

File names can be specified with a variable that indicates one of a number of common 
system locations.

For example:

%windows%NotePad.exe

Section [Drawing]

Initial Directory Settings

Directory = dir_name

This statement specifies the initial working directory.  The default working directory if 
this statement does not appear in the Ini file is the same as set by Window's Program 
Manager.

Font Settings

XXX_Font = font_name font_size [BOLD ITALIC]

This statement specifies the font for text items appearing in a schematic document.  
“font_name” is the name of a TrueType font, only TrueType fonts are supported.  
“font_size” is the point size to use.  There are two optional style keywords which may 
be applied, “BOLD” and “ITALIC”.  The possible items which may have there font 
specified are:

Default_Font, Attribute_Font, Border_Font, MiscText_Font, Pin_Font, 
Symbol_Font, PrintPage_Font

Color Settings

XXX_Col =ColorName

%my documents% The document folder for the 
current user

%program files% The Program Files folder on 
this computer

%desktop% The Desktop folder on this 
computer

%windows% The Windows system folder 
on this computer
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This statement specifies the color for items appearing in a schematic document.  All 
items in a schematic, except the page background, default to black.  The page 
background defaults to white.  The possible values for XXX_Col are:

Default_Col

DeviceAttrs_Col, SignalAttrs_Col, BusAttr_Col, PinNumber_Col, 
PinNumber_Selected_Col

Device_Col, Signal_Col, Signal_Selected_Col, Pin_Col, Pin_Selected_Col, 
Bus_Col, Bus_Selected_Col, BusPin_Col, BusPin_Selected_Col

Page_Col, Boundary_Col, GridMajor_Col, GridMinor_Col, RandowText_Col, 
RandowTextFrame_Col

The available colors are (letter case is not significant in color names):

Red
Green
Blue
Cyan
Magenta
Yellow
Black
DkGray
Gray
LtGray
White
VLtGray
LtBlue
LtGreen
LtRed
DkBlue
DkGreen
DkRed
Violet
Orange

Specifying the Location of Design Templates

Templates = folder

The Templates keyword specifies the location of the design template files that will be 
displayed in the New Design box.  This keyword can be specified multiple times to 
point to multiple template folders, if desired.

Specifying the Location of Example Files

Examples = folder
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The Examples keyword specifies the location of the example files that will be 
displayed when the Examples button in the New Design box is clicked.  This keyword 
can be specified multiple times to point to multiple template folders, if desired.

Adding Custom Menu Commands to Popup Menus

Keywords: POPUPSCRIPTDEV, POPUPSCRIPTSIG, POPUPSCRIPTPIN, 
POPUPSCRIPTCCT

Adding Default Attribute Field Definitions

The setup file keyword ATTRFIELD allows you to specify attribute field definitions that 
will be included in every new design that is created.  The format of this keyword is as 
follows:

ATTRFIELD = fieldName
ATTRFIELD = fieldName/options;

"fieldName" can be any valid attribute field name, i.e. consisting of letters, digits and 
the period and underscore characters “.” and “_”.  The maximum field name length is 
16 characters and spaces are not allowed.

If no options are specified, the field will be a device field with default maximum length 
and switch settings.

A number of switch setting options can be specified as letters and digits after a “/” 
following the field name.  If any digits follow the “/”, they are taken to be the maximum 
data length for this field.  The default is 32000.  Any combination of other option letters 
can be selected from the following table.  The order of the option letters is not 
important.

Any number of new fields can be added by using multiple ATTRFIELD lines.  Any line 
specifying the name of an existing field will be ignored.

Table 1: 

Option 
Letter

Meaning

A Allow Carriage Return character in data

C Allowed in design

D Allowed in devices

F Fixed, i.e. user cannot remove field definition

G Group with Name

I Instance data, i.e. can have different value inside different 
instances of the same hierarchical block

L Location fixed on schematic

P Allowed in pins
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ATTRFIELD examples:

ATTRFIELD = Aperture/SY10
ATTRFIELD = InputDelay/PYU10
ATTRFIELD = ModelText

Enabling Auto-Backup and Timed Auto-Save

Backup = On

This statement specifies that you want an automatic backup created each time an 
existing circuit file is resaved.  The default is On.

AutoSave = 15

This statement specifies that you want to be prompted to save your work whenever 
the specified number of minutes has passed without a save. The default is 0, i.e. no 
auto save.

Disabling Device Date Stamping

This statement controls the application of a date stamp to devices whenever they are 
edited.

NODATESTAMP

This keyword does not take any value.  If the keyword appears, date stamping will be 
disabled.  If it does not appear, date stamping is enabled.

Specifying Standard Sheet Sizes

The SheetSize keyword is used to specify the standard sheet sizes that are available 
in the Sheet Size Wizard command using the following format:
SheetSize = name width height

R Rotate with object

S Allowed in signals

T Do not display value list, even if a .List field is present

V Visible by default

W Show Field Name by default

X Read only value

Y In Primary list by default

Table 1: 
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Where:

• name is the text that you want to appear in the sheet size list.  This should be 
surrounded by double quotes if it contains any non-alphanumeric characters.

• width and height are decimal numbers expressed in internal units:

1 inch = 1008
1 cm = 397

For example:

SheetSize = "ANSI A Portrait - 8-1/2W x 11H" 8568 11088
SheetSize = "ANSI A Landscape - 11W x 8-1/2H" 11088 8568
SheetSize = "ANSI B - 17W x 11H" 17136 11088
SheetSize = "ANSI C - 22W x 17H" 22176 17136
SheetSize = "ANSI D - 34W x 22H" 34272 22176
SheetSize = "ANSI E - 44W x 34H" 44352 34272

Solid Grid Lines

The SOLIDGRID Ini file keyword determines if grid lines are drawing with solid lines.  
If not on then the grid is drawn with the default dotted lines.  On some platforms dotted 
lines are not supported correctly or may be slow.

SOLIDGRID = on

Zoom Factors

SCALES = n1..n11
NORMALSCALE = index

The SCALES statement is used to specify the magnification levels used by the 
Reduce and Enlarge commands.  The keyword is followed by 11 decimal integers 
separated by blanks and sorted in ascending order.  The 1:1 scale level (at which 
externally created pictures appear in their original size) is 14.  Enlargements are 
specified by smaller numbers (e.g. 7 gives 200%) and reductions by larger numbers.  
The default values are:

SCALES = 4 7 10 14 18 24 28 42 63 98 140
NORMALSCALE = 3

The NORMALSCALE  statement is used to specify which of the scale steps specified 
in the SCALES line will be used as the “Normal Size” setting.  The index must have a 
value in the range of 1 to 11.

Pin Spacing

PINSPACE = n;

The PINSPACE keyword is used to specify the spacing between adjacent pins when 
breakout symbols are created.  This can also serve as the default for symbols created 
by other tools.  The value must be a single decimal integer which is used as a multiple 
of the standard grid space of 5 dots.  The default value is 2.
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Breakout Parameters

BREAKOUT = dth dtv;

The BREAKOUT keyword lets you control the creation of bus breakout symbols 
generated by the program.  This does not affect any breakouts in existing files as 
these symbols are already created and stored with the file.

The BREAKOUT keyword is followed by two numbers for the following parameters:

Disabling ”Loose End“ Markers on Signal Lines

The NOLOOSEENDS Ini file keyword disables the cross-markers that are normally 
displayed on the screen at the ends of unconnected line segments.  The format of the 
command is:

NOLOOSEENDS = off

Undo Levels

The UNDO Ini file keyword indicates the number of levels of undo which should be 
maintained.  A value of zero means that there is no undo.  The default value is 10.

UNDO = n

Note: Undo data is held in memory during program operation.  A higher value here will 
increase the memory space occupied by the program.

Fine-Tuning Pin Number Text Display

The PINTEXT keyword allows you to adjust the display position of pin numbers on 
devices.  The format of this keyword is as follows:

PINTEXT = dth dtv

“dth” and “dtv” are positive or negative integer offsets which adjust the text position by 
the given amount in screen dots at Normal Size screen scale.  All devices in the 
design are equally affected.

Important: This adjustment should not be required in normal use and should be used with 
caution.  No checking is done on the range of these settings.

Note: Changing these numbers in the Ini file will not automatically recalculate the positions 
of pin numbers in existing designs.  You can force a recalculate by using the Design 
Preferences command to change the pin text font or size, then change it back to the 
original setting.

dth the horizontal offset (in screen dots at 100% scaling) 
for placement of text names on a breakout

dtv the vertical offset (in screen dots at 100% scaling) for 
placement of text names on a breakout
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Internal Error Checking

NOERRORCHECK = off
MSGCHECK = on

The first statement disables the internal error checking described elsewhere in the 
Appendix.  The second statement increases what is checked.

Note: This should only be done in consultation with our Technical Support department as 
it will prevent warnings from being issued for internal or unusual system errors.  In many 
cases these errors can be easily recovered if corrected immediately but may cause data 
corruption if left undetected.

Section [Libraries]

Specifying Libraries to Open at Startup

Specifying the Default Library Folder

FOLDER = directory_path

This specifies the folder/directory that will contain the libraries to be specified in 
following LIBRARY statements.  This statement can be omitted if the libraries are 
located in the same directory as the OptiSPICE Schematics executable, or if you 
prefer to specify a complete file “library_path” in each library statement.

Specifying a Single Library

LIBRARY = library_path

This specifies a single library to open.  The “library_path” can be simply the name of 
the library if the library is in the current directory, or a relative path to the library, or a 
fully qualified path from the root. 

Opening All Libraries in a Folder

LIBRARYFOLDER = directory_path

This names a folder/directory to be searched for libraries.  All libraries in this folder 
will be opened.  Folders inside this folder are not checked.  The format of the folder 
name is the same as for the FOLDER keyword above.

Section [DevEditor]

This section contains items affecting the device symbol editor tool.

Default Font

Font = "font_name" font_size [BOLD ITALIC]

This statement specifies the default font for text items appearing in a device symbol 
editor document.  “font_name” is the name of a TrueType font, only TrueType fonts 
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are supported.  “font_size” is the point size to use.  There are two optional style 
keywords which may be applied, “BOLD” and “ITALIC”.  

Grid Settings
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GridColor =RED, GREEN, BLUE, CYAN, MAGENTA, YELLOW 
BLACK,DKGRAY, GRAY, LTGRAY, or WHITE
GridSize = grid
SnapSize = snap
PinSnapSize = pinsnap

The GridColor statement specifies what color to use when drawing the symbol editor’s 
Grid.  GridSize, SnapSize and PinSnapSize are all expressed as a 5 pixel multiplier.  
GridSize specifies the number of 5 pixel spaces between displayed grid lines.  
SnapSize sets the grid snap for all graphical objects, except pins, and PinSnapSize 
sets the snap used when positioning pins.

Default Pin Name

PinName = PIN1
BusName=BUS1

These entries set the default name used for normal pins and bus pins, respectively.  
When a new pin is added to a symbol, the exact name given is tried first.  If this name 
is already in use, a numeric part is added, or any existing numeric part is incremented 
until a unique name results.  You can force names to always have leading zeros by 
specifying an initial name such as PIN001.

Symbol Gallery Location

SymbolGallery = Data Files\Symbol Gallery.clf

This statement specifies the location of the library file to be used as the "Symbol 
Gallery", i.e. the list of graphic items displayed while using the symbol editor.  Only 
one symbol gallery file can be specified.  The file must be a valid OptiSPICE 
Schematics symbol library (.clf) file. 

Section [System]

Tools Directory

ToolFolder = c:\dw\tools

This statement defines where to look for the external code modules. If this value is not 
specified then modules are loaded from the tools subdirectory under wherever the 
OptiSPICE Schematics executable is located.

Default System Font

Font = "font_name" font_size [BOLD ITALIC]

This statement specifies the default font which the OptiSPICE Schematics system will 
use when no other font has been specified.  Certain program modules may by default 
display text using this default font.  If no font is specified an attempt is made to use a 
Courier type face.  If no font size is specified then 10 point is used.
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“font_name” is the name of a TrueType font, only TrueType fonts are supported.  
“font_size” is the point size to use.  There are two optional style keywords which may 
be applied, “BOLD” and “ITALIC”.  

Example:

Font = “Courier New" 10 Bold

Printer Line Scaling

PrinterScaleLines = None, All, or OverOnePixel

This allows the user to specify whether lines are to be scaled when printed.

“None” is the default, it indicates that no scaling will occur.  With this setting a line's 
width is printed with the same number of pixels as on the screen.  When printing to 
high resolution printer, i.e.: >= 300 dots per inch, this will cause thick screen lines 
(busses) to be reproduced as printed lines which do not appear to be much thicker 
then thin screen lines (signals).  This setting is most useful when printing to dot-matrix 
printers where the printer's resolution is similar to the screens resolution.

“All” indicates that every lines will be scaled so that its printed width appears the same 
as on the screen.

“OverOnePixel” indicates that lines that have a screen width of greater then 1 pixel 
will be scaled when printed.  The result is signal lines being drawn very finely, but 
busses appearing as thick lines.

Printer Color Mapping

PrinterColors = Yes or ToBlack

This keyword controls translation of colors to black and white during printing.  This is 
used in cases where the printer driver being used does not properly handle color 
requests  If PrinterColors=ToBlack is specified then all colors are translated to black 
for printing. If this keyword is missing or an invalid option has been specified then no 
translation of colors will occur.

Clipboard Color Mapping

ClipboardColors = Yes or ToBlack

This is used to control translation of colors to black and white when placing an image 
on the clipboard.  If ClipboardColors=ToBlack is specified then all non-white colors are 
translated to black. If this keyword is missing or an invalid option has been specified 
then no translation of colors will occur.

Section [System Font Translations]

Old_Font_Name = Replacement_Font_Name

Font translations are used when the fonts imbedded in a file are not available on the 
current platform. This section allows the user to define which fonts (available on the 
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current platform) are to be used instead of the fonts specified.  The replacement font 
must be a TrueType font.

Each line in this section specifies a font mapping. For example:

Bookman = Courier New
Times = Times New Roman

specifies that anytime the font Bookman is displayed then Courier New should be 
used as its replacement, and when Times is displayed or requested that Times New 
Roman should be used.

Section [Find]

Specifying Search Script Location

ScriptFolder = dir_name

This keyword specifies the location of search scripts that will be available to the user 
in the Find tool.  All files with the “.RFM” extension that are located in the specified 
directory will be added to the Find tool’s list.  This keyword can be specified multiple 
times (one per line) if desired, to add more directories.

Section [TextEdit]

Specifying Additional Text Document Types

You can specify additional file extensions to be handled by the built-in text editor.  For 
example, if you frequently create a text report from your designs that has the file 
extension "rpx", you can add this extension to the list of handled file types.  This 
means that this file type will appear in the New and Open commands, allowing easier 
access to those files.

Note: These additional file types are not registered with the Windows system. I.E. you will 
not be able to open them in OptiSPICE Schematics by double-clicking on a file in the 
Windows Explorer.

For example, the following line adds handling for report script files having the .RFM 
extension.

TextDoc = "\nReport Script \nReport Script\nReport 
Script Files (*.rfm)\n.rfm"

(All of the above text must appear on one line in the INI file)

Notes on this format:

• The string consists of 5 sections that provide information about the file type. The 
sections are separated by a newline marker "\n".

• The first section (before the first \n) specifies ###

• The second section specifies the name prefix used when creating new files of the 
given type.  A number is appended to this string to give the complete file name.
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• The third section provides the name that will be used to show the file type in the 
New document type list.  If this is omitted, then it will not be possible to create this 
file type using the File/New command.

• The fourth section provides the string that appears in the "Files of type" selection 
list in the Open file box.

• The last section specifies the default file extension applied when a Save As is 
done on this file type.
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